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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

KECEWA PCPLUS TELAT
Assalamu'alaikum. Dear

PC+. Saya adalah calon
pelanggan tetap PC+. Kenapa
begitu? Karena saya selalu
mendapatkan PC+ yang sudah
basi, sebab sampai di daerah
saya selalu sudah habis masanya
dan bisa dikatakan Tabloid PC+
pada edisi minggu ini datangnya
pada edisi minggu depan. Saya
tidak tahu apakah itu kesalahan
pihak POS atau PC+ sendiri yang
telat mengirimkannya ke daerah
saya. Atau bisa jadi itu disengaja
oleh pihak agen penjual dengan
tidak menjual edisi terbaru
sebelum habis laku edisi lama.
Tetapi setahu saya dalam 5 hari
saja PC+ sudah habis terjual di
tiap-tiap agen di daerah saya.
Mungkin hal ini dikarenakan
oleh banyaknya minat para
mahasiswa khususnya yang
meminati dunia IT. Daripada
mereka harus membeli majalah
yang harganya bisa mencapai 2-3
buku IT, lebih baik membeli
Tabloid PC+ yang isinya padat
dan harganya relatif murah.

Saya menghimbau kepada
mahasiswa yang masih diberi jajan
oleh orang tua supaya
memikirkan juga para mahasiswa-
mahasiswa yang masih membiayai
kuliah dengan biaya sendiri.
Menurut saya harga PC+ sudah
pas dan tidak perlu dinaikkan lagi.
Hanya saja saran saya jangan ada
diskriminasi intelektual di mana
harga di Jawa dan di pulau lain
dibedakan. Apakah kami yang di
pulau selain di Jawa bukan orang
yang berhak mendapatkan
informasi IT seperti halnya Jawa?
Makasih ya, Saleum dari Tanah
Rencong. Wassalam.

Eka Saputra
xca11@yahoo.com

Red: Terima kasih kritikan dan
masukannya Bung Eka. Kami
langsung mem-follow-up
keterlambatan ini, tetapi pada
umumnya pengiriman ke seluruh
Indonesia sudah selesai dalam waktu
2-3 hari, sehingga PCplus sudah
beredar di seluruh Indonesia paling
lambat hari Jumat setiap minggunya.

Mengenai perbedaan harga, tidak
ada maksud mendiskriminasi secara
intelektual atau alasan lain. Satu-
satunya pertimbangan adalah ongkos
distribusi yang berbeda antara Jawa
dan luar Jawa.

DORONGAN BELAJAR PC
DARI PCPLUS

Assalamualaikum. PC+,
setelah iseng-iseng membaca
koran kamu, saya kok jadi mulai
tertarik dengan KOMPUTER ya?
Oleh karena itu, berdasarkan
prinsip “TIDAK ADA KATA
TERLAMBAT UNTUK BELAJAR”
maka saya ingin menanyakan
beberapa hal pada Anda.
1. PC+, perlu diketahui bahwa

rasa ingin tahu saya tentang
komputer lebih dalam
sekarang ini  besar sekali
(berkat membaca PC+ ),
namun saya sangat bingung
dalam memilih buku yang
cocok untuk PEMULA seperti
saya. Oleh karena itu dalam
kesempatan ini saya mohon
PC+ dapat memberikan
bantuan mengenai referensi
buku yang baik untuk mulai
belajar. Sekadar informasi,
sekarang ini saya sangat
tertarik untuk mempelajari
tentang "CARA
MENDOWNLOAD, MENG-
INSTALL PROGRAM, DAN
MENGENAL SELUK-BELUK
KOMPUTER LEBIH DALAM
LAGI".

2. PC+, saya juga mohon
diberikan tips dan trik dalam
belajar bahasa
PEMROGRAMAN.

Sekian dulu surat dari saya,
atas bantuannya saya ucapkan
terima kasih dan saya sangat
menunggu jawaban dari PC+
semua, kalau bisa tolong jawaban
diberikan secepatnya karena saya
sudah tidak sabar ingin mulai
belajar.

Ramla Yondo
rayon@myquran.com

Red:  Salah satu buku yang harus
Anda pelajari adalah “Langkah
Mudah Merakit PC” yang diterbitkan
PCplus. Buku-buku komputer terbitan
Elexmedia Komputindo, Andi Offset,
dan sebagainya juga perlu Anda
simak. Tips trik pemrograman bisa
Anda pelajari dengan menghubungi
yahya@e-pcplus.com

ISINYA DIPERBANYAK DAN
WORKSHOP

Kepada PCplus yang saya
hormati, tolong isinya
diperbanyak donk, harga
handphone diperdikit aja. Kalo
bisa ditambah info mengenai
teknologi masa kini dan kalo bisa
info produk dipersedikit juga.
Saya mau tanya, kok di Jakarta
workshop mengenai Linux tidak
ada? Saya lihat di iklan PCplus
hanya banyak di Surabaya dan di

Jakarta hanya mengenai
perakitan PC secara terus-
menerus. Kalo bisa diadakan di
Jakarta dan dengan harga
terjangkau.

Nalpha
teamnix@hotmail.com

Red: Usulannya kami perhatikan
Bung. Juga pertanyaan tentang
workshop Linux di Jakarta. Tunggu
tanggal mainnya, kami sedang
mempersiapkan workshop Linux yang
murah meriah berkualitas. Jangan
sampai ketinggalan mendaftar bila
sudah dibuka kesempatannya karena
tempatnya sangat sangat terbatas.

WEBSITE DAN FAX
Redaksi PCplus, saya punya

beberapa saran sebagai berikut.
1. Bagaimana kalau PCplus

mengulas secara rinci tentang
cara-cara mengopi teks
website ke dalam Notepad
atau yang sejenisnya bila
website tersebut sudah di-
protect (tidak dapat di-block-
copy).

2. Bagaimana kalau PCplus
memberikan cara-cara/alamat
situs yang dapat digunakan
untuk mengirim fax (kalau bisa
situs yang sudah menjangkau
area fax di Indonesia).

Sekian saran dari saya dan
terima kasih atas tanggapannya.

Jonathan
super_servo@yahoo.com

Red: Boleh juga usulannya.

MODUL MERAKIT PC
Saya Junaidi, pada

kesempatan ini mohon informasi
bagaimana cara untuk
memperoleh modul atau panduan
merakit komputer yang telah
dilaksanakan oleh PCplus di
beberapa daerah, saya sangat
berminat untuk memilikinya.
Karena di kota kami di Banda
Aceh PCplus tidak mengadakan
kegiatan tersebut. Jadi saya
mohon infonya untuk
mendapatkan modulnya. Apakah
bisa dikirim dengan biaya yang
sesuai dengan yang dilaksanakan
oleh PCplus selama ini atau ada
ketentuan lain? Sebelumnya saya
ucapkan terima kasih.

Junaidie
junaidie@telkom.net

Red: Modul hanya dicetak untuk
keperluan workshop Bung Junaidie.
Untuk mendapatkan panduan
lengkap, kami sarankan Anda
membeli buku yang kami terbitkan,
“Langkah Mudah Merakit PC”

MERAKIT HARI LIBUR DAN
BIKIN VCD

Hai PCplus yang makin
keren!!! To the point aja nih. Saya
ada beberapa usulan.

1. Saya tertarik sekali dengan
adanya workshop yang
diadakan oleh PCplus dan
saya kepengen sekali
mengikuti acara tersebut
tetapi tidak mempunyai
waktu luang. Masalahnya,
saya adalah seorang
karyawan sekaligus
mahasiswa. Jadi saya minta
tolong acara workshop
dijadwalkan pada hari
Minggu/libur, biar saya bisa
ikutan dan setelah saya
membeli buku "Langkah
Mudah Merakit PC", saya
lihat sangat bagus sekali,
saya mau ngusulin juga
gimana kalau bikin VCD-nya
supaya lebih jelas dan dapat
dimengerti dan apabila lupa
bisa melihatnya di VCD
tersebut.

2. Terakhir usulan saya, gimana
kalau PCplus tiap 10/20 edisi
dibikin VCD-nya seperti
sebelumnya yang telah
beredar bersama buku di
atas. Tolong diperhatikan
karena saya hobi sekali
mengoleksi Tabloid PCplus
tetapi selalu ada yang
hilang/dipinjam dan tidak
balik lagi.

Sekian dulu dan terima
kasih.

Yayat Ruhyat
yats_bager@plasa.com

entis_kasep@yahoo.com

Red: Terima kasih usulannya Bung
Yayat. Kami juga tengah
mengusahakan supaya
mendapatkan sewa tempat yang
bisa dipakai untuk workshop pada
hari Minggu/libur. Masalahnya,
sampai saat ini masih belum dapat.
Mudah-mudahan, pas bulan
Ramadhan nanti kita bisa
mendapatkannya. Usulan untuk
membuat VCD bagus sekali. Cuma
teknis pelaksanaannya sampai saat
ini masih sulit.

SOFTWARE PENGOLAH
GAMBAR

Yth Redaksi PCplus. Saya
senang dengan PCplus karena
banyak mengulas hal-hal yang
saya senangi seperti Adobe
Photoshop, Corel, ACDSee,
karena saya baru belajar saya
belum tahu caranya ngopi atau
memindahkan file gambar/
image seperti gambar back-
ground atau desktop theme
dari CD ke harddisk, apakah
dengan drag and drop seperti
wallpaper atau file foto jangan
diketawakan ya, soalnya saya
baru belajar sekian terima kasih.

Dian Argapuri
argapuri@plasa.com

Red: Terima kasih masukannya.
Tenang Mbak Dian, kami akan
usahakan untuk membantu Anda.

Memerdekakan Diri
Tanggal 17 Agustus tahun ini jatuh pada hari Minggu. Pemerintah

memutuskan untuk menggeser hari libur nasional tersebut menjadi hari
Senin, 18 Agustus, supaya lebih banyak orang menikmati istirahatnya
bersama keluarga. Supaya orang-orang lebih merdeka dari beban
pekerjaan sehari-hari.

Namun bagi PCplus, libur pada hari Senin bisa sedikit menjadi
masalah. Soalnya setiap hari itulah PCplus diracik dan diramu untuk
disajikan kepada pembaca di minggu itu. Dengan menggeser libur
menjadi Senin, seluruh awak kapal PCplus harus bekerja ekstra keras
supaya semua racikan dan bahan sudah selesai disiapkan dan siap untuk
dimasak pada hari Jumat. Otomatis, waktu persiapan menjadi lebih
singkat. Tak ayal, kru redaksi, iklan, dan bagian produksi harus menaikkan
ritme alias RPM proses kerja supaya dalam waktu yang mepet hidangan
PCplus bisa tersaji dan rasanya tetap nikmat seperti biasa.

Di minggu perayaan kemerdekaan ini, kami mengangkat sebuah
tema yang bisa membuat Anda sedikit merdeka dari rutinitas pekerjaan di
belakang meja kantor. Atau memerdekakan Anda dalam membelanjakan
duit di kantong.

Tema itu tak lain adalah notebook-notebook murah. Banyak orang
menyebutnya sebagai desknote, kombinasi antara komputer desktop
dengan notebook. Secara teknis, belum ada pendefinisian secara jelas apa
yang dimaksud desknote. Sedangkan secara bisnis, desknote kadang-
kadang didefinisikan sebagai komputer yang bentuknya seperti notebook,
tapi harganya lebih murah dari notebook pada umumnya. Tapi definisi itu
pun tidak terlalu tepat lantaran mahal tidaknya sangat tergantung dari
spesifikasi notebook itu sendiri. Ada lagi yang menjawabnya dengan
mendefinisikan desknote sebagai komputer notebook yang
menggunakan prosesor desktop sebagai otaknya. Tapi, lagi-lagi definisi ini
gugur karena ada vendor yang mengklaim produknya sebagai desknote
tetapi tetap menggunakan prosesor mobile, meski dalam hal ini adalah
prosesor non Intel dan AMD.

Seperti apa jelasnya pendefinisian itu, Anda perlu menyimaknya.
Juga, menarik sekali mengamati perkembangan terakhir dari teknologi ini.
Apakah fitur-fitur terbaru seperti teknologi Wi-Fi sudah tersedia di dalam
sebuah desknote?

Kami memilih tema ini, supaya di tengah merayakan suasana
kemerdekaan, Anda juga bisa menikmati kemerdekaan yang lain.
Merdeka dari kewajiban harus bekerja di meja kantor karena Anda punya
desknote. Merdeka untuk berbelanja kebutuhan lain, karena anggaran
yang tersedia tidak tersedot hanya untuk membeli komputer yang bisa
ditenteng ke sana ke mari.

Merdeka!
Salam hangat dari Palmerah

Redaksi
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Ratusan Server di Indonesia Diserang Virus Blaster.
Seperti yang telah diperkirakan, celah keamanan RPC Dcom sangat berpotensi menimbulkan masalah
jika berhasil diciptakan virus yang memanfaatkan kelemahan tersebut. Sebanyak 80 % server Internet di
Indonesia yang menggunakan OS Server windows rentan terhadap serangan ini namun hanya sedikit
komputer yang melakukan patch atas celah keamanan tersebut.

Setelah worm Blaster muncul, baru ketahuan bahwa para administrator memang belum melakukan
patch atas Windowsnya sehingga dengan mudah Blaster menyebar. Hebatnya, Blaster memiliki ukuran
yang sangat kecil, 6 KB sehingga sangat mudah dan efektif untuk disebarkan melalui Internet. Untuk
mencegah tidak di serangnya oleh virus tersebut, disarankan untuk segera menjalankan patch dari
Microsoft.

Kalangan yang paling sering diserang oleh Blaster adalah home user. Ini dikarenakan home user
lebih tidak berwaspada pada worm tersebut. Tetapi home user yang memiliki personal firewall di dalam
komputernya akan terhindar dari serangan worm ini, karena port 135 yang digunakan oleh worm ini
untuk menyerang ke komputer telah diproteksi. Apabila menyerang ke jaringan, para administrator
hendaknya segera melakukan patching pada Windows NT/2000/XP/2003 untuk menghindarkan komputer
terinfeksi Blaster dan dijadikan "zombie" untuk menyerang komputer lain di Internet seperti yang
terjadi sekarang ini.

Menurut perkiraan para pakar antivirus, serangan semacam ini akan berlangsung terus sampai satu
minggu dan celakanya pada tanggal 15 Agustus 2003 semua komputer yang terinfeksi akan melakukan
serangan Ddos ke www.windowsupdate.com dan diperkirakan tujuan dari serangan ini adalah untuk
mencegah para pengguna Internet untuk melakukan update atas celah keamanan RPC Dcom tersebut.

Namun pihak Microsoft membantah bahwa virus telah menginfeksi situs tersebut sehingga pelangan
tidak perlu men-disable fitur Windows Update. Microsoft menyarankan untuk men-download patch yang
tersedia di www.microsoft.com/security/incident/blast.asp. Selain itu, disarankan juga untuk
menempuh tiga langkah berikut ini yaitu:
• Menggunakan sistem keamanan firewall, baik untuk pengguna korporat maupun individu
• Selalu melakukan update perangkat lunak dengan patch terbaru
• Melakukan update antivirus dan mengaktifkannya ketika sedang bekerja menggunakan komputer.

Sejauh ini, Microsoft juga bekerja sama dengan pihak berwajib untuk menindak pelaku penyebaran,
baik perorangan maupun organisasi. Menurut Microsoft, tindakan yang menyerang atau merusak sistem
komputer dalam bentuk apapun merupakan tindakan kriminal. “Kami juga akan terus melakukan
perbaikan untuk meningkatkan sistem keamanan produk kami dan melakukan security review sehingga
setiap ada serangan kami sudah mampu memberikan informasi sejak dini dan patch dapat digunakan
guna menghindari serangan semacam ini,” ujar sumber di Microsoft. (snu)

SAP Susun Ulang Organisasi Development-nya. Langkah ini
dilakukan guna memaksimalkan keahlian dan teknologinya agar sesuai dengan kebutuhan industri spesifik.
Penyusunanan Ulang ini meningkatkan kemampuan SAP untuk mengembangkan solusi bisnis industri
spesifik secara efisien, dengan memanfaatkan keunggulan proses pengembangan, seperti mempergunakan
kembali komponen-komponen peranti lunak.

SAP membentuk tiga kelompok solusi bisnis baru (business solution groups-BSG) yang
mengombinasikan organisasi development yang bertanggung jawab untuk solusi industri spesifik dan solusi
bisnis pada umumnya, seperti CRM dan SCM.

Tiga BSG baru tersebut terdiri dari BSG Manufacturing Industries, BSG Services Industries, dan BSG
Financial and Public Services. BSG ini melingkupi organisasi development untuk penyedia jasa keuangan,
asuransi dan industri layanan publik, seperti human capital management, tim development keuangan dan
ERP. BSG dibentuk guna memperkuat interaksi antara tim development SAP dan tim eksekusi di lapangan
secara global.

Penyusunan ulang organisasi SAP ini merupakan upaya lanjutan dari serial perubahan SAP yang telah
dilakukan pada beberapa bagian, di antaranya globalisasi dan standardisasi Global Marketing, Service &
Support, SAP Consulting, Global Field Operations, SAP Education, dan Global SAP Human Resources. (snu)

Matrox RT.X100 Xtreme Roadshow. Tanggal 14 Agustus lalu, bertempat
di Puri Pertiwi I Room Hotel Dusit Mangga Dua, Jakarta, Matrox melaksanakan roadshow bertajuk “RT.X100
Xtreme Roadshow”. Roadshow ini rencananya akan digelar di banyak negara. Untuk Asia Pasifik, Indonesia
adalah negara kedua yang menggelar roadshow ini.

Pada acara ini, Matrox memperkenalkan dua produk barunya yaitu RT.X10 Xtra dan RT.X100 Xtreme.
Kedua produk ini mengalami peningkatan dibandingkan versi sebelumnya, khususnya dalam software yang
disertakan. Dengan software yang baru ini terdapat beberapa fitur yang sebelumnya tidak tersedia. RT.X10
Xtra lebih ditujukan untuk pengguna rumahan yang memiliki antusiasme terhadap video editing,
sementara RT.X100 Xtreme lebih ditujukan ke arah profesional.

Pada acara ini juga dilakukan demo terhadap beberapa kemampuan dari RT.X100 Xtreme. Seperti versi
sebelumnya, RT.X100 Xtreme ini memiliki kemampuan melakukan banyak hal secara realtime. Bagi
pengguna RT2000, RT2500, RT.X10 dan beberapa jenis kartu video editing merek lain, Matrox juga
menawarkan program tukar tambah untuk memperoleh RT.X100 Xtreme. Khusus bagi yang membeli
RT.X10 Xtra dan RT.X100 Xtreme pada hari tersebut, diberikan bonus berupa potongan harga. (cgs)

Harga Produk Microsoft Dijual
Lebih Murah. Salah satu di antaranya adalah Microsoft
Office XP. Sebelum di Indonesia, Microsoft telah menerapkan
strategi pemangkasan harga jual produknya di China dan Taiwan.

Harga sebuah full package product (FPP) untuk Office XP turun
sekitar 20%. Sementara, harga Office “eceran” seperti Word 2002,
Excel 2002, dan Power Point yang dijual secara terpisah juga turun
sekitar 32% dari harga semula. Dari perubahan harga yang
diberikan ini, pelanggan retail akan menghemat biaya sekitar 900
ribu hingga 1 juta rupiah, tergantung pada pembelian masing-
masing produk. Secara regional di kawasan Asia Pasifik yang
tingkat pembajakannya masih sangat tinggi, penurunan harga ini
diharapkan akan memberikan pengaruh yang signifikan.

Selain program diskon harga, Microsoft juga menawarkan
suatu program yang disebut Software Assurance. Melalui program
ini, pelanggan bisnis yang membeli Software Assurance akan
mendapatkan suatu paket yang terdiri atas pelatihan, dukungan
pemasaran dari Microsoft, serta management tools. Dengan
mengikuti program asuransi software ini, pelanggan mendapatkan
jaminan dan dukungan gratis apabila produk software yang
diasuransikannya dikeluarkan versi upgrade-nya.

Tidak hanya itu. Untuk aplikasi Office berbasis Macintosh,
perusahaan yang didirikan oleh Bill Gates dan Paul Allen ini juga
memangkas harga. Anda tertarik untuk memilikinya sekarang?
Daripada keburu dirazia polisi! (snu)

Canon Keluarkan Printer Seri
Terbaru. Kali ini dua direct photo printer dengan teknologi
dye sublimation diluncurkan pada awal bulan Agustus ini. Mereka
adalah CP-200 dan CP-300. Kedua printer foto ini merupakan
generasi penerus dari printer CP-100 yang tergolong praktis karena
bentuknya yang kompak, trendy, dan dengan harganya yang
terjangkau.

Baik CP-200 maupun CP-300 diperuntukkan untuk mencetak
secara cepat dari kamera digital yang sekarang makin populer
penggunaannya. Oleh karena itu, kedua printer ini juga kom-
patibel dengan kamera digital Canon yang memiliki fitur Camera
Direct Printing untuk pencetakan langsung tanpa bantuan PC.

Kedua printer ini memiliki resolusi sebesar 300x300dpi dengan
menggunakan tinta 4 warna dasar yang khusus yang dapat
mencetak maksimal jika digunakan pada kertas foto Canon. Untuk
mendapatkan warna yang akurat, dua printer ini menawarkan 256
tingkat warna. Selain itu, keduanya juga mampu menghasilkan
cetakan dalam 3 ukuran yaitu ukuran kartu pos, ukuran L, dan
ukuran kartu kredit.

Untuk CP-300 Canon menyertakan pula sebuah rechargeable
battery Canon NB-CPL1 untuk mempermudah pengoperasian saat
bepergian selain juga dapat menggunakan tegangan listrik biasa.
“Pilihan penggunaan baterai ini menjadi tambahan kenyamanan
bagi para penggunanya,” ujar Merry Harun, Canon Senior Division
Manager PT Datascrip. Untuk tahap awal, CP-200 dijual dengan
harga 180 dolar sementara CP-300 dapat dibeli dengan harga 260
dolar. (sil)

VIA Lakukan Validasi memori
DDR 400. Perusahaan mikrocip terkemuka
mengumumkan program validasi memori DDR-400 berdasarkan
spesifikasi JEDEC dijalankan bersama-sama dengan Advanced
Validation Labs. Langkah validasi ini dilakukan guna memastikan
stabilitas kinerja yang optimal dan performansi yang tangguh dari
seluruh chipset VIA yang berbasis DDR-400, baik chipset yang
mendukung prosesor Intel maupun AMD.

Validasi dilakukan dengan melakukan pengetesan terhadap
modul memori menggunakan platform chipset VIA PT800 dan
KT600. Salah satu pengetesan yang dilakukan adalah pengujian
panas untuk melihat ketahanan modul memori pada setiap set
instruksi yang dibebankan kepadanya. (snu)



4 |

plusTechnews IV • 20 - 26 Agustus 2003
PCplus 140

Peraih Bubu Award 2003. Peraih Bubu Award untuk kelas korporat diumumkan
pada hari Senin (14/8) lalu. Untuk kelas individual, best female designer dan people’s choice akan
diumumkan pada bulan Oktober 2003. Berikut ini pemenang untuk kelas korporat untuk masing-masing
kategori: (alx)

 Kategori Pemenang Alamat
 E-commerce PD OCTA Utama www.oxone-online.com
 Commerce Citibank Indonesia www.citibank.com/indonesia
 Government Dinas Informasi dan Komunikasi Purwakarta www.draft.purwakarta.go.id
 Education STIKOM www.stikom.edu
 News & Entertainment Weddingku www.weddingku.com
 Organization Babaflash www.babaflash.com
 Best of the Best Babaflash www.babaflash.com

IBM Lengkapi IBM eServer z990 dengan
Fungsionalitas Kriptografis dan Trusted Key Entry.
Kriptografi dengan fitur lengkap ini dirancang untuk memungkinkan pelanggan memiliki pilihan
enkripsi “clear key” atau “secure key”, yaitu kemampuan keamanan canggih yang umum digunakan di
berbagai industri, terutama di industri layanan keuangan dan perbankan.

Penambahan ini lebih meningkatkan kemampuan enkripsi z990 untuk aplikasi-aplikasi yang
membutuhkan tingkat perlindungan data tertinggi. Jika digunakan dengan z/OS, sistem operasi
unggulan untuk mainframe, z990 ini akan memberikan fungsionalitas kriptografis canggih.

IBM eServer z990, yang diperkenalkaan pada bulan Mei lalu, menetapkan standar  baru di
komputasi kelas enterprise, dengan memimpin industri dalam hal virtualisasi, otomatisasi, skalabilitas,
keamanan, dan keandalan. Di desain dari bawah ke atas untuk membantu menghalau gangguan yang
akan memasuki sistem, mainframe IBM ini adalah salah satu server yang paling aman dari semua server
yang ada di pasaran. Sebuah z990 16-way yang menjalankan z/OS 1.4 dapat memproses hingga 11.000
transaksi secure socket layer (SSL)/detik.

PCIX Cryptographic Coprocessor (PCIXCC) milik z990, yang memberikan
mainframe ini kriptografi kunci yang aman, merupakan pengganti PCICC dan CMOS
Cryptographic Coprocessor Facility yang sebelumnya tersedia pada platform
zSeries versi terdahulu, seperti z900.

Semua yang ditawarkan fungsi-fungsi PCICC juga terdapat pada z990 PCIXCC tetapi dengan
performa yang lebih tinggi. Selain itu, z990 PCIXCC menyediakan fungsi-fungsi CMOS Cryptographic
Coprocessor Facility yang digunakan oleh aplikasi-aplikasi
yang sudah dikenal. PCIXCC mendukung fungsi-fungsi kriptografis yang sangat aman, penggunaan nilai-
nilai encrypted-key yang aman, dan sambungan yang ditentukan penggguna.

Penambahan fungsionalitas kriptografi ini akan tersedia pada pertengahan bulan September
mendatang, sebulan lebih cepat dari rencana semula. (snu)

Nortel Networks Luncurkan
Produk dan Program “Security
Partner”. Produknya merupakan sebuah peranti lunak
terbaru, Alteon Operating System (AOS) 21.0, yang untuk saat ini
tersedia bagi produk-produk Alteon Application Switch. AOS
menyediakan fitur-fitur untuk mengidentifikasi dan melindungi
sistem dari penyalahgunaan jaringan ataupun serangan lainnya.

Fitur aplikasi keamanan ini meliputi Advanced Denial of
Service (DoS) Protection yang menggunakan teknik pattern
matching yang canggih untuk menangkal beragam jenis
serangan terhadap jaringan; Secure, sebuah layanan Web yang
fault-tolerant, yang dijalankan dengan Extensible Markup Lan-
guage (XML) dan fungsi pemeriksaan Simple Object Access
Protocol (SOAP) menjadikan Alteon Application Switch sebagai
produk pertama yang menawarkan fitur khusus Web Services-
aware traffic management yang memeriksa, mengklarifikasi, dan
mengatur lalu lintas Web services; dan pengelolaan aplikasi
peer-to-peer canggih yang memungkinkan perusahaan untuk
secara proaktif mengendalikan lalu lintas layanan Web
mereka. (fbi)

Sigma Cipta Caraka Raih
Kemenangan Lagi pada Apicta
Indonesia 2003. Prestasi ini diraih melalui Sigma I
Approva, Best of Business Application – Finance dan Sigma I
WebTeller, Best of E-Commerce.

Kategori Best of Business Application adalah aplikasi yang
paling inovatif yang mendukung berbagai proses bisnis dalam
sebuah perusahaan. Sedangkan kategori Best of E-Commerce
adalah aplikasi yang paling inovatif untuk menyajikan sistem
transaksi berbasis Web. Selain itu, penilaian setiap kategori
berdasarkan keunikan, inovasi, kualitas, potensial dan presentasi
dari solusi tersebut.

APICTA (Asia Pacific Information and Communications
Technology) Award yang diselenggarakan setiap tahunnya akan
memperlombakan setiap pemenang dari masing-masing negera di
kawasan Asia Pasifik yang menyelenggarakannya ke tingkat
international.  Tahun ini negara yang terpilih untuk menjadi tuan
rumah APICTA International adalah Australia. (snu)
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Resolusi
dan Refresh Rate

Cakrawala Gintings
cakra@e-pcplus.com

P

Pada edisi yang lalu
PCplus sudah

membahas mengenai
kedalaman warna.
Kedalaman warna

pada monitor
dipengaruhi oleh RGB

yang digunakan.
Kedalaman warna

yang umum adalah
true color dengan

hampir 16,8 juta
warna. Banyaknya

warna yang bisa
ditampilkan ini

memang merupakan
faktor yang penting

bagi sebuah monitor.

engguna PC
tentunya menginginkan
tampilan yang bisa
menampilkan semua

warna yang ada atau setidaknya
sebanyak-banyaknya. Bila warna
yang bisa ditampilkan oleh se-
buah monitor itu sangat terbatas,
misalnya hanya 16 buah warna,
maka monitor itu kurang me-
narik untuk digunakan untuk
aplikasi yang membutuhkan ba-
nyak warna. Monitor tersebut
tentunya tidak memadai untuk
digunakan dalam hal mengolah
foto dan menonton film misalnya.
Selain faktor kedalaman warna
yang didukung, monitor juga
memiliki faktor penting lainnya
seperti resolusi dan refresh rate.

Resolusi
Membahas resolusi tentunya

tidak bisa dilepaskan dari pixel.
Pixel merupakan
singkatan dari
picture element.
Pixel ini adalah
bagian terkecil yang
membentuk suatu
gambar. Anggaplah
pixel ini seperti
halnya titik kecil
yang bisa
menampilkan warna
apa saja dari salah
satu true color di atas.

Bila titik-titik
kecil tersebut tersusun
secara rapat dalam
jumlah yang besar
pada suatu area ter-
tentu, maka dengan
memberikan warna
yang sesuai pada ma-
sing-masing titik, dapat
dibentuk suatu pola pada
area tersebut. Hal seperti
inilah yang membuat monitor bisa
menampilkan berbagai gambar.

Untuk menampilkan
berbagai gambar tersebut

monitor akan mengatur masing-
masing warna dari pixel yang
digunakan. Resolusi dari suatu

gambar ataupun monitor itu
adalah banyaknya pixel yang
digunakan. Tiga nilai yang paling
umum adalah 640 x 480, 800 x

600, dan 1024 x 768. Resolusi
sebesar 1024 x 768 pixel berarti
ada sebanyak 1024 pixel pada

sumbu X dan 768 pixel
pada sumbu Y. Adapun
banyaknya pixel yang
digunakan secara
keseluruhan adalah
hasil kali dari
keduanya. Semakin
banyak pixel yang
digunakan tentunya
akan semakin bagus,
hanya saja luas dari area
yang digunakan juga
harus diperhatikan.
Suatu monitor 17”
dengan resolusi 1024 x
768 pixel umumnya akan
menghasilkan gambar
yang lebih halus
dibandingkan dengan
suatu monitor 19”
dengan resolusi 1024 x
768 pixel juga.

Refresh Rate
Suatu monitor memerlukan

waktu untuk menggambar suatu
gambar penuh pada layarnya.
Proses menggambar ini tentunya

proses memberikan warna pada
pixel. Proses pemberian warna ini
tentunya secara bertahap, per
pixel.

Oleh karena itu, proses ini
jelas membutuhkan waktu.
Refresh rate ini merupakan
banyaknya proses penggambaran
yang selesai secara utuh pada
setiap detiknya. Jadi bila refresh
rate yang digunakan adalah
sebesar 60Hz dan yang
ditampilkan pada monitor adalah
gambar diam dari suatu mobil,
maka gambar diam dari mobil
tersebut akan ditampilkan
sebanyak 60 kali dalam satu
detiknya. Mungkin Anda
bertanya buat apa kalau gambar
diam? Seperti dijelaskan tadi
bahwa proses pemberian warna
pada pixel tadi itu dilakukan
secara bertahap, per pixel.
Setelah pixel yang satu selesai
diberi warna dengan
penembakan RGB, pixel tersebut
tidak akan diberi warna lagi
sampai pixel-pixel lain sudah
mendapatkan gilirannya semua.
Selama tidak ditembak ini, warna
yang dihasilkan pixel tersebut
akan memudar hingga akhirnya
hilang.

Oleh karena itu refresh rate
yang dimiliki haruslah memadai
agar jangan sampai ada pixel
yang sudah tidak berpendar
padahal proses penggambaran
belum selesai. Semakin tinggi
refresh rate yang digunakan,
akan semakin tidak berkedip
suatu tampilan dari monitor
itu.  PC+

Selain kedalaman warna, resolusi, dan refresh rate
juga merupakan properti penting dari monitor
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bbc.football.fantasyleague.co.uk
Jadi Manajer Tim Liga Inggris

Alex Pangestu
alex@e-pcplus.com

P

Kompetisi liga Inggris
musim 2003/2004

mulai bergulir hari
Sabtu, 15 Agustus

2003. Para penggila
sepak bola, khususnya

liga Inggris, tidak
akan melewatkan
pertandingan tim

kesayangan mereka
apabila ditayangkan
di televisi. Daripada
berjudi, mendingan

daftar menjadi
manajer virtual di

Internet. Nonton bola
jadi lebih seru, lebih

deg-degan. Malah
bisa dapat hadiah!

Cplus
mencoba
salah satu
kompetisi manajer

virtual milik BBC, salah satu
kantor berita di Inggris.
Alamatnya adalah
bbcfootball.fantasyleague.
co.uk. Sebenarnya ada situs
lokal yang beberapa tahun lalu
pernah dicoba oleh penulis
(waktu itu belom gawe di
PCplus), yaitu kompetisi milik
www.plasa.com, namun tahun
ini tampaknya tidak ada
kompetisi lanjutan. PCplus juga
sudah mendaftar ke kompetisi
sejenis di
www.djarumsupersoccer.
com. Namun untuk kompetisi
musim 2003/2004 sepertinya
belum diaktifkan. PCplus sudah
mengirimkan e-mail untuk
mengonfirmasi ada tidaknya
kompetisi lanjutan, namun pada
saat tulisan ini diturunkan
belum ada jawaban dari yang
bersangkutan.

Dengan pertimbangan
bertepatan mulainya kompetisi
liga Inggris 2003/2004, maka
PCplus membahas BBC Fantasy
Football yang pendaftarannya
dimulai tanggal 15 Agustus lalu.

CARA BERMAIN
Sebelum bermain tentunya

harus mendaftar. Klik saja
[Register] untuk mendaftar. Anda
akan diminta mengisi nama tim
dan berbagai informasi mengenai
diri Anda. Klik [Next] jika
semuanya sudah lengkap. Jangan
lupa check
persetujuan bahwa
Anda menyetujui
segala peraturan
yang sudah
ditentukan oleh BBC
Fantasy Football.

Pada halaman
berikutnya Anda
akan diminta
memilih pemain-
pemain. Formasi tim
sudah fix, tidak
dapat diubah, yaitu
4-4-2 dengan
seorang kiper. Kalau
Anda klik [Lucky
Dip], seluruh posisi
akan diisi otomatis.
Tapi dengan
menggunakan cara
itu kurang seru. Lebih seru kalau
Anda sendiri yang memilih
pemainnya.

Anda harus pintar-pintar
memilih pemain. Selain karena
budget yang terbatas (£50M), tim
Anda ini akan fix selama satu
bulan, walaupun Anda
diperbolehkan menransfer
pemain sebanyak 6 kali. Ada
baiknya Anda mencari jadwal
pertandingan selama satu bulan.
Kemudian pilih pemain dari tim
yang lawannya enteng-enteng
atau tim yang Anda yakini akan
memenangkan pertandingan.

Pada awal bulan berikutnya,
paling lambat sebelum 15 menit
sebelum pertandingan di awal
bulan tersebut, Anda baru boleh
bebas mengganti pemain. Satu
hal lagi yang berhubungan
dengan pemilihan pemain adalah
jumlah maksimal pemain yang
Anda pilih dari satu tim ialah 2.
Jadi dalam tim Anda hanya boleh
ada 2 pemain Manchester United
di tim Anda. Klik [Next] kalau
sudah selesai.

Halaman berikutnya adalah
halaman validasi tim. Kalau ada

kesalahan pemilihan Anda harus
kembali ke halaman sebelumnya.
Namun kalau sudah benar, akan
muncul pesan yang
menyampaikan bahwa tim Anda
sudah valid. Anda bisa klik [Next]
jika muncul pesan ini. Kemudian
muncul pesan bahwa PIN untuk
tim Anda sudah dikirim ke e-mail
Anda. Periksa e-mail Anda dan
gunakan PIN ini untuk login.

PENILAIAN
Tiap tim akan memperoleh

poin yang tergantung dari hasil
pertandingan tim pemain yang

dipilih pada pertandingan
sesungguhnya. Berikut ini adalah
peraturan mengenai pemberian
poin:
• Jika seorang pemain

mencetak gol, 3 poin akan
ditambahkan untuk tim Anda.

• Jika seorang pemain
memberikan assist, 2 poin
akan ditambahkan. Assist
yang dimaksud adalah operan
terakhir kepada pencetak gol.

• Jika seorang kiper atau
seorang pemain bertahan
tidak kebobolan, 3 poin akan

ditambahkan.
• Jika seorang kiper atau

seorang pemain bertahan
dimainkan minimal 45 menit,
1 poin akan ditambahkan.

• Jika seorang kiper atau
seorang pemain kebobolan, 1
poin akan dikurangi.

HADIAH-HADIAH
Ada 2 kategori hadiah.

Hadiah yang diberikan setiap
satu bulan sekali untuk manajer
urutan pertama dan runner-up
serta hadiah tiga bulanan untuk
posisi pertama, runner-up dan ke

tiga.
Untuk tiap bulan juara dan

runner-up akan memperoleh
hadiah berupa tiket untuk
pertandingan liga Inggris, piala,
dan pertandingan internasional
yang dimainkan di Inggris. Ada
pula hadiah berupa merchan-
dise permainan sepak bola,
kamera dan kaos.

Sedangkan manajer yang
jadi juara dalam hitungan 3
bulan berhak memperoleh 2
buah tiket final Euro 2004 di
Portugal. Tiket pertandingan,
penerbangan dari London ke
Portugal dan akomodasi selama
2 malam akan ditanggung oleh
sponsor. Runner-up berhak atas
tiket sebuah pertandingan tim
di daratan Eropa. Misalnya tiket
menonton pertandingan Inter
Milan di Serie A. Posisi ketiga
akan memperoleh meja
permainan sepakbola.

KOMPETISI LAIN
Ada dua buah fitur spesial.

Yang pertama adalah
pembuatan liga virtual sendiri
yang tim-timnya adalah tim-tim
yang dimanajeri oleh kawan,
keluarga atau kerabat lain.
Hadiahnya? BBC Football tidak
menyediakan hadiah untuk
kompetisi ini. Silakan sediakan
hadiah sendiri.

Fitur lainnya adalah
Challenge A Friend. Ayo
tantang teman Anda untuk
bertanding! Isi nama serta e-
mail teman Anda. BBC Foot-
ball otomatis akan
mengirimkan e-mail tantangan
Anda. Hadiahnya juga diatur
sendiri. BBC Football tidak
menyediakan hadiah khusus.

Ayo daftar! Atur tim Anda,
nonton pertandingannya di
televisi kemudian (mudah-
mudahan) menang. PC+

bbc.football.fantasyleague.co.uk
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Tatacara
Download File
Lewat mIRC

Y.J. Thurana
thurana@e-pcplus.com
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Dengan asumsi bahwa
Anda sudah bertanya-

tanya dan
mendapatkan

informasi mengenai
beberapa channel IRC

yang menyediakan
file untuk di-down-

load, mari kita
lanjutkan

pembahasan kita
yang sempat

tertunda. Yaitu
mengenai pen-down-

load-an file di IRC.

engaturan
awal mIRC
untuk keperluan pen-
download-an sudah

dibahas pada kesempatan yang
lalu, menyisakan kita satu tugas
lagi, yaitu download itu sendiri.

PERLU DIPERHATIKAN
Pada World Wide Web yang

bertingkah laku bak sebuah
“perpustakaan umum”,
siapapun bisa dengan bebas
mengambil apapun. Sedangkan
aturan yang sedikit berbeda
berlaku di IRC channel.

Tidak ada download
manager yang akan membantu
Anda. Yang ada hanyalah
program mIRC dan sedikit
ketekunan. Kita melakukan
semua kegiatan di channel IRC
dengan sebaris perintah yang
kita ketikkan di bagian bawah
jendela mana saja yang sedang
terbuka. Misalnya perintah /join
#chatplus artinya kita
bergabung dengan channel (#)
chatplus.

Kemudian berhubungan
dengan download file,
ibaratkan diri Anda mampir ke
rumah seseorang untuk
mengambil barangnya. Apa
yang harus Anda lakukan?
Permisi dulu, tentu saja. Jika
mereka mengijinkan silakan
ambil barangnya. Jika tidak,
silakan gigit jari. Kira-kira
seperti itulah tata kramanya.
Walaupun tidak seketat itu.

Pada dasarnya, di IRC Anda
bisa mengambil apa saja
dengan syarat:
• tahu caranya
• tidak melanggar aturan

yang sudah ada di channel
tersebut

• file tersebut ada dan Anda
rela menunggu giliran jika
memang diharuskan.

Karena itu saran saya untuk
para pemburu file, khususnya
yang baru pertama kali
mencicipi IRC, setiap kalli
bergabung dengan suatu
channel selalu:
1. Baca Topic-nya baik-baik.

Topic, yang selalu muncul
pertama setiap kali suatu
channel terbuka biasanya
berisi informasi-informasi
yang berguna mengenai
channel tersebut termasuk
aturan-aturan yang berlaku
di situ.

2. Bagian Topic yang
membahas aturan-aturan

tersebut biasanya bernama
!rules. Jangan lupa untuk
mempelajari bagian ini juga
karena di sini lah
kelangsungan hidup Anda
berlangsung. Melanggar
aturan sama artinya dengan
ditendang keluar dengan
tidak hormat. Dan yang
dimaksud dengan ditendang
memang betul-betul
ditendang (kicked out).

3. Bagaimana jika tidak ada
aturan tertulisnya? Gunakan
peribahasa ini “Malu bertanya
ditendang keluar”. Tetapi
ingat, ini hanya jika aturan
tersebut memang tidak
tertulis. Jika sudah ada
dengan jelas dan Anda masih
bolak-balik bertanya, nasib
Anda akan sama. Jangan
salahkan siapa-siapa jika ada
tanda sepatu di bagian
belakang celana Anda.

MENGGUNAKAN FILE
SERVER

Secara umum, tempat
penyimpanan file yang dimiliki
oleh anggota channel disebut file
server. Biasanya ini adalah bagian
dari harddisk dari komputer
pribadi masing-masing.

Jika diijinkan oleh channel
yang bersangkutan, Anda bisa
menggunakan perintah !list.
Perintah ini akan memunculkan
daftar file server yang ada pada
channel itu. Mungkin juga ada
FTP server di antara daftar
tersebut, tetapi masalah FTP
adalah cerita lain.

Jika perintah tersebut tidak
diijinkan oleh channel, Anda
harus menunggu munculnya file
server advertisement yang
berbentuk seperti jendela iklan
pop-up dengan isi seperti jendela
yang muncul setelah perintah
!list tadi (Gambar 1).

Berikut adalah hal-hal dalam
jendela file server:

1.  Trigger:
Perintah yang digunakan

untuk masuk ke file server.
Pastikan bahwa Anda
menyalinnya dengan tepat. Atau

gunakan saja Copy dan Paste.
Bagi mereka yang belum terbiasa
dengan IRC, mungkin terasa aneh
ketika perintah Ctrl+C tidak
berfungsi untuk melakukan copy
seperti biasa. Di sini teks akan
otomatis disalin ketika Anda
membloknya. Sementara itu
Ctrl+V masih berfungsi sebagai
paste. Jika file server sedang
tidak menerima pengguna baru
pada saat tersebut, Anda akan
mendapat pemberitahuannya
pada jendela status. Pada gambar
contoh di atas, perintah untuk
mengaktifkan Trigger tersebut
adalah: /ctcp Tsukushi^^
Unlicensed anime (sekali lagi,
tanpa tanda kutip).

2.  Sends dan
Queues:

Ketika menggunakan file
server, permintaan file yang Anda
ajukan akan disimpan pada slot
“antri” (queue) sampai dengan
slot “kirim” (send) tersedia.
Dengan memperhatikan bagian
ini, Anda akan bisa
menyelamatkan banyak waktu
yang akan terbuang percuma.
Jika tidak ada “antrian” yang
tersedia, lebih baik Anda mencari
file server lain karena apapun
yang Anda lakukan tidak akan
memungkinkan pengambilan file.

3.  /dccserver:
Beberapa file server yang

berada dibelakang firewall
memiliki pilihan ini. Gunakan
perintah yang diberikan untuk
bisa mendapatkan kiriman file
dari situ.

Catatan:
• Jika Anda menggunakan

beberapa perintah /dccserver
yang berbeda, yang berlaku
hanyalah yang terakhir.

• Jika Anda juga berada di
belakang firewall, ada

kemungkinan besar bahwa
berbagai server tersebut tidak
bisa memberikan layanannya.

Jika Anda sudah berada
didalam file server, jendela
berikut akan muncul
(Gambar 2).

Dan perintah-perintah yang
bisa digunakan di sini menyerupai
perintah-perintah pada masa DOS
(Disk Operating System) dulu. Di
antaranya adalah sebagai berikut:
• help: memunculkan daftar

perintah yang bisa digunakan
di fserv.

• dir atau ls: memunculkan
daftar file dar direktori.
Direktori ditampilkan dalam
huruf besar, sementara file
memiliki ekstensi di
belakangnya. Misalnya
perintah DIR memunculkan
WINDOWS dan film.zip
maksudnya di fserv itu ada
direktori windows dan file
film.zip.

• cd: berpindah ke direktori.
Misalnya didalam direktori C:\
ada direktori WINDOWS,
maka untuk masuk ke
direktori itu ketikkan perintah
cd windows. Untuk kembali
ke direktori diatasnya gunakan
perintah cd.. (dua titik
dibelakang penting!)

• get: meminta file dan
memasukkannya ke daftar
antrian untuk di-download.
Misalnya: perintah get
film.zip akan memulai proses
pen-download-an file
film.zip. Ingat, jangan
memasukkan ukuran file di
dalam baris perintah.

• sends: menampilkan
informasi mengenai proses
pengiriman yang sedang
terjadi. Catatan: Kadang-
kadang beberapa server
mungkin menyembunyikan
perintah ini.

• queues: menampilkan
informasi mengenai antrian.
Juga menunjukkan lokasi

urutan antrian Anda pada
daftar tersebut.

• clr_queues: menghapus
antrian Anda dari daftar.

• clr_failqueues: menghapus
antrian yang gagal. Catatan:
perintah ini hanya berlaku
pada fserv yang mendukung
fasilitas pengiriman ulang
untuk file yang gagal.

RANGKUMAN
Jadi kalau boleh

dirangkum, untuk
menyederhanakan tulisan yang
panjang di atas, tahapan yang
harus Anda lakukan untuk bisa
men-download suatu file dari
IRC channel adalah:
1. Lakukan pengaturan awal

pada IRC client (lihat artikel
sebelumnya pada PCplus 3
minggu yang lalu).

2. Cari channel IRC yang
memiliki file yang bisa di-
download.

3. Bergabung ke channel
tersebut.

4. Cari lokasi file tersebut
(biasanya dengan perintah
!list).

5. Cari tahu perintah trigger
yang dibutuhkan untuk bisa
masuk ke fserv tempat file
yang Anda inginkan berada.

6. Masuk ke direktori
penyimpanan file tersebut.

7. Minta file tersebut dengan
perintah get.

8. Bersabar menunggu giliran
dalam proses antrean.

Semoga berhasil! Karena
seperti proses memancing ikan,
awalnya selalu sulit. Tetapi
sekali berhasil, Anda akan
kecanduan. Percaya deh! PC+

Gambar 1

Gambar 2
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Satelindo:
Tingkatkan Memori SIM Card,

Tingkatkan Layanan Masyarakat

F.X. Bambang Irawan
fbi@e-pcplus.com

Y

Pernahkah Anda
mengalami

“kekurangan”
memori untuk

menyimpan SMS atau
phone book? Jangan

buru-buru memaki-
maki ponsel. Bisa jadi

justru masalahnya
adalah karena SIM

Card Anda.

a, SIM Card
(Subscriber Identity
Module Card)
konvensional yang

masih berkapasitas 8KB masih
banyak beredar dan mungkin
salah satunya adalah yang Anda
gunakan. Dengan kapasitas

sekecil ini memang Anda masih
bisa melakukan aktivitas
menelepon atau SMS dengan
lancar. Namun jika tingkat
aktivitas Anda mulai menanjak,
phone book Anda terus
menggembung, dan SMS terus
dilayangkan dan berdatangan,

maka kemungkinan besar Anda
akan merasa kewalahan.
PHASE 2+

Beruntung jika ponsel Anda
sudah mempunyai kapasitas
memori built-in yang besar dan
dapat dimanfaatkan untuk
menyimpan data-data seperti record
panggilan, phone book, dan Inbox
SMS. Dengan ponsel berkapasitas
memori yang besar ini, SIM Card
Anda yang berbasis teknologi smart
card tersebut akan lebih bisa
bernapas lega karena tidak
sendirian menanggung sesaknya
data yang Anda simpan.

Bahkan sekarang, ponsel
dengan kategori smart phone sudah
bisa mengelola data lebih gembung
berkat dukungannya terhadap
memori eksternal seperti MMC
(Multimedia Card) atau Memory
Stick Duo. Saat ini, memori eksternal
jenis ini sanggup menyimpan data
sampai 128MB.

Namun sebaliknya, meski
ponsel Anda sudah canggih dan
berkapasitas besar itu, namun jika
SIM Card-nya payah karena tidak
mendukung layanan-layanan
menggiurkan yang ditawarkan
oleh operator seluler. Dengan SIM
Card berkapasitas besar, operator
memang leluasa menawarkan
berbagai layanan bernilai tambah
(Value Added Services, VAS) yang
lebih interaktif. Pelanggan akan
merasa mempunyai alat
komunikasi yang optimal jika
piawai menggunakan layanan
VAS yang umumnya saat ini
berbentuk menu browser yang
berisi informasi-informasi bisnis
dan hiburan.

Ada beberapa periodisasi SIM
Card seiring dengan tahapan-
tahapan yang digapai oleh GSM.

SIM Card pada GSM Phase 1 hanya
mempunyai memori sebesar 3KB
(Kilobyte) yang digunakan untuk
menyimpan nomor-nomor
alfanumeris. Sedang pada GSM
Phase 2 mampu mengusung
8KB dan selain digunakan
untuk menyimpan
nomor-nomor
alfanumeris dan
phone book, juga
digunakan untuk
menyimpan SMS.
Ya, baru pada
GSM Phase 2
layanan SMS
(Short Message
Service) sudah bisa
diselenggarakan.

Nah, SIM Card pada
GSM Phase 2+ mampu
mengangkut memori sebesar
32KB sekaligus memungkinkan
melakukan perintah dengan
command dari SIM Card dan
dieksekusi di ponsel. Pada fase ini
pula aplikasi pada ponsel dapat
dikembangkan.

MATRIX 64K DAN MENTARI
32K

Satelindo merupakan
operator yang tahun 2003 ini
memfokuskan perhatian pada
peningkatan kapasitas kartu-kartu
yang disuguhkannya. Baik kartu
prabayar Mentari maupun Matrix
sama-sama “dinaikkan” kapasitas
memorinya. Mentari konvensional
yang semula hanya mempunyai
kapasitas 8KB digenjot
kapasitasnya menjadi 32Kilobyte
melalui kartu Mentari 32K.
Sedang Matrix yang semula
berkapasitas 8KB, 16KB, dan
terakhir 32KB, disediakan versi
upgrade-nya menjadi 64KB.

Ponsel
berme-

mori besar
dengan SIM

Card besar
adalah paduan

sempurna untuk
layanan bernilai

tambah.

Fo
to

-fo
to

: A
RE

/PC
plu

s

Beragam layanan melalui Satelindo@ccess

Dengan kapasitas memori
pada kartu sebesar 32KB, maka
Mentari 32K dapat menampung
sebanyak 30 SMS dan 250 entri
phone book. Ini jauh lebih banyak
dibanding Mentari lama (8K) yang
hanya mampu menyimpan
masing-masing 20 SMS dan 100
entri phone book. Selain itu,
dengan kartu ini kita juga
mendapatkan menu browser
Satelindo@ccess yang dapat kita
gunakan untuk mem-pull
berbagai informasi aktual yang
disediakan oleh operator dan
content provider.

Sebenarnya sebelum Mentari
32K ini, Satelindo sudah menawar-
kan kartu Mentari dengan kapa-
sitas yang sama, 32KB, bernama
Mentari Plus. Namun, dalam peng-
amatan, kartu ini kurang men-
dapat sambutan, kemungkinan
besar karena desain dan position-
ing-nya yang terlalu tinggi level-
nya dibanding dengan segmen
yang sebenarnya ingin disasar.
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Sedang kartu Matrix 64K, selain
mengubah tagline promosi menjadi
“The freedom to be you”, juga
menggenjot penyimpanan memori
sampai 30 SMS dan lebih dari 500
entri phone book. Matrix
sebelumnya mampu menyimpan
SMS sampai 10 (8KB), 20 (16KB), dan
55 (32), serta menyimpan entri
phone book sebanyak 50 (8KB), 100
(16KB), dan 200 (32KB). Dibanding
dengan Matrix 32KB, Matrix 64KB
memilih memperkecil kuota
penyimpanan SMS dan lebih suka
memperbesar kuota phone book
sampai 500 entri!

VALUE ADDED SERVICES
Dengan memori yang lebih

besar berikut kapabilitas SIM
Application Toolkit (SAT) pada pada
ponsel yang mendukung spesifikasi
Phase 2+, banyak kemungkinan
layanan yang bisa ditawarkan oleh
operator. Misalnya:

• menu khusus yang bisa
dipersonalisasi pada SIM Card

• antarmuka menu yang lebih
mudah dipahami

• layanan interaktif (suara dan
data)

• transfer data yang lebih aman
• layanan data interaktif (seperti

bursa saham, valuta asing,
cuaca)

• layanan perbankan atau
pembayaran lainnya

• e-mail
• Location Based Service (LBS)

Maka setelah menggenjot
pasar agar menggunakan atau
bermigrasi ke kartu-kartu dengan
memori minimal 32K, Satelindo
langsung menggelar berbagai
layanan bernilai tambah. Layanan
pertama yang langsung dapat
dirasakan sebagai benefit memori
besar tersebut adalah “New”
Satelindo@ccess. Pada
Satelindo@ccess versi baru ini
terdapat dua kategori besar layanan
informasi, yaitu Info& Transaksi
(berisi informasi-informasi ekonomi,
kurs, bursa saham, politik,
olahraga, mobile banking, hotel &
restoran, pesawat & kereta api, jalan
tol, bioskop & gosip artis, dan
transaksi tagihan & pulsa) dan
Hiburan (download ringtone,
logo operator, picture message,
graphic, screen saver, kirim e-mail,
kuis, game, chatting, dan
astrologi).

Layanan mutakhir yang barus
aja dirilis adalah mobile banking.
Untuk layanan ini Satelindo
menggandeng tangan bank
kondang BCA dan menjulukinya
dengan m-BCA. Layanan mobile
banking ini segera mendapat
sambutan dan menggugah
pelanggan-pelanggan dengan kartu

lama bermemori kecil
segera meng-upgrade
kartunya demi
mendapatkan
kenikmatan mengelola
duitnya di BCA melalui
peranti ponsel yang
selalu mereka sanding
siang malam.

Masih banyak
kemungkinan layanan
berbasis SIM Card yang
berkecukupan memori.
Misalnya, dengan
Location Base Service

(LBS) kita bisa mendapatkan
berbagai layanan kreatif yang
memanfaatkan kemampuan untuk
mengenali lokasi keberadaan SIM
Card. Berdasarkan kapabilitas itu
dapat dikembangkan berbagai
layanan seperti: keamanan, peta,

Teknologi SIM Application Toolkit
SIM Application Toolkit (SAT) adalah seperangkat perintah yang

menentukan bagaimana SIM Card berinteraksi dengan dunia luar dan
memperluas protokol komunikasi antara kartu dengan handset. Dengan SAT,
kartu jadi berperan proaktif (SIM melakukan perintah-perintah secara
independen terhadap pesawat dan jaringan).

Cara kerjanya, seperti ditulis oleh Budi Mulyono pada PCplus edisi 80,
adalah berdasarkan prinsip master-slave. Ponsel selaku master menanyakan
apakah SIM mempunyai kemampuan Phase2+. Jika dijawab ya, maka
selanjutnya SIM akan memberitahu ponsel adanya aplikasi dalam SIM. Dalam
spesifikasi disebutkan beberapa kemampuan yang bisa dimiliki SIM, yaitu
Setup Menu (untuk membuat dan menampilkan menu ), Select Item (untuk
membuat pilihan menu), Get Input (untuk meminta masukan dari user
melalui ponsel), Send SM (untuk mengirimkan SMS), Setup Call (untuk
melakukan panggilan ke nomer tertentu), dan lain-lain. Setiap kemampuan
atau perintah yang disebutkan tadi mempunyai sederetan setting parameter
masing-masing. PC+

Kartu Mentari 32K (kiri) dan Mentari 8K
(kanan).

program-program penawaran, dan
sebagainya.

Hanya saja masalahnya
mungkin akan menjadi klasik:
dibutuhkan content yang killer
berikut provider yang pinter
menangkap kebutuhan. Di tanah air
operator sulit “menemukan”
content provider, tutur Johny
Swandi Sjam, Direktur Utama PT
Satelindo. Padahal, lanjutnya, di
Jepang layanan VAS digandrungi
oleh pengguna ponsel dan ada
berpuluh-puluh perusahaan
penyedia layanan.

Operator dan content
provider memang mempunyai
tugas berat mengingat SIM Card
di masa depan bisa saja mengarah
ke kapasitas dengan level “mega”
dan ponsel pun sudah umum
ditancapi memory card yang

memuat lebih banyak data untuk
diproses. Gabungan keduanya,
ponsel bermemori besar dengan

SIM Card bermemori besar adalah
paduan sempurna untuk layanan
bernilai tambah. PC+
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Menonaktifkan Setting
Jaringan pada Control Panel

Menghilangkan
Underline pada Link

Kali ini kita akan membahas
mengenai bagaimana cara
menonaktifkan setting jaringan
yang dapat diakses melalui
Control Panel. Menonaktifkan
setting jaringan di sini bukanlah
membuat Windows agar tidak
dapat mengakses jaringan,
melainkan mengedit registry
untuk menyembunyikan kontrol
jaringan agar setting jaringan
yang telah Anda buat
sebelumnya tidak dapat diakses
atau diubah.

Ada berbagai cara untuk
mengamankan setting jaringan
dari tangan-tangan jahil. Mulai
dari mengubah nama,
memindahkan atau menghapus
file network.cpl yang terdapat
di folder system Windows
hingga melakukan berbagai
penonaktifan fitur jaringan
melalui registry. Apapun cara-

cara yang telah Anda lakukan
untuk mengamankan sistem, trik
berikut ini dapat Anda gunakan
untuk memperkuat atau
menambah keamanan Windows.
Ikuti langkah-langkah berikut:
1. Klik [Start]>[Run] kemudian

ketik regedit untuk
menjalankan Registry
Editor.

2. Masuklah ke subkey
HKEY_CURRENT_USER\
Software\ Microsoft\
Windows\ CurrentVersion\
Policies\ Network.

3. Apabila subkey Network
belum tersedia, buatlah
subkey tersebut dengan
mengklik kanan mouse lalu
pilih [New]>[Key], kemudian
beri nama Network.

4. Setelah berada pada subkey
Network, buatlah sebuah
DWORD value baru. Caranya,

klik kanan mouse pada bagian
kanan window lalu klik
[New]>[DWORD value].

5. Beri nama DWORD value tadi
dengan nama NoNetSetup.

6. Klik dua kali entry yang baru
Anda buat tadi untuk

mengubah Value data-nya,
lalu isikan dengan nilai 1.

7. Tutup Registry Editor
lalu restart PC.

Steven Andy Pascal
steven@e-pcplus.com

Pada Internet Ex-
plorer, umumnya setiap link
yang ada pada sebuah halaman
ditandai dengan garis bawah.
Walaupun maksud dari garis
bawah ini adalah untuk
menginformasikan adanya link
yang menghubungkan sebuah
halaman dengan halaman lain,
namun tidak semua orang
nyaman dengan penampilan ini.

Jadi harus bagaimana?
Hilangkan underline tersebut!
Bagaimana caranya?
1. Klik [Start]>[Control Panel]>

[Network and Internet Con-
nections]>[Internet Options]
atau jika Anda sudah berada
di Internet Explorer dapat
langsung mengklik

[Tools]>[Internet Options...].
2. Pada jendela Internet Options

kliklah tab [Advanced].
3. Pada bagian Settings:,

carilah Underline Links.
4. Disana terdapat pilihan

Always, Hover, dan Never.
Posisi default yang biasanya
terpilih adalah Always yang
artinya setiap link yang ada
pada sebuah halaman Web
akan diberi tanda garis bawah
atau underline.

5. Jika Anda memilih Hover
maka garis-garis bawah pada
setiap link akan dihilangkan,
namun saat pointer mouse
Anda berada di atas sebuah
link, maka garis bawahnya
akan muncul. Garis bawah

tersebut akan kembali hilang
apabila posisi pointer Anda
tidak lagi berada di atas link
yang Anda tunjuk.

6. Pilihan Never akan
menghilangkan seluruh garis
bawah yang terdapat pada
link. Tidak peduli pointer
mouse Anda berada di
atasnya atau tidak, underline
akan tetap disembunyikan.

7. Setelah Anda menentukan
pilihan, klik [Apply] lalu tekan
[OK] untuk menutup window
Internet Options.
Nah, mulai sekarang Anda

tidak akan terganggu lagi
dengan underline yang terdapat
pada sebuah halaman Web.
Sebagai catatan, trik ini hanya

Sudah bosan dengan
tampilan kursor Windows XP
Anda? Tapi ketika Anda ingin
menggantinya, ternyata pilihan
yang diberikan Windows cuma
“begitu” aja, kecuali Anda
sudah menginstal Plus XP! Yang
itu pun hanya memberikan 3
varian kursor saja. Tentu saja
pilihan menggonta-ganti kursor
menjadi terbatas. Nah ini
saatnya yang tepat untuk
menginstal program Stardock
CursorXP Free, program yang
menyediakan berbagai jenis
kursor dengan tampilan 3
dimensi plus animasi dengan
efek suara. Program ini dapat
Anda download dari
www.cursorxp.com yang

menyediakan versi gratis
(CursorXP Free) maupun dengan
membayar (CursorXP Plus). Untuk
yang terakhir memiliki fitur yang
lebih komplit dan disertai suara.

Setelah program Anda
download, seperti biasa jalankan
file setup-nya dan CursorXP akan
terinstal. Menggunakannya
sangat mudah:
1. Jalankan saja programnya

dari [Start]>[All Program]>
[Stardock CursorXP] lalu klik
pada [Configure CursorXP]
untuk memunculkan jendela
CursorXP configuration
seperti pada gambar.

2. Untuk memilih kursor yang
Anda sukai klik pada
dropdown list pada menu

Theme, seperti terlihat pada
gambar penulis memilih
theme Bubblegum,
selanjutnya klik [Apply].

3. Anda juga dapat melakukan
perubahan-perubahan seperti
kecepatan berkedip,
bayangan, kontras, dan
sebagainya, lalu
menyimpannya sebagai kursor
Anda. Caranya, klik pada
tombol [Configure], lalu sorot
salah satu jenis Cursors dari
list. Kemudian klik tombol
[Configure] yang ada di
bawah, lakukan perubahan,
kemudian klik tombol [Save
as] untuk menyimpannya.
Anda dapat pula menambah

koleksi theme yang ada, yang

banyak tersedia secara gratis di In-
ternet, salah satu tempatnya ada-
lah di www.wincustomize.com

Nah, sekarang kursor Anda
menjadi lebih hidup dan siap
menemani hidup Anda di depan

komputer atau bahkan menjadi
inspirasi di saat yang
dibutuhkan. Selamat mencoba!

Fajar Sadik
diki_dq@yahoo.com

Membuat Kursor Windows XP
Lebih Hidup

berlaku jika halaman Web yang
Anda buka belum di-set oleh
Webmasternya untuk
menampilkan link dengan Hover,

Never, atau Always. Selamat
mencoba.

Steven Andy Pascal
steven@e-pcplus.com
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Membuat Katalog Gambar
dengan Adobe Photoshop

Membuat Lens Flare Photoshop
untuk CorelDraw

CorelDraw tidak menyedia-
kan fasilitas lens flare. Untuk itu
kita perlu menggunakan Photo-
Shop yang hasilnya di-import di
CorelDraw sehingga objek ca-
haya (Lens Flare) dapat kita atur
posisinya dengan bebas.
Untuk mengikuti latihan ini
penulis menggunakan
CorelDraw versi 9 dan Adobe
Photoshop 5.0. Pembaca dapat
pula mengikutinya meski

menggunakan versi yang lebih
tinggi.

1. Aktifkan PhotoShop, buat
file baru melalui menu
[File]>[New], dengan
background gambar
menggunakan warna hitam.

2. Beri efek/filter cahaya
dengan mengklik menu
[Filter]>[Render]>[Lens
Flare], dengan nilai

Brightness 130% (Gambar 1).
3. Buat seleksi seluruh gambar

dengan mengklik [Select]>[All],
lalu klik [Edit]>[Copy]
untuk meng-copy.

4. Aktifkan tab Channels,
buat channel baru dengan
tombol [Create New
Channel], maka
akan muncul channel dengan
nama Alpha 1.

5. Tampilkan hasil copy ke

channel Alpha 1 dengan
mengklik menu[Edit]>[Paste],
maka gambar lens flare akan
muncul dengan warna
grayscale.

6. Atur intensitas gelap terang-
nya melalui menu [Image]>
[Adjust]>[Levels] sehingga
gambar lebih kontras.

7. Aktifkan tab Layers dan layer
background, lalu isi seluruh
gambar dengan warna putih
dengan cara mengklik menu
[Edit]>[Fill].

8. Save pekerjaan Anda yang
dengan format TIF melalui
menu [File]>[Save A Copy].

9. Aktifkan CorelDraw,
persiapkan gambar bitmap

planet dan teks sesuka Anda
seperti ditunjukkan Gambar
2, lalu import gambar lens
flare yang dibuat di
photoshop dengan menu
[File]>[Import]. Maka lens
flare kini dapat Anda geser
dan atur di CorelDraw.
Hasilnya adalah seperti yang
nampak pada Gambar 3.

10. Untuk membuat lens flare
lebih nyala lagi, aktifkan ob-
jek lens flare lalu gunakan
tool Lens (icon gelas) di Co-
relDraw, kemudian atur pro-
pertinya. Lebih indah bukan?

Hendi Hendratman ST
videa@telkom.net

Gambar 2

Gambar 1

Gambar 3

Katalog gambar
biasanya dipergunakan untuk
keperluan advertising produk-
produk melalui publikasi-
publikasi dalam bentuk media
cetak. Melalui katalog gambar
yang disediakan konsumen
tidak hanya mengetahui
keterangan mengenai suatu
produk melalui penjelasan-
penjelasan berupa teks, tetapi
mereka dapat juga mengetahui
bentuk dari produk yang
sedang diiklankan tersebut.
Pembuatan katalog gambar
memerlukan gambar-gambar
yang berukuran kecil atau
seringkali disebut dengan
thumbnail agar publikasi
advertising tidak memerlukan
tempat yang terlalu besar. Jika
yang ingin dibuat hanya
berisikan sejumlah kecil gambar,
hal ini tidak terlalu merepotkan.
Bagaimana halnya jika katalog
tersebut memuat 100 jenis
gambar yang berbeda. Bisa
dibayangkan betapa repotnya.
Anda harus membuat thumb-
nail-nya dulu, kemudian
melakukan layout terhadap
berbagai thumbnail tersebut.

Kekhawatiran seperti ini
tidak seharusnya terjadi, karena

Anda dapat membuat katalog
gambar secara cepat dan
praktis dengan bantuan Adobe
Photoshop. Hanya dengan
semudah mengklik mouse
Anda dapat membuat katalog
yang berisi puluhan bahkan
ratusan gambar hanya dalam
hitungan menit. Untuk
membuatnya, ikuti langkah-
langkah berikut ini :

1. Simpan file gambar yang
akan Anda buat katalognya
dalam satu folder.

2. Buka program Adobe
Photoshop.

3. Klik [File]>[Automate]>
[Contact Sheet II …],
kemudian akan muncul dia
log box Contact Sheet II.

4. Lakukan browsing terhadap
file gambar yang telah
Anda simpan dalam satu
folder tadi dengan
mengklik tombol [Browse].

5. Pada kolom Document,
Anda dapat melakukan
perubahan terhadap
beberapa setting yaitu
menentukan besarnya
dokumen katalog gambar
tempat menyimpan thumb
nail gambar tersebut

dengan mengubah ukuran
panjang dan lebarnya yang
dapat Anda pilih dalam satuan
pixel, inchi, atau centimeter,
menentukan resolusi gambar,
menentukan color mode, dan
menentukan apakah thumbnail
tersebut menjadi satu layer
(Flatten Layers) ataukah
terpisah dalam layer yang
berbeda. Jika Anda
menginginkannya dalam satu

layer, maka berikan tanda
centang pada [Flatten All
Layers].

6. Pada kolom Thumbnail,
Anda dapat mengatur layout
dari thumbnail. Jika Anda
memilih Down first maka
thumbnaill akan disusun
secara vertikal. Sebaliknya
Across first akan menyusun
thumbnail secara horizontal.

7. Pada kolom selanjutnya Anda
dapat memberikan nama

dari thumbnail tersebut
sesuai dengan nama file
gambarnya dengan
memberikan tanda centang
pada [Use Filename
As Caption]. Di sini Anda juga

dapat mengubah jenis dan
ukuran huruf yang akan
menjadi caption dari

thumbnail tersebut.
8. Setelah Anda selesai mela-

kukan perubahan terhadap
setting di atas, klik OK.

Tunggu dan biarkan Adobe
membuat katalog tersebut
secara otomatis dalam beberapa
menit. Setelah katalog gambar
tersebut selesai dibuat, simpan
dengan nama dan format
ekstensi file yang diinginkan
pada folder yang dikehendaki.

Arif Perdana
mail_id_2001@yahoo.com
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Cakrawala Gintings
cakra@e-pcplus.com Optimalkan Fungsi dari Hardware

dengan Software yang Tepat
Suatu hardware

memiliki fungsi-fungsi
tertentu. Agar suatu

hardware itu bisa
berfungsi secara opti-

mal, ada beberapa
syarat yang harus

dipenuhi. Salah satu
syarat itu, selain

dukungan dari hard-
ware lain yang tepat,

adalah penggunaan
software yang tepat.

ua software
utama yang umum
digunakan dalam
mendukung suatu

hardware selain BIOS adalah
sistem operasi dan driver. Kedua
software tersebut akan
mempengaruhi kinerja dan juga
fungsi dari hardware tersebut.
Bukan hal yang aneh lagi bila
menggunakan driver terbaru,

kinerja suatu hardware dan ke-
stabilannya bisa meningkat.
Penggunaan sistem operasi
yang sesuai juga bisa menghasil-
kan dampak yang sama. Ini juga
dipengaruhi kenyataan bahwa
driver yang digunakan itu juga
disesuaikan dengan sistem
operasi yang digunakan.

Software Khusus
dan Software Pihak
Ketiga

Selain menggunakan sistem
operasi dan driver, suatu

hardware kadang kala
memerlukan suatu software
khusus untuk menjalankan
maupun mengatur suatu fungsi
tertentu yang dimilikinya. Tanpa
menggunakan software khusus
ini, fungsi tersebut tidak bisa
digunakan ataupun
dikonfigurasi.

Software khusus ini sering
kali memang berasal juga dari
produsen hardware tersebut.
Meskipun begitu, ada juga yang
berasal dari pihak lain alias pihak
ketiga. Software pihak ketiga ini
sering kali menawarkan fitur
yang tidak dimiliki oleh software
dari pihak produsen hardware

yang bersangkutan.
Dalam kondisi tertentu,

penggunaan software pihak
ketiga memang diperlukan untuk
menggunakan suatu hardware.
Contoh yang paling umum
adalah CD-Writer. Sebelum sistem
operasi yang banyak digunakan
mendukung penulisan
menggunakan CD-Writer secara
langsung dari sistem operasi itu
sendiri, penggunaan software
pembakar seperti Nero Burning
Rom diperlukan untuk
melakukan operasi penulisan

pada CD-Writer
tersebut.

Tidak
mengherankan bila
menggunakan soft-
ware pembakar seperti
Nero Burning Rom tadi
harus diperhatikan
versinya, telah
mendukung CD-Writer
yang digunakan atau
tidak. Bila belum, tentu
saja software
pembakar tersebut
kemungkinan tidak
akan mendukung
pembakaran
menggunakan CD-
Writer tersebut. Oleh
karena itu
menggunakan CD-
Writer yang baru harus
disertai juga dengan software
pembakar yang sesuai.

Fungsi Tertentu dari
Suatu Hardware

Untuk kasus
CD-Writer ini, selain
software pembakar
pihak ketiga,
kadang kala
software khusus
dari pembuat CD-
Writer tersebut
diperlukan untuk
mengaktifkan
fungsi khusus dari
CD-Writer tersebut.
Contoh dari kasus
seperti ini adalah
PlexWriter Premium
yang pada
beberapa edisi yang
lalu pernah PCplus
bahas.

Untuk
mengaktifkan GigaRec,
diperlukan software yang diberi
nama PlexTools Professional.
Tanpa software ini, fitur GigaRec
sejauh ini tidak bisa diaktifkan
sehingga seolah-olah

mengurangi kemampuan dari
CD-Writer tersebut. Kasus yang
bisa dikatakan memiliki
kemiripan dengan hal ini adalah
kasus pada kartu grafis ATI
Radeon. Kartu grafis ATI Radeon

yang banyak beredar saat ini
memerlukan driver dan sebuah
software khusus yang juga
berasal dari ATI untuk bisa
digunakan secara optimal.

D

Memang untuk sebagian besar
keperluan, menggunakan driver
saja sering kali sudah memadai.
Software yang paling penting di
antara keduanya memang tentu
saja adalah driver ini.

Software lain yang
dimaksud di atas adalah ATI
Control Panel yang
menawarkan beragam
pengaturan dari kartu grafis ATI
Radeon yang digunakan.
Pengaturan ini seperti memilih
output yang dikehendaki,
mengatur antialiasing, dan
mengatur video overlay.

Selain CD-Writer dan kartu
grafis, hardware lain juga
banyak yang memerlukan
software khusus selain driver
untuk mengatur suatu fiturnya.
Kartu suara seperti Audigy
misalnya, membutuhkan
software khusus untuk
mengonfigurasi SoundFont
yang di-load, tidak cukup hanya
dengan driver. Suatu fitur baru
pada prosesor juga sering kali
membutuhkan software yang
tepat agar dapat dimanfaatkan.

Salah satu contohnya
adalah Hyper-Threading pada
Pentium-4 dengan TMPGEnc
seperti yang pernah PCplus
sajikan. Oleh karena itu, agar
penggunaan hardware bisa
secara optimal juga diperlukan
perhatian pada software yang
mendukungnya.

Software ini tidak hanya
sebatas BIOS, sistem operasi,
dan driver saja, tetapi software
pendukung lainnya (bila
memang tersedia) juga harus
diperhatikan.

Software pendukung
lainnya ini kadang kala sudah
tersedia pada CD yang
disertakan bersama hardware,
namun bila belum ataupun
ingin menggunakan yang
terbaru bisa mencarinya pada
situs yang bersangkutan.  PC+

Untuk mengaktifkan GigaRec diperlukan PlexTools Professional

ATI Control Panel sering terlupakan
untuk di-install

Hyper-Threading telah didukung oleh
TMPGEnc
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Trik Bermain Playstation
dengan Aman pada PC Anda

N

Anda yang gemar
menggunakan

komputernya  untuk
bermain game,

terutama game-game
dari Console Play-

Station One, tentulah
sudah mengenali betul

dengan nama Emula-
tor PlayStation semisal

Connectix Virtual
Game Station atau

juga Bleem! Play-Sta-
tion Emulator.

amun demikian,
meski Emulator PS
tersebut dapat
membuat kita puas dan

senang karena  dapat
memainkan CD game dari
console PS One, terkadang kita
harus membayar mahal karena
CD-ROM cepat rusak atau
menjadi lambat kinerjanya..
Kerusakan yang dialami oleh CD-
ROM ini misalnya tidak lagi bisa
membaca keping CD lainnya,
menjadi lambat, atau lama dalam
mengakses sebuah CD. Bahkan
terkadang CD-ROM tidak mampu
lagi untuk membaca sebuah CD
Audio.

Tentulah bila hal ini terjadi
akan memaksa kita untuk segera
mengganti CD-ROM tersebut
dengan yang baru untuk
menjalankan Emulator PS tadi.
Selanjutnya, kerusakan yang
tidak kita inginkan akan terulang
lagi akibat bermain PS Emulator
pada PC. Jika hal ini terus terjadi
selama berulang-ulang,
bayangkan keraguan kita untuk
bermain PS pada PC. Berapa
besar biaya yang akan kita
keluarkan untuk mengganti atau
memerbaiki CD-ROM rusak
tersebut.

Mengapa hal ini dapat
terjadi? Jawabannya mudah saja.
CD-ROM yang digunakan untuk
menjalankan CD game PS One
selama menjalankan program
Emulator PS akan bekerja pada
putaran tertinggi sehingga akan
menyebabkan CD-ROM akan
menjadi cepat rusak. Selain itu,
memainkan sebuah CD game
milik Console PSOne biasanya
akan menghabiskan waktu
berjam-jam sehingga akan
membuat CD-ROM akan cepat
rusak karena dipaksa untuk
berputar secepat-cepatnya
(maksimal) dan menjadi cepat
panas pada bagian motornya.

Apabila takut kerusakan itu

akan terjadi pada CD-ROM akibat
menggunakan Emulator PS,
untuk menghindarinya ada suatu
cara yang  ampuh. Bahkan
dengan cara ini penulis bisa
bermain PS pada PC selama
berjam-jam.

Adapun syarat yang perlu
dimiliki untuk bisa menggunakan
cara ampuh ini adalah Anda
harus memiliki ruang kosong
pada harddisk minimal 4 atau
5GB. Akan tetapi, semua itu
tergantung pada koleksi games
PlayStation yang Anda miliki dan
yang sering Anda mainkan.
Selain itu Anda harus memiliki 2
buah software untuk
menjalankan cara ampuh ini
yaitu Virtual Drive dan software
pembuat image CD.

Software Virtual Drive yang
penulis pakai adalah DAEMON
Tools V3.23 atau DAEMON Tools.
Anda men-download-nya di
http://www.daemon-tools.com
atau di www.afterdawn.com
secara gratis.

Sementara, software
pembuat image CD yang penulis
gunakan adalah CloneCD versi 4
atau versi apapun yang dapat
dijalankan pada operating system
yang Anda pakai. Anda dapat
men-download-nya di http://
www.elby.org atau lebih
spesifiknya dapat di-download
pada  http://elby.ch/english/
products/clone_cd/index.html,
meski sifatnya shareware. Namun
demikian, jangan khawatir.
Meskipun shareware Anda masih
dapat menggunakannya untuk
membuat image CD game PS
berulang kali.

Setelah Anda mendapatkan
DAEMON Tools tersebut, langkah

selanjutnya adalah menginstal
software tersebut pada PC Anda.
Langkah penginstalannya dengan
cara menjalankan program
setup.exe DAEMON Tools.
Kemudian, ikuti langkah
selanjutnya yang tertera pada

layar monitor
Anda. Setelah
proses penginstalan
selesai dan Anda
telah me-restart
komputer Anda,
akan muncul icon
tray DAEMON Tools
pada taskbar dan
icon DAEMON Tools
pada desktop
komputer Anda.

DAEMON Tools
ini akan muncul
secara otomatis
yang berupa icon
tray setiap kali

Anda menyalakan komputer. Bila
Anda khawatir pemunculan icon
tray dari DAEMON Tools ini dapat
mengurangi kinerja komputer
karena selalu di-load oleh
memori, Anda dapat
menonaktifkan Option Autostart-
nya dan memunculkan icon tray
tersebut bila Anda hendak
bermain PS saja. Dengan cara
mengklik ganda Icon DAEMON
Tools pada layar desktop saja.
Adapun cara menonaktifkan
Mode Autostart
adalah dengan
mengklik  kanan
pada icon tray
DAEMON Tools.
Kemudian Anda
tinggal mengklik
[Option]>[autostart].
Hilangkan tanda
centang pada icon
autostart tersebut.

Selanjutnya
Anda tinggal
menginstal soft-
ware pembuat
image CD, dalam
hal ini adalah
CloneCD. Langkah-
langkah yang dilakukan adalah
dengan menjalankan program
penginstalan CloneCD, seperti
biasa Anda tinggal mengikuti
langkah yang diberikan pada
layar monitor Anda.

Setelah terinstal akan muncul
icon tray CloneCD pada taskbar
dan icon CloneCD pada desktop.

Untuk menghilangkan icon tray
CloneCD tersebut langkahnya
adalah  dengan klik kanan icon
tray Clone CD.

Kemudian masuk ke menu
[autostart]. Hilangkan tanda
centang pada tulisan Auto-start.
Kemudian  akan muncul kalimat
yang mengonfirmasikan apakah
Anda ingin menghilangkan
Autostart tersebut sehingga tidak
akan menggunakannya lagi
setiap kali komputer menyala,
klik [Yes/OK].

Untuk menggunakan
CloneCD, Anda tinggal mengklik
ganda icon CloneCD pada
desktop Anda atau melalui menu
[Start]>[Program]. Akan muncul
jendela registrasi. Anda bisa
menggunakannya selama jangka
waktu 21 hari. Jika belum
memiliki nomor register, untuk
menjalankannya Anda dapat
mengklik kata Try It! pada
jendela registrasi tersebut.

Jika Anda ingin membuat
Image CD game PS, Anda tinggal
mengklik gambar CD
berkacamata (gambar default-
nya) yakni yang bertuliskan Read
to Image file di bawah gambar
tersebut.

Selanjutnya akan tampil tab
Select CD-Reader.  Anda tinggal
memasukkan CD game PS Anda
tersebut ke dalam CD-ROM lalu

klik [Next] dan CloneCD akan
otomatis mencarinya.

Akan muncul tab jenis CD
yang Anda masukan tadi yakni
Audio CD, Data CD, game CD dan
Multimedia Audio CD. Dalam hal
ini pilihlah Game CD (jika Game
CD tidak berhasil dibaca oleh
DAEMON Tools, Anda dapat

memilih menggunakan Data CD).
Kemudian klik kembali [Next].

Setelah itu akan muncul
penentuan lokasi di mana Image
CD game PS tersebut akan
disimpan dan juga nama dari
image CD game PS tersebut
(default-nya bernama Image.cd),
dengan mengklik [Browse], Anda
dapat tulis sendiri nama image-
nya dan Anda dapat menentukan
lokasinya penyimpanannya.
Selanjutnya klik [OK].

Proses pembuatan Image
CD pun akan berlangsung.
Lamanya sesuai dengan jenis
CD ROM yang Anda gunakan.
Jika proses pembuatan image
gagal, CloneCD akan
memberitahukan Anda apakah
ingin di teruskan atau tidak
dan apakah ingin membuang
image yang tidak komplit (yang
tadi gagal dibuat). Jika telah
selesai akan muncul suara
tanda selesai.

Untuk dapat memainkan
Emulator PS Anda tinggal
melakukan langkah-langkah
sebagai berikut:
1. Klik dua kali icon DAEMON

Tools di desktop.
2. Klik kiri pada icon tray

DAEMON Tools tersebut, lalu
klik pada bagian Device
O:[huruf drive virtual
Anda:]No Media. Di sinilah
Image CD dibutuhkan.

3. Jika Anda telah membuat
image CD game yang ingin
Anda mainkan, Anda tinggal
mencari lokasi image CD
game PS tersebut dan
mengklik ganda nama image
CD game PS tersebut
sehingga pada DAEMON
Tools di bagian Device
O:[huruf drive virtual
Anda:]No Media akan
menjadi Device O:[huruf drive
virtual Anda:]Alamat image
CD yang Anda buat beserta
nama image tersebut.

4. Kemudian Anda tinggal
menjalankan program
Emulator PS yang Anda miliki.
(dengan syarat di dalam CD-
ROM Anda tidak terdapat
sebuah CD).

5. Untuk mengganti CD game
yang Anda mainkan, Anda
tinggal melakukan langkah
klik kiri pada icon tray
DAEMON Tools, kemudian
klik bagian Unmount All Drive
dan lakukan langkah mulai
dari nomor 2.

6. Untuk keluar mematikan
DAEMON Tools),Anda tinggal
mengklik kanan pada icon
tray DAEMON Tools lalu klik
[Exit].  PC+

Pra Fitria Nugraha
patrianu@yahoo.com

Pilih opsi Read to image file untuk untuk mulai
membuat file image

Pilih drive yang akan dijadikan tempat
menaruh CD game ketika file akan dibuat
image-nya
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Wordsearch Maker v2.0

Bikin Permainan Cari Kata

Browser Banyak Fitur
MyI E2

Permainan cari kata
adalah menyusun kata-kata dari
huruf-huruf yang tersusun di
dalam suatu grid. Wordsearch
Maker adalah freeware yang
dapat digunakan untuk
membuat permainan ini.
Dengan menggunakan
Wordsearch Maker, pembua-
tan permainan cari kata men-
jadi lebih mudah dibandingkan
dengan cara manual.

Wordsearch Maker sudah
menyediakan template
berukuran 15x15 petak. Kata
yang bisa dimasukkan
berjumlah 18. Sayang sekali
pembuat Wordsearch Maker
tidak menyediakan fitur untuk
mengubah ukuran template
dan jumlah kata. Padahal
dengan kustomasi seperti itu,
tingkat kesulitan permainan
yang dihasilkan bisa
“dimainkan”.

Pengisian kata-kata yang
akan dicari dapat langsung
dilakukan di grid. Caranya, klik

kiri pada petak untuk huruf
pertama sampai kotak berwarna
hijau. Untuk mengatur arah baca
(kanan, kiri, bawah, atas, atau
serong), klik tombol kanan pada
mouse sampai panah bergerak ke
arah yang diinginkan. Secara
otomatis kata akan dimuat pada
Word List. Setelah kata-kata
yang menjadi soal sudah dimuat
seluruhnya pada grid, sekarang
tinggal mengisi petak-petak
kosong. Pengisian ini bersifat
bebas. Bisa diisi manual atau
diisikan oleh Wordsearch
Maker. Kalau seluruh petak
sudah terisi, permainan bisa
dimainkan dengan menggunakan
PC atau dicetak melalui printer.

Ingin membuat permainan
cari kata dengan Wordsearch
Maker? Silakan download di
http://www.adders.org/
freeware/wsearch.html.
Ukurannya cuma 710KB.

Alex Pangestu
alex@e-pcplus.com

MyIE adalah browser
alternatif yang sangat menarik
untuk digunakan. Ada
beberapa kelebihan yang
dimiliki oleh browser yang versi
terbarunya adalah MyIE2.
Berikut ini PCPlus paparkan
kelebihan-kelebihannya.

Kelebihan pertama ini
sering dijumpai pada browser-
browser alternatif lain, yaitu
membuka halaman baru
dengan menggunakan tab,
sehingga tidak membuat
taskbar Windows secara penuh.
Namun hati-hati, bagi yang
tidak terbiasa menggunakan
tab pada saat browsing, bisa-
bisa langsung mengklik tombol
[Close] yang terletak paling
pojok kanan atas. Untunglah
MyIE2 mengonfirmasi apakah
benar MyIE2 mau ditutup.
Tombol untuk menutup suatu
halaman adalah tombol silang
yang berwarna merah, yang
letaknya berdekatan dengan
tombol [Close].

Para pengguna MyIE2
dapat menggunakan gerakan
mouse untuk melakukan
beberapa hal seperti kembali
ke halaman sebelumnya
(back), ke halaman depan
(forward), membuka halaman
baru (new page) serta
menutup sebuah tab atau
halaman (close tab). Asyik,
kan? Gerakan mouse ini harus
dikombinasikan dengan
menahan klik kanan mouse.

Super Drag&Drop.
Begitulah situs MyIE2 menyebut
kelebihan lain dari browser ini.
Teknologi ini membuat para
pengguna MyIE2 membuka
sebuah link yang ada di dalam
suatu halaman atau teks ke
halaman baru dengan
menggunakan drag and drop.
Dengan Super Drag&Drop ini,
teks yang diblok dapat dijadikan
kata kunci untuk search
engine yang default pada
MyIE2 serta menyimpan
teks yang diblok pada file
tertentu.

MyIE2 menyediakan
fasilitas untuk menjaga
privasi menyelami
Internet. Fasilitas yang
dinamakan Clean
System ini dapat
digunakan untuk
menghapus cookies,
address, history, cache,
form data dan undo list.
Sedangkan untuk
membunuh pop-up yang
sering kali muncul seperti
tembakan senapan
mesin, MyIE2
menyediakan AD
Hunter. Pengguna
MyIE2 bisa mengisi
Filter List agar pop-up
yang “dibunuh” benar-
benar pop-up yang tidak
diinginkan.

Beberapa browser
lain selain Internet
Explorer tidak memiliki

plugin GoogleBar. Namun
MyIE2 bisa dipasang plugin itu.
Tidak hanya GoogleBar,
namun juga Yahoo Compan-
ion, FlashGet dan lainnya.
Plugin seperti ini bisa di-
download dari situs yang sama
dengan MyIE2.

Tidak hanya aplikasi-aplikasi
yang berhubungan langsung
dengan Internet yang dapat

dipasang shortcut-nya di toolbar
MyIE2, namun juga aplikasi-
aplikasi lain yang ada di dalam
sistem PC.

Supaya tidak bosan dengan
tampilan yang itu-itu saja, MyIE2
menyediakan fasilitas untuk
“ganti kulit”. Kulit-kulit MyIE2
dapat di-download gratis di
www.skinnable.com/myie2.

Fiturnya banyak, kan? Kalau

ingin mencoba MyIE2, silakan
download dari
www.myie2.com. Khawatir
ukurannya terlalu besar untuk
sebuah browser dengan banyak
fitur? Tidak perlu. Ukuran paket
instalasinya cuma 1,6MB. Satu
lagi, MyIE2 gratis!

Alex Pangestu
alex@e-pcplus.com
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Panduan
Mengutak-atik Registry

Windows Registry Guide 2002

Catatan Kecil
di Desktop

Magic Notes v3.3

Registry, seperti yang
sudah berulang kali disebutkan
di PCplus, adalah sebuah
database yang digunakan untuk
menyimpan berbagai setting
Windows. Registry ini berisi
semua informasi tentang PC,
baik hardware, software, user
maupun tampilan Windows.

Manipulasi registry sering
kali dilakukan untuk mengaktif-
kan fungsi atau mendapatkan
setting  tertentu. Karena
fungsinya yang vital, manipulasi
ini harus dilakukan dengan hati-
hati karena perubahan tertentu
pada registry menyebabkan
Windows berjalan tidak dengan
semestinya.

Bagi para pemula yang
ingin mengutak-atik registry
bisa mendapatkan berbagai
panduan manipulasi registry
dengan Windows Registry
Guide.

Windows Registry Guide
adalah kumpulan berbagai tips,
trik, dan tweak registry Win-
dows dengan tampilan yang
dibuat menyerupai Windows
Help dengan format HTML.
Anda bisa mendapatkannya
dalam bentuk file ZIP atau file
EXE dengan ukuran 675KB
secara gratis melalui

www.download.com atau
www.winguides.com. Aplikasi
ini kompatibel dengan Windows
versi 9x/Me/NT/2000 dan XP.

Setelah unzip dilakukan
akan terdapat 4 file, yaitu
readme.txt, license.txt,
registry.chm dan sebuah file
untuk meng-uninstall. Klik ganda
file registry.chm untuk memulai
membaca berbagai trik yang
disediakan.

Tampilan Windows Regis-
try Guide terbagi
menjadi 2 panel. Panel
sebelah kiri berisi index
yang terdiri dari 6
topik utama: Hard-
ware, Network,
Security, Software,
Tips and Trick dan
Windows. Masing-
masing topik memiliki
beberapa subtopik
dengan ruang lingkup
yang lebih spesifik.
Pada panel sebelah
kanan ditampilkan
detail dan link masing-
masing topik. Anda
cukup melakukan klik
pada link yang tersedia
sesuai dengan judul
yang diinginkan maka
penjelasan tentang

pengeditan registry tersebut
akan ditampilkan.

Pada Windows Registry
Guide ini juga disediakan
Registry FAQ yang berisi
penjelasan singkat tentang
registry Windows. Selain cukup
berguna bagi para pemula,
berbagai file ini pun bisa
digunakan sebagai kumpulan
informasi bagi Anda yang
memang sudah memahami
registry.

Jika mengunjungi situs
www.winguides.com, Anda
akan menemui versi 2003 yang
menyediakan tutorial registry
yang lebih lengkap untuk para
pemula disertai dengan berba-
gai link ke sumber-sumber infor-
masi registry di Internet. Namun
sayangnya, versi tersebut tidak
tersedia secara cuma-cuma.

Parlindungan Manalu
parlindunganmanalu@yahoo.com.sg

Sering membuat catatan
kecil di meja kerja Anda? Kemu-
dian catatan tersebut jatuh atau
terselip di tumpukan pekerjaan
Anda sehingga Anda kesulitan
mencarinya? Kemudian supaya
hal itu tidak terjadi lagi, Anda
pergi ke toko buku dan
membeli sticky notes (setumpuk
kertas kecil berwarna kuning
dengan lem di ujungnya). Anda
tinggal menulis catatan kecil
Anda di kertas tersebut, sobek
dari tumpukannya dan
tempelkan di pinggir monitor,
meja atau di mana saja.

Nah, sekarang hal itu bisa
Anda lakukan dengan PC Anda.
Magic Notes adalah sebuah
aplikasi yang fungsinya mirip
dengan sticky notes, hanya saja
Anda “menempelkannya” di
desktop Windows Anda. Tidak
hanya warna kuning, tapi juga
bisa diganti menjadi biru, hijau,
abu-abu, ungu, atau merah.

Anda bisa membuat

sebanyak mungkin catatan de-
ngan judul untuk setiap catatan
tersebut. Untuk menghemat
tempat, setiap catatan dapat di-
minimize sehingga yang terlihat
hanya judulnya saja. Masing-
masing catatan juga dapat diatur
tingkat transparency-nya
sehingga bisa tembus pandang.

Sebagai pelengkap, ada juga
alarm untuk mengingatkan Anda
akan hal-hal yang harus Anda la-
kukan. Anda juga dapat mem-
buka situs Internet dari notes
Anda. Dan bila Anda tergabung
dalam suatu jaringan, Anda
dapat mengirim notes kepada
teman Anda melalui jaringan.

Magic Notes merupakan
shareware dengan masa trial 45
hari yang dapat Anda download
di www.magicnotes.com de-
ngan setup file sebesar 706KB.
Magic Notes dibandrol dengan
harga US$15.

Jimmy Sundjaja
bintang@rad.net.id
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Persaingan PC TentengTerbaru:
SEKSI, DINAMIS,

EKONOMIS

Alois Wisnuhardana
wisnu@e-pcplus.com

Bodinya sama-sama
manis dan seksi. Bila

tak dibopong agak
lama dan cuma dielus

sekelebatan, pasti
banyak yang bilang

keduanya tak ada
beda. Yang satu

tenaganya perkasa,
sedikit gemuk, tapi

gampang berkeringat.
Yang satu lagi lebih

lembek tenaganya tapi
tak gampang

berkeringat dan
bentuknya pun lebih
langsing ideal. Kalau

mau menjamah, yang
gemuk justru lebih

murah ketimbang yang
langsing. Yang satu

agak hiper sedangkan
yang satunya lagi
tidak. Pilih mana?

angan ngeres
dulu! Kita berbicara
perkara komputer, bu-
kan yang lain. Tepatnya,

tentang desknote dan notebook!
Ya, secara fisik, desknote

dengan notebook sama-sama
manis dan seksi. Kalau Anda
sekadar memandang, tentu tak
bakal tahu mana desknote mana
notebook. Desknote, umumnya
tenaganya lebih besar ketimbang
notebook karena prosesor yang
digunakannya pun berbeda.

Oleh karenanya, desknote
pun lebih punya tenaga ekstra
dibandingkan notebook
tradisional yang berprosesor
mobile. Akan tetapi, karena
kelebihannya itu, ia juga lebih
gampang berkeringat alias lebih
mudah mengeluarkan panas. Tak
tanggung-tanggung, panas yang

dikeluarkannya bisa dipakai
untuk menghangatkan kulit.

Desknote juga lebih hiper
alias lebih rakus dibanding note-
book dari sisi listrik yang dikon-
sumsi. Desknote memang diran-
cang untuk dipakai di tempat
yang ada jaringan listriknya, se-
dangkan notebook bisa dipakai
di mana saja dengan mengan-
dalkan baterai yang disertakan.
Selain itu, prosesor notebook
juga ditambahkan dengan
aplikasi pengelola resources.

Yang paling menarik, un-
tuk bisa membopong desknote
ke mana-mana, Anda tak perlu
mengeluarkan uang sebanyak
bila ingin membopong note-
book. Harga sebuah desknote
bahkan hanya sedikit di atas
harga sebuah komputer
dekstop. Padahal komputer
desktop cuma bisa diajak
bermain di rumah dan bodinya
pun gembrot habis dibanding-
kan desknote. Tak heran bila
selama kuartal kedua tahun lalu
hingga sekarang ini, komputer
tenteng (desknote dan notebook)
pertumbuhan-nya di seluruh
dunia bisa mencapai 22%.
Sementara komputer dekstop
termehek-mehek lantaran hanya
naik 5%.

Ragam Spesifikasi
Notebook tradisional yang

menggunakan prosesor khusus
notebook pasti selalu keting-
galan spesifikasi dan terutama

kecepatannya ketimbang PC
desktop. Harganya pun bisa dua
sampai tiga kali lipat lebih mahal
meskipun spesifikasinya jauh ke-
tinggalan di bawah PC desktop.

Pada awal kemunculannya,
sebagaimana dipaparkan di atas,
orang lebih mengenal produk
semacam ini sebagai desknote.
ECS termasuk yang
memopulerkan penggunaan
istilah ini. Namun dalam

perkembangannya, kriteria pen-
definisian desknote tampak men-
jadi lebih rumit dan menjadi ku-
rang pas. Lihat saja! Bila desk-
note didefinisikan sebagai note-

book yang menggunakan prose-
sor desktop, definisi ini sudah
gugur karena ada beberapa
produk yang menggunakan
prosesor khusus untuk note-
book alias mobile processor. Sa-
lah satunya adalah ECS yang
menggunakan prosesor Gigapro
atau Transmeta. Sementara
merek Sony atau Fujitsu yang
sama-sama menggunakan pro-
sesor Transmeta tetap menye-
but produknya sebagai note-
book, bukan desknote. Apabila
desknote didefinisikan sebagai
notebook dengan harga murah,
banyak vendor yang menawar-
kan notebook berharga murah,
dan juga menggunakan
prosesor khusus notebook.

Oleh karenanya, jalan te-
ngah harus ditempuh. Ada dua
opsi yang bisa dipilih apabila me-

ngamati perkembangan pasar dan
teknologi produk-produk ini. Bisa
digunakan istilah mobile desktop
atau istilah lain yakni desktop
notebook. Definisinya sangat sim-
pel, yakni komputer jinjing yang
menggunakan prosesor desktop.
PCplus dalam tulisan ini memilih
menggunakan peristilahan yang
kedua, desktop notebook.

Definisi ini memberikan
ruang yang lebih luas bagi pro-
duk-produk terbaru, di mana

para vendor menawarkan sebuah
notebook yang betul-betul sudah
mengemas teknologi terbaru dari
teknologi PC desktop, dan dijual
dengan harga yang mendekati
atau setara dengan notebook
tradisional yang betul-betul
berprosesor mobile.

Murah-Mobile
Betulkah solusi desktop

notebook menawarkan produk
yang murah tetapi sekaligus mo-
bile? Apabila diukur dari harga
yang dibundel, produk-produk
yang ditawarkan sebenarnya
tidak semua bisa dibilang murah.
Apabila dilihat dari performansi
yang ditawarkan, bisa dikatakan
bahwa pada umumnya vendor-
vendor menawarkan berbagai
variasi, mulai dari spesifikasi yang
terbatas hingga yang wah.

Meskipun menggunakan
jenis prosesor yang sama clock
speed-nya, harga yang ditawar-
kan antara satu vendor dengan
vendor yang lain bisa sangat
berbeda. Berikut ini beberapa
komponen yang membedakan
harga sebuah desktop notebook:
• Kapasitas harddisk
• Jenis optical drive, mulai dari

CD-ROM, DVD-ROM, CD-RW,
hingga DVD-/+RW

• Jenis dan kapasitas memori,
apakah SDRAM atau DDR

• Ragam aksesori yang ditawar-
kan, mulai dari integrated
modem, LAN, hingga Wi-Fi

• Ukuran layar LCD yang
ditawarkan

• Sistem operasi yang
ditawarkan, umumnya
bervariasi antara Windows XP
Home dan Professional.

Dugaan kami, setelah tuntas
membaca tulisan ini, Anda sibuk
membolak-balik iklan notebook
yang belakangan gencar
dilakukan.  PC+

Bodinya seksi, harganya murah,
bisa dibawa ke mana-mana. Kian
banyak harga dan spesifikasi
yang bisa dipilih. Semuanya
tergantung selera dan ukuran
kantong.

J

A
RE

/P
C

pl
us



 | 17

plusFokus PCplus 140
IV • 20 - 26 Agustus 2003

Plus Minus
“Desktop Notebook”

Silvester Sila Wedjo
sila@e-pcplus.com

Ketika komputer  yang
sekarang ini kita kenal
sebagai desktop note-

book muncul sekitar
akhir tahun 2000,

banyak pihak yang
perpikir sinis terhadap

nasib perangkat
semacam ini. Banyak

sebutan yang
kemudian muncul

berkenaan dengan
munculnya debutan

baru tersebut. “Note-
book banci” atau

“notebook bukan, PC
pun bukan”.

anci jadi istilah
populer yang kerap
dilontarkan para
pemerhati IT untuk

menyebut desktop notebook.
Julukan ini wajar saja terlontar
lantaran pada masa itu masih
janggal rasanya ada “notebook”
yang menggunakan prosesor
desktop biasa. Padahal secara
kasat mata bentuknya benar-
benar persis sama seperti wujud
sebuah notebook standar.

Meski begitu, lama-
kelamaan sosok banci ini pudar
dengan sendirinya lantaran
kemampuannya sudah mendapat
pengakuan di pasar. Selain
strategi pemasaran yang jitu,
harga yang bisa menyaingi PC

B

desktop membuat banyak
konsumen tergiur. Bahkan di
tahun-tahun 2001-2002, ECS
Taiwan, salah satu pembuat
desktop notebook memperoleh
beberapa
penghargaan
berkat
inovasinya
membuat
desktop note-
book ini.

Pihak ECS
sendiri
menyebutnya
sebagai
desknote.
Kabarnya tipe
desknote
semacam ini
menjadi
primadona
penjualan di
akhir tahun
2002. Tambahan
lagi, para
pengguna PC
pun banyak yang beralih
menggunakan desktop notebook
ini ketimbang membeli notebook
yang menggunakan prosesor
mobile. Alasan utamanya tidak

lain tidak bukan adalah harga
jual yang murah. Meskipun
bentuk maupun fitur yang
diusung tidak jauh berbeda
dengan notebook yang harganya

umumnya lebih dari 1000 dolar
AS per unitnya.

Cerita tentang notebook
berprosesor desktop ini ternyata
tidak berhenti sampai di situ.

Banyak vendor besar berskala
multinational company dan
sudah punya nama besar juga
turut mengekor membuat
produk serupa. Beberapa dari

merek-merek
tersebut
memiliki tipe
yang
mengusung
spesifikasi yang
cukup
beragam.
Alasannya
jelas: Market-
nya luar biasa
besar. Ini bisa
dimaklumi
mengingat
banyak pihak
sebenarnya
ingin membeli
perangkat
semacam
notebook tapi
agak berat
dengan harga

yang ditawarkan. Padahal
mereka sangat membutuhkan
perangkat semacam ini untuk
menunjang aktivitasnya yang
cukup mobile. Makanya tak

heran jika mereka memilih
pilihan desktop notebook  yang
boleh dibilang menjadi pilihan
alternatif antara notebook dan
PC desktop biasa.

Alasan ini setidaknya
dibenarkan oleh Sutiono Gunadi,
General Manager PT Multicom
Persada, perusahaan komputer
dengan brand Mugen, yang juga
menjual desktop notebook
semacam ini.  “Pasarnya cukup
besar. Kalau kecil, tidak mungkin
merek-merek multinasional itu
juga berlomba-lomba
memasarkan notebook jenis ini,”
tambah Sutiono lagi.

Namun begitu, sebagai
sebuah produk, desktop note-
book memiliki kelemahan dan
kelebihan. Memang sangat
subjektif dan sangat tergantung
dari sudut pandang dalam
menilai produk ini. Namun, itulah
kenyataannya. Tak ada gading
yang tak retak. Begitu pula
produk ini.

Nilai plus yang paling
menonjol dari desktop notebook
semacam ini adalah harganya
yang tergolong murah. Yang
termurah misalnya harganya
hanya sekitar 4 juta rupiah lebih,
sementara yang paling mahal
berharga belasan juta rupiah.
Tentu saja dengan fitur yang
sedemikian wah. Buat yang
berkantong pas-pasan hingga
sedang, desktop notebook ini
tentu bisa menjadi salah satu
alternatif pilihan yang cukup
menggiurkan.
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Buat yang ingin Mobile tapi berkantong pas-pasan, desktop
notebook bisa jadi pilihan menarik
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 Portabel alias mudah
ditenteng-tenteng ke mana mana
juga jadi nilai plus dari desktop

notebook ini. Maklum,

bentuknya yang ramping dan
hampir seukuran dengan laptop
pada umumnya memang
membuat komputer jenis ini
mudah dibawa-bawa. Dari sisi ini,
desktop notebook memang
mengungguli PC desktop biasa
meski masih di bawah sedikit dari
notebook tradisional.

Satu kelemahan desktop
notebook  dibanding notebook
dari sisi mobilitasnya adalah
ukurannya yang relatif lebih
besar ketimbang notebook. Ini
bisa dimaklumi mengingat
prosesor yang dipakai adalah
prosesor desktop serta
mengusung baterai yang lebih
besar untuk mendukung prosesor
desktop tadi. Alhasil bobot dan
ukurannya pasti lebih besar
ketimbang notebook berprosesor
mobile.

Namun begitu, tak sedikit
pula desktop notebook yang
tidak dilengkapi dengan
baterai. Kalaupun ada,  sifatnya
hanyalah optional saat
pembelian. Makanya, desktop
notebook dengan model
semacam  ini sangat tergantung
oleh pasokan listrik dari luar.
Dengan demikian perangkat ini
sulit dipakai tanpa adanya
baterai eksternal atau arus
listrik dari PLN. Namun, bila
penggunanya membeli baterai
yang sifatnya opsional,
kekurangan ini memang bisa
diminimalisir meski waktu
pemakaiannya tidak bisa lebih
lama dibandingkan notebook
biasa.

Ini bisa dimaklumi
mengingat penggunaan prosesor
biasa pada desktop notebook ini
membuat konsumsi daya listrik
jauh lebih besar. Apalagi pada
sistem ini tidak ada mekanisme
penghematan energi semacam
Speed Step Technology pada
prosesor mobile bikinan Intel
untuk penghematan tenaga
baterai, yang memungkinkan

konsumsi daya dikurangi ketika
kerja sistem tidak terlalu berat
dan akan berdaya penuh  jika
sedang menjalankan aplikasi

berat.
Kekurangan

lainnya adalah
bobotnya yang
lebih berat dan
ukuran casing
yang lebih besar
dibanding
notebook pada
umumnya. Ini
bisa dimaklumi
mengingat
prosesor dan
beberapa
komponen yang
ditanam  adalah
prosesor desktop
biasa sehingga
membutuhkan
pembuangan
panas yang lebih
baik. Akibatnya,
casing yang
dimiliki juga
pasti lebih besar
dibanding
notebook biasa.
Bila rata-rata
notebook
berprosesor
mobile beratnya

antara 2,5 hingga kurang dari 3
kilogram, maka desktop note-
book ini umumnya punya bobot
antara 3-4,5 kilogram.

Keunggulan dari desktop
notebook ini adalah sebagian

Siapa Sih Pengguna yang Cocok?

Terlepas dari kelebihan maupun kelemahan yang dimiliki
notebook berprosesor desktop ini, sudah banyak konsumen yang
menggunakan peranti semacam ini. Dengan iming-iming harga yang
lebih murah, di samping tawaran mobilitas yang membuat
penggunanya puas, banyak konsumen yang memang merasa
terbantu dengan menggunakan tipe perangkat semacam ini.

Pengguna notebook berprosesor desktop ini sendiri sangat
beragam, mulai dari kalangan profesional hingga pengguna
rumahan. Namun umumnya para penggunanya adalah mereka yang
ingin agar program atau data-data yang disimpan bisa dibawa ke
mana. Menurut Ataka Tjandra dari ECS Indonesia, sebagian besar
pengguna desktop notebook adalah mereka yang ingin mobile
namun kantongnya terbatas. Makanya desktop notebook semacam
ini dipilih karena meskipun sifat mobile-nya hampir sama seperti
notebook pada umumnya karena gampang dibawa ke mana-mana,
harga yang ditawarkan bisa lebih murah. Kualitasnya pun lumayan.
“Hanya sedikit barang yang kembali ke kita karena adanya
kerusakan,” akunya lagi.

Ia sendiri melihat pangsa pasar untuk wilayah ini sebenarnya
besar. Hanya dulunya semua vendor tidak melihat adanya pasar
potensial seperti ini. Hal senada juga diakui oleh Setiono Gunadi
dari Mugen Indonesia, merek branded lokal yang juga memasarkan
desktop notebook semacam ini. Menurutnya pengguna notebook
semacam ini adalah mereka yang memerlukan komputer yang
mobile namun dana yang dimilikinya terbatas. “Pasarnya cukup
besar, khususnya di Indonesia yang memang kemampuan daya
belinya masih sangat rendah” imbuhnya lagi.

Sedangkan menurut Martin Wibisono dari Hewlett-Packard
Indonesia, produk notebook berprosesor desktop tidak akan
menggusur pasar notebook tradisional melainkan justru pasar PC
desktop. Hal senada dibenarkan oleh Suparwan Soelaiman dari IBM
dalam suatu kesempatan. Untuk jenis produknya, IBM
mengandalkan ThinkPad seri G40 sementara HP menawarkan HP
Presario 800.

Potensi pasar yang sedemikan besar memang sangat bisa
dipahami. Dengan harga yang lumayan terjangkau namun
mendapatkan perangkat dengan mobilitas mirip notebook memang
cukup menggiurkan sebagian orang. Apalagi fitur-fitur yang
ditawarkan juga sangat menarik, tak kalah dengan notebook pada
umumnya. Oleh karena itu, wajar jika penggunanya adalah kalangan
profesional hingga mahasiswa. Pengguna rumahan pun sudah
banyak yang lebih menggunakan desktop notebook semacam ini di
rumah mereka karena alasan mudah disimpan dan perawatannya
yang mudah. (sil) PC+

Apa Saja Merek yang Beredar?

Manisnya bisnis desktop notebook ini memang sangat terasa.
Bila dahulunya hanya satu dua produsen saja yang berjibaku di
lahan ini, balakangan vendor-vendor besar turut meramaikan pula
pertarungan. Hampir semua merek-merek terkenal mengeluarkan
pula tipe-tipe desktop notebook dengan segala kemampuannya.

Sebut saja HP, IBM, Toshiba, Dell, Acer, dan Asus yang
merupakan babon-babon untuk kelas notebook selama ini akhirnya
masuk ke gelanggang pertempuran desktop notebook ini. Itu belum
lagi merek-merek lokal macam Zyrex, Mugen, Wearnes, yang tak
kalah sengit bertarung memperebutkan pembeli. Bhinneka,
perusahaan komputer e-commerce pun ikut meramaikannya.

Akibatnya bisa ditebak. Perang harga terjadi di antara pemain.
Ini memang tak bisa dihindari mengingat pembeli potensial untuk
desktop notebook ini memang dari kalangan yang sensitif harga, di
mana harga menjadi patokan utama dalam memilih produk yang
akan dibeli. Hal ini bisa dilihat dari banyak terjualnya desktop
notebook dengan prosesor paling rendah.

Adanya perang di kelas ini diakui oleh Sutiono Gunadi dari
Mugen, yang untuk kelas desktop mobile mengeluarkan Marve 1100.
Menurutnya, perang harga ini membuat profit yang bisa diambil
untuk pasar ini menjadi sangat kecil sehingga dari kacamata bisnis
sudah tidak sehat lagi. Meski begitu, ia mengakui pangsa pasar
untuk kelas ini masih sangat besar.

IBM sendiri misalnya mengusung kelas ThinkPad G40 yang
berbasis Pentium-4 dengan kecepatan 2,4GHz, memori DDR 128MB
serta harddisk sebesar 20GB dengan harga sekitar 1159 dolar. Itu
belum ditambah fitur-fitur lain yang cukup menarik. Sementara HP
untuk saat ini paling tidak memiliki 4 buah tipe notebook yang
menggunakan prosesor desktop yaitu Compaq Evo N1020v, Presario
2543AP/2545AP, Presario 2538AP, dan nx9010 dengan pilihan
prosesor mulai dari kecepatan 2,4GHz hingga 2,66GHz.

Sementara, Mugen yang mengusung Marve 1100 yang tersedia
dalam dua tipe yaitu tipe yang menggunakan DVD dan yang
menggunakan combo. Meski begitu, dari sisi spesifikasi keduanya
mengusung prosesor kelas 1,8A yang memang ditujukan untuk
kalangan entry level yang umumnya memilih prosesor dengan
kecepatan terendah. Harga yang ditawarkan keduanya berkisar 1220
hingga 1318 dolar AS.

Di lain pihak, Elitegroups yang menjadi pelopor maraknya
desktop notebook  mengusung brand i-Buddie untuk desktop
notebook mereka untuk Indonesia memasarkan A907, A900, A901,
A928,A980,A530 dengan harga mulai dari 599 hingga 699 dolar per
unit tergantung tipenya. Jenis ini boleh dibilang desktop notebook
yang paling murah di antara merek yang lain. Meski kebanyakan
tidak menyertakan baterai di dalamnya, produsennya tetap
menyediakan baterai optional dalam paket penjualannya.

Masih banyak merek lain yang beredar yang menawarkan
desktop notebook semacam ini. Harganya pun sangat beragam
tergantung spesifikasi maupun merek yang diusung. Yang pasti,
adanya kelas ini memang seakan menjadi terobosan buat pengguna
yang ingin mobile tapi keuangannya terbatas. (sil) PC+

besar layar yang digunakan
sudah jenis LCD aktif alias TFT,
meski ukuran diagonal layarnya
sangat tergantung tipenya. Pada
umumnya ukuran diagonal layar
yang diberikan mulai dari 13,1
inci hingga 16 inci yang hampir
sama dengan layar monitor pada
notebook. Alhasil, waktu
menggunakan desktop ini,
rasanya memang sama seperti
ketika menggunakan notebook!

Apakah Bisa
Di-upgrade?

Soal kemampuan upgrade
memang sangat tergantung
merek dan tipenya. Beberapa tipe

tidak memungkinkan adanya
upgrade apapun termasuk
upgrade untuk prosesor. Ini
karena prosesor dengan board di
dalam menjadi satu.

 Menariknya, tipe lain
memungkinkan adanya proses
upgrade pada beberapa kompo-
nen penting. Umumnya memang
masih sebatas upgrade prosesor,
harddisk, atau memori, meski
salah satu merek juga mengklaim
motherboard di dalam produk
desktop notebooknya dapat di-
upgrade bila diperlukan.

Keuntungan kemungkinan
adanya upgrade ini tentu saja

jelas. Para penggunanya
sewaktu waktu bisa

mengganti prosesor,
memori, dan
harddisk dengan

kecepatan atau kapasitas
yang lebih besar sehingga bisa
meningkatkan kemampuan
perangkat ini secara keseluruhan.

Adanya kemampuan ini
memang cukup menarik buat
pengguna yang berencana meng-
upgrade atau yang merasa
kemampuan desktop notebook-
nya makin menurun karena
terlalu banyak program atau
data.  PC+
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“Pasarnya cukup besar. Kalau kecil, tidak
mungkin merek-merek multinasional itu juga
berlomba-lomba memasarkan notebook jenis ini “

Kemampuan Upgrade-nya yang lumayan jadi nilai plus jenis desktop
notebook ini
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Popularitas Microsoft
Excel sebagai program
penyunting spreasheet

telah diakui banyak
pihak.  Saat ini

telah hadir program
penyunting tak

berbayar alias
opensource

yang menjadi satu
paket dalam

OpenOffice 1.0, yaitu
OpenOffice Calc.

Seperti “saudara-
saudara”nya yang lain

(Writter, Impression,
dan Kmail Evolution),

Calc tersedia dalam
versi MacOs, Solaris,

Linux maupun
Windows.

asilitas dan alat
kerja “khas”
penyunting spreadsheet
yang disediakan Calc

antara lain:

Pemformatan Sel
Penggabungan sel,

pemecahan sel, pemberian warna
latar, corak bingkai sel diatur dari
menu [Format].

Pengurutan data
Data dapat diurutkan

berdasarkan abjad, kuantitas
secara naik atau turun (semakin
besar atau kecil). Fasilitas ini
dapat diakses melalui ikon [Sort
Ascending / Descending].

Vincent Bayu T.B.
vincent@e-pcplus.com

F

Pemformatan Angka
Angka input dapat diformat,

antara lain sebagai tanggal, mata
uang, desimal, persen, dan
lainnya. Format angka dapat
diakses melalui menu
[Format]>[Cells]>
[Numbers]>[Category].

Pemformatan
Kondisional

Pencarian dan penandaan
nilai-nilai tertentu yang ada
dalam data besar tentu menyulit-
kan. Penggunaan syarat-syarat
atau batasan tertentu dapat me-
mudahkan kerja kita.  Fasilitas ini
ada di menu [Format].  Sayang-
nya, pemformatan sudah disedia-
kan dalam pilihan siap pakai (dan
sedikit), tidak seperti di Microsoft
Excel yang bisa kita atur sesuai
corak yang diinginkan.

Penggunaan Formula
Rumus-rumus dapat kita

isikan langsung ke sel. Juga bisa
pada field formula. dan salin
antar-sel secara otomatis, persis
seperti di Microsoft Excel.  Rumus
dalam Calc juga diawali tanda =,
misalnya:  =D6*A1  atau
=E7+10%.

Operator
Penghitung

Penghitung hasil
akhir dari nilai-nilai
dalam rangkaian sel
yang berjumlah besar,
misalnya baris 1 sampai
baris 1000 dapat
didapatkan dengan
memanfaatkan
[SubTotals] pada menu
[Data].  Operasi yang
ada antara lain: nilai
terkecil dan besar (min/
max), rata-rata (aver-
age), standar deviasi,
dan lainnya.

Validitas
Penghitungan

Kesahihan cara dan
urutan penghitungan
dapat diuji melalui
fasilitas [Validity] pada menu
[Data].

Detective
Fasilitas ini di Microsoft Excel

dikenal dengan istilah Trace
Errors.  OpenOffice menyatukan
berbagai pelacakan kesalahan
dalam menu [Tools]>[Detective],

antara lain: [Trace Dependent],
[Trace Precedent], [Trace
Errors], [Mark Invalid Data].

Pembuatan Chart
dan Tabel

Data dari suatu cell range
(kumpulan sel) dapat dijadikan
sumber informasi dan kerangka

OpenOffice Calc:
Penyunting Spreadsheet yang

Gratis dan Potensial

Setelah kita membuat
pasangan kunci, maka

kita bisa melihat daftar
kunci yang sudah ada

dalam database GnuPG
dengan memberikan
perintah gpg --list-

key (Gambar 4).
Terlihat bahwa data-
base pasangan kunci

berada pada direktori /
home/willy/.gnupg/

bernama pubring.gpg
dan secring.gpg.

Sebaiknya, Anda
membuat salinan

(backup) dari database
pasangan kunci ini

sehingga jika terjadi
kerusakan pada

komputer, Anda tidak
perlu membuat

pasangan yang baru.
Cukup meng-import-
nya saja dari backup

yang telah Anda buat
sebelumnya.

erlu
diketahui, jika
suatu saat Anda
membuat pasangan

kunci baru dan berniat untuk
tidak menggunakan pasangan
kunci yang lama, maka Anda
harus menyebarkan kunci publik
Anda ke rekan-rekan agar Anda
dapat melakukan komunikasi

Pengenalan GnuPG
( Bagian 2 )

Willy Sudiarto Raharjo
willy@e-jogja.net

penyusun tabel atau chart secara
otomatis.

Blok range sel sumber data,
lalu pergunakan menu
[Insert]>[Chart] atau klik Ikon
[Insert Chart].  Pilihlah tipe dan
model chart yang diinginkan.

Masih banyak lagi fasilitas-
fasilitas pengolahan data yang
disediakan oleh OpenOffice
Calc dan tidak sulit dibedakan

dengan fungsi yang sama
(padanannya) di Microsoft
Excel, antara lain: Scenario,
Goal Seek, Filter.

Memang ada fasilitas-
fasilitas kerja di OpenOffice
Calc yang harus terus
disempurnakan kinerjanya.
Selamat mencoba.  PC+

dengan aman seperti
sebelumnya.
Kedua kunci itu merupakan
pasangan yang tidak bisa

dipisahkan.
Setiap pasangan kunci selalu
mempunyai ID yang unik. Kunci
yang Anda buat saat ini dan
yang Anda buat 5 menit
kemudian akan mempunyai ID
yang berbeda, meskipun Anda
mengisikan informasi yang
sama.

Meng-export
Kunci Publik

Kunci publik yang telah kita
buat dapat kita kirimkan ke

rekan-rekan kita, namun
sebelumnya kita
harus meng-export-
nya agar menjadi
sebuah file teks atau
ASCII, tergantung
pada selera kita.
Sebagian besar
orang cenderung memilih untuk

membuat file teks karena lebih
mudah diidentifikasi bahwa file
itu merupakan sebuah kunci
publik.

Untuk mengekspor
kunci publik kita dalam
bentuk plain text dan
bernama willy.txt,
berikan perintah gpg --
armor --export willy >
willy.txt. Parameter --
armor berfungsi untuk
menghasilkan file teks

biasa, sedangkan --export willy

berfungsi untuk melakukan
export terhadap kunci publik
milik user willy. Tanda >
merupakan pengalihan (redirec-
tion).  Artinya, mengarahkan
hasil output dari proses export ke
dalam file willy.txt. Nah, file
willy.txt inilah yang akan kita
kirimkan ke teman-teman kita.
Anda bisa melihat isi file
tersebut dengan menggunakan
perintah cat.

P

Meng-import
Kunci Publik

Selain melakukan exsport
kunci publik, kita juga bisa
meng-import kunci publik milik
orang lain, misalnya rekan kita.
Proses import sangatlah
sederhana, cukup dengan
perintah gpg –import <file>,
dimana <file> adalah nama file
yang merupakan kunci publik
dari teman kita (Gambar 5).
File ini biasanya mempunyai
dua bentuk, yaitu file teks
(plain text), atau file dalam
bentuk ASCII yang sulit untuk
dibaca.

Sebagai contoh, terdapat
file yang berisi kunci publik dari
dosen penulis, yaitu
vmueller.key.txt. Kita ingin
meng-import-nya agar disimpan
dalam database kita.

Perintahnya adalah gpg --
import vmueller.key.txt.
Setelah kita menekan tombol
Enter, maka akan nampak
bahwa kunci telah berhasil di-
import dengan baik. Untuk
melihat perubahan, Anda bisa
gunakan perintah gpg --list-
key yang akan menampilkan
semua kunci dalam database
(Gambar 6).
(bersambung) PC+

Gambar 4

Gambar 5

Gambar 6
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Macromedia
DreamWeaver:
Membangun
Homepage
Bersama

Si Penenun Mimpi

Vincent Bayu T.B
vincent@e-pcplus.com

“Penenun Mimpi”, demikian makna nama software keluaran
Macromedia ini.  Dilihat dari segi kemudahan

penggunaannya,  Dreamweaver ditujukan untuk banyak
pengguna, bukan monopoli desainer web atau desainer

homepage kampiun.

ita akan mencoba mengenal cara penggunaan berbagai tool di Dreamweaver
untuk membangun homepage sederhana, serta mem-publish-nya secara
gratisan.

Proses membangun Web kita tentu saja harus diawali dengan merancang
dalam corat-coret di atas kertas. Kita harus menentukan halaman induk (home), halaman
rujukan, serta rangkaian halaman-halaman lainnya. Selain itu juga mengumpulkan
gambar-gambar penunjang. Setelah semua persiapan matang, barulah kita masuk ke
Dreamweaver.

K

OK, kita sudah mulai mengenali beberapa fasilitas kerja awal sekaligus membuat
halaman awal homepage. Minggu depan kita akan mencoba membuat halaman
lanjutan dan menambahkan hyperlink.  PC+

Ikon
Code and
Design
New

Panah Penggulung Panel

Field
Sintaks
HTML

Tab
Common

Ikon
Insert
Table

Ikon
Split
Table

Kotak
Properties

Tab Media

Ikon
Flash
Button

Pilih Exact Fit

Teks untuk Tombol

Tab Common

Ikon Design New

Ikon Insert Picture

1. Membuka dan Mempersiapkan Layar Kerja
Saat pertama kali membuka Deamweaver versi MX, akan disajikan layar pilihan
tampilan biasa (versi klasik) atau versi MX. Pilih tampilan versi MX. Selanjutnya, klik
menu [File>New]. Sebagai pemula, kita pilih Basic Page HTML. Jika Anda ingin layar
kerja yang lega, gulung panel-panel yang tak diperlukan dengan klik panahnya.
Kita juga bisa mengetahui sintaks-sintaks bahasa HTML yang menyusun objek-
objek di halaman kerja dengan megaktifkan tab Common dan ikon [Show Code
and Design View].

2. Membuat Kerangka Dasar Halaman
Garis-garis pembatas sebaiknya kita manfaatkan untuk menyusun objek-objek di
halaman Web.  Manfaatkan tabel. Klik ikon [Insert Table]. Atur jumlah dan
pembagian kolom serta  lajur  utamanya. Jika kita ingin membagi-bagi lagi lajur
atau kolom, klik ikon [Split Cells into Colums or Rows].

3. Menambahkan Teks
Teks bisa langsung kita ketikkan dalam kolom, kemudian sunting melalui kotak
Properties, antara lain: Alignment, Size, Style, Font.

4.Menambahkan Unsur Tambahan
untuk Input atau Action
Tombol-tombol bisa kita gunakan untuk menambahkan action atau mendapatkan
input, antara lain: form isian, list menu, checkbox, tombol-tombol, dan lainnya di
tab Forms. Sekarang kita gunakan dahulu tombol beranimasi yang ada di tab
Media. Klik ikon Flash Button, pilih model dan warna tombol, berikan teks untuk
tombol, tentukan ukuran teks. Jangan lupa untuk memilih Exact Fit pada Scale
di kotak Properties tombol.  Sesuaikan ukuran tombol dan ukuran teks.

5. Memasukkan Gambar
Gambar atau foto adalah faktor yang sangat mempengaruhi daya tarik
homepage kita.  Maka, tidak ada salahnya bila kita menambahkan gambar atau
foto ke dalam homepage tersebut, di samping uraian dan story sebagai bahan
utamanya.  Klik tab Common dan ikon [Image].  Ambil gambar dari folder atau
direktori tempatnya disimpan.  Perlu diketahui, ukuran gambar untuk tampilan
Web atau homepage tidak perlu besar.  Disarankan, berformat JPG atau GIF
dengan resolusi kira-kira 75-100 dpi.  Tujuannya, agar gambar bisa cepat tampil
saat halaman Web diakses.  Sesuaikan ukuran gambar agar masuk ke dalam
“sangkar” (sel tabel)-nya.
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Hak Cipta Software, Open Source,
dan Software Freeware

NASRULLAH IDRIS
acu@bdg.centrin.net.id

Diberlakukannya UU
Hak Cipta di Indonesia,

khususnya yang
berkaitan dengan

software, jelas akan
memberikan

konsekuensi signifikan
terhadap beragam

bentuk program
mencerdaskan bangsa

yang memanfaatkan
fasilitas komputer.

Tetapi kita tidak bisa
mengelak, karena hal
tersebut menyangkut

penghargaan terhadap
produk kreativitas.
Pelanggaran yang

sudah lama mewabah
hanya akan menjadi
bumerang terhadap
karya cipta saudara

kita sendiri.

eski
demikian, mau
tidak mau, semua pihak
yang terkait, termasuk

pemerintah, perlu mencari
berbagai solusi untuk
mengantisipasinya. Kalau tidak,
sama saja dengan melarang
kaum fakir miskin untuk mencuri
makanan, tetapi tidak
memberikan jalan, bagaimana
mengatasi perut yang lapar.

Apabila kita tidak terpaku
oleh pola berpikir normatif,
banyak alternatif antisipasi untuk
itu tanpa harus melakukan
tindakan ilegal. Saya pun akan
menyampaikan beberapa solusi
yang perlu dipertimbangkan,
yang kemudian disosialisasikan.
1. Windows dari Microsoft, yang

realitasnya dipakai oleh
kebanyakan pengguna PC,
merupakan pembuka aplikasi
nomor satu untuk semua hal.
Bila tidak sanggup membeli
yang original, kenapa tidak
beralih ke lain serta tidak
perlu membayar lisensi. Linux
yang semakin apresiatif secara
global, bisa dijadikan
alternatif. Banyak
kelebihannya meskipun
pamornya masih kalah.

2. Tekankan penggunaan
software sebagai motor

kreativitas dan penghemat
waktu ketimbang gaya hidup.
Rasanya mubazir Microsoft
Word hanya dipakai untuk
menulis artikel tanpa disertai
kegiatan pengolahan data.
Kenyataannya banyak
pengguna DOS menghasilkan
karya tulis jauh lebih
berbobot, rapih, dan bernilai
ketimbang pengguna Win-
dows. Pergilah ke beberapa
kantor redaksi media massa,
akan terbukti di sana. Hampir
semua tulisan saya pun dibuat
dengan program DOS versi
lama, termasuk artikel ini.

3. Carilah software yang bersifat
free (freeware). Tidak perlu
malu menggunakannya hanya
karena bersifat demo,
temporer, evaluation, advertis-
ing, atau trial, selama
memberikan kredit poin
intelektual dan keterampilan.
Malah banyak di antaranya
mempunyai keunggulan
tertentu yang tidak bisa
didapatkan dari software
komersil.

4. Optimalkan fasilitas search
Internet. Kualitas data tidak
selalu tergantung pada
software, tapi juga
kemampuan mencari kata
kunci. Misalkan, dengan
menulis "software or <nama
katagori> or freeware" di situs
raksasa akan muncul ribuan
sinopsisnya. Sungguh sayang
kalau tidak dimanfaatkan.
Rasanya aneh kalau sampai
tidak menemukan software
gratis satu pun.

5. Manfaatkan lembaga soft-
ware foundation freeware
dengan mengirim e-mail atau
mengakses situsnya.
Jumlahnya sangat banyak
dengan kebijaksanaan
beragam. Pilih yang tercocok
dengan kebutuhan. Untuk
search bisa memasukkan
kalimat seperti "software or
foundation or freeware"

(tanpa tanda kutip).
6. Yakinlah, banyak

programer tanpa
pamrih. Mereka
membuat software
untuk kepentingan
manusia. Antara lain
dengan memberikan
agreement "bebas
untuk didistribusikan
kepada siapa pun".
Saya juga memakai
salah satu software-
nya untuk fasilitas e-
mail yang salah satu
operasinya lebih
menghemat waktu
serta tidak bisa
dilakukan dengan
Outlook Express.

7. Carilah software
"open source". Pada Linux
akan banyak diperoleh serta
bisa dimodifikasi secara gratis.
Ibaratnya tidak hanya
menikmati ikan goreng, tetapi
mengetahui proses lauk itu
sampai ada di meja makan.
Secara tersirat ini mengajak
kita sekaligus sebagai
"produsen". Malah merang-
sang kita membuat software
sejenis dengan kualitas lebih
bagus ketimbang sumber
referensinya.

8. Ubahlah paradigma "internet
identik dengan software
buatan lembaga tertentu". Itu
salah. Masih banyak user
berpandangan demikian,
langsung atau terselubung,
terutama dari mereka dengan
pengetahuan minim. Ini sama
dengan sikap picik alias
mempersempit ruang lingkup
pilihan mereka.

9. Perkuat interaksi informasi
seputar software freeware
antar pengguna Internet.
Adanya fasilitas milis kategori
Internet oleh user Indonesia
bisa dimanfaatkan untuk ber-
tukar data. Para webmaster di
tanah air pun diharapkan
bersedia menyisipkan

beberapa link URL tentang itu
beserta keterangan fungsi.
Justru ini bisa meningkatkan
rating pengunjung situsnya
masing-masing.

10.Ajarkan komputer dengan
bahasa sederhana serta
mudah dimengerti kalau
memang ada mata
pelajarannya. Bukannya
njelimet serta penuh dengan
simbol berantakan. Untuk
jangka panjang berarti
menggiring anak didik
memiliki pola berpikir tuntas,
detail, dan integrasi tentang
materi tersebut. Terbukti
dalam sejarah kapan pun,
kondisi intelektual yang enjoy
seperti itu menghasilkan karya
luar biasa, termasuk bidang
software.

11.Pertimbangkan kemungkinan
pembuatan software gratis
made in Indonesia tetapi
tetap mempunyai nilai
pendapatan bagi penciptanya.
Misalkan dengan merekayasa
program sedemikian sehingga
setiap beberapa puluh menit
muncul pesan sponsor di layar
monitor serta diproteksi alias
tidak bisa dihilangkan oleh
pengguna komputer. Mirip

dengan sinetron televisi.
Pirsawan tidak dipungut tarif
tontonan, karena secara tidak
langsung sudah dibayar oleh
iklan.

12.Jadikan memberi hadiah
software freeware sebagai
tradisi, dengan disket atau
melalui e-mail, selama si
pemilik copyright-nya
memberi lampu hijau. Banyak
link yang bisa dicari lewat
fasilitas search serta langsung
di-download. Meskipun
berlakunya, katakanlah tujuh
hari, tetapi kalau momentum-
nya tepat dengan problema si
penerima, mengapa tidak?
Misalkan ia sedang dikejar
waktu dalam mengolah data
untuk sidang skripsi.

13.Berdayakan YLKI untuk
melindungi konsumen dalam
segala bentuk manipulasi
teknis, konflik interest, atau
rayuan tersebut, agar
keputusan mereka membeli
software benar-benar dilan-
dasi oleh kesadaran akan prio-
ritas, efisiensi, dan kegunaan-
nya. Masa sih hanya untuk
membuat denah rumah ting-
gal enam ruangan harus mem-
beli AutoCAD versi baru?  PC+

A
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X
PC
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Beberapa contoh produk Microsoft Original
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Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan mendaftar dengan mengirimkan e-mail  kosong ke mailplus-subscribe@yahoogroups.com. Agar keanggotaan Anda segera diaktifkan,
balas e-mail konfirmasi yang dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat mengirimkan e-mail pertanyaan ataupun tukar menukar pengalaman seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin.
Jika Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-digest@yahoogroups.com. Sebagai informasi, setiap hari

Jum’at hingga Minggu adalah hari bebas di milis ini. Setiap anggota dapat mem-posting e-mail diluar seputar masalah komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak
software, flamming, dan sebagainya. Jika Anda tidak ingin menerima e-mail OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan silakan Anda aktifkan kembali ke mode normal
dengan mengirim e-mail ke mailplus-normal@yahoogroups.com.
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Mau Update BIOS
Tapi…

Halo rekan-rekan milis
semua, saya baru saja merakit
komputer dengan motherboard
Gigabyte GA-8KNXP yang
menggunakan chipset i875P
(Canterwood) dan hendak
melakukan update BIOS
menggunakan fasilitas baru
yang ditawarkan yaitu @BIOS.
Menurut manualnya dengan
@BIOS ini saya bisa melakukan
update BIOS dari Windows.
Tetapi, sebelum melakukannya,
ada hal yang terlebih dahulu
ingin saya tanyakan pada rekan-
rekan semua:

1. Apakah bila saya lakukan
update BIOS, semua setting
BIOS kembali ke default
terutama untuk setting RAID
yang sudah di-setting oleh

Pertanyaan Seputar
Prosesor AMD

Halo rekan-rekan milis yang
pintar-pintar, saya ada sedikit
pertanyaan. Begini, saya me-
miliki satu unit komputer de-
ngan spesifikasi sebagai berikut:

• Motherboard MSI KT4V
dengan chipset VIA KT400

• Prosesor AMD Athlon XP
1800+

• Memori DDR-SDRAM 256MB
• VGA Asus GeForce2 MX400
• Harddisk 20GB

Yang ingin saya tanyakan
adalah:
1. Kenapa kalau saya lihat

pada System Properties,
kecepatan prosesor terbaca
1,15 GHz? Apakah memang
segitu kecepatan normal

Restart ke MS-DOS
pada Windows 98

Kulo Nuwun. Saya mau
numpang tanya nih.
Masalahnya kira-kira begini.
Saya punya problem dengan
sistem operasi Microsoft
Windows 98 yang saya
gunakan. Ketika saya ingin
melakukan restart ke MS-DOS
mode, sistem operasi tersebut
tidak mau masuk ke sana.
Tampilan layar pada monitor
hanya hitam saja. Bagaimana
solusinya agar komputer saya
tersebut bisa saya restart ke
dalam MS-DOS mode? Untuk
sementara, sekian pertanyaan
dari saya. Matur nuwun

A. Sumarjono

Jawab:
Kalau sistem operasi MS

Windows 98 pada komputer

orang toko dengan dua
harddisk Maxtor 40GB yang
saya pakai?

2. Apakah RAID betul bisa
meningkatkan performa PC?

3. Lalu apa bedanya update
BIOS dan driver
motherboard?
Thanks a lot guys.

Sugianto

Jawab:
1. Kalau Anda tidak

menemukan masalah
dengan komputer Anda,
update BIOS sebenarnya tidak
terlalu diperlukan. Tentu saja
kalau Anda tetap
menjalankan update BIOS,
semua setting akan kembali
ke default karena sesudah
update, setting default-nya
harus di-load kembali. Saran
saya, sebelum di-update BIOS-

nya, catat dulu semua setting
di BIOS, jadi setelah update
Anda bisa kembalikan lagi
setting-nya. Tidak perlu
khawatir untuk update BIOS
pada motherboard Anda
karena pada motherboard
Gigabyte Anda sudah tersedia
fitur Dual BIOS yang
merupakan fasilitas back up
BIOS yang akan secara
otomatis mengambil alih jika
update yang Anda lakukan
mengalami masalah.

2. Betul sekali, karena RAID
akan meningkatkan
kecepatan transfer data di
harddisk secara signifikan
(RAID 0, atau mode stripping).
Kalau RAID satu lagi yaitu
mode mirroring (RAID 1)
gunanya adalah untuk
meningkatkan keamanan
data dalam HD.

3. Driver motherboard
maksudnya gimana nih? Saya
belum pernah dengar. Apa
maksud Anda driver untuk
chipset? Sebelum update, saya
sarankan anda baca dulu di
website-nya perbaikan apa
saja yg disediakan. Setelah itu
baru Anda putuskan perlu
update atau tidak. Kalau
driver chipset, Anda silakan
saja menggunakan versi
terbaru.

Rantanplan, alexander

Tanya Scandisk
Windows 95

Teman-teman, sekedar nanya
saja. Kenapa ya di Windows 95a
saya kalau setelah habis proses
mematikan komputer yang
nggak benar (mati lampu

misalnya) kok Scandisk-nya
nggak jalan secara otomatis ya?
Dulu sewaktu saya masih
menggunakan sistem operasi
Windows 98SE, Scandisk
tersebut bisa berjalan secara
otomatis koq,  kalau PC saya
shut down-nya tidak benar. Apa
yang harus saya periksa ya?
Terima kasih, sebelumnya.
Salam.

surya-saputra

Jawab:
Coba Anda periksa file

MSDOS.SYS Anda. Biasanya file
ini invisible, dan letaknya ada di
folder C:\. Anda edit saja file
tersebut secara manual, lalu
tambahkan pada file tersebut
perintah AutoScan=1. Semoga
membantu.

LuckyGuy354, Adri Febrianto

yang Anda gunakan tidak dapat
menjalankan opsi Restart in MS-
DOS mode, kemungkinan besar
ada file command yang korup.
Salah satu solusinya adalah, coba
Anda jalankan System File
Checker. Caranya, Anda dapat
lakukan lewat mengetikkan sfc
pada kolom [Start]>[Run], atau
dengan mengklik di
[Start]>[Programs]>[Accessories]>
[System Tools]>[System Infor-
mation]. Pada menu yang
muncul, pilih [Tools]>[System
File Checker]. Pada menu
berikutnya yang muncul, Anda
langsung klik [Start] saja. Kalau
memang ada file yang korup,
Anda pilih Extract one file from
installation disk, kemudian
berikan alamat tempat Anda
menyimpan file-file mentah
sistem operasi. Selamat Mencoba.

I Made C. Wirawan

Athlon XP 1800+ ini atau
bisa lebih? Dan kalau bisa
gimana cara men-setting-nya?

2. Bagaimana kita bisa tahu spe-
sifikasi prosesor yang kita gu-
nakan tersebut dari dalam
Windows? Karena kalau saya
perhatikan, yang terbaca
hanya AMD Athlon-nya saja,
XP 1800+ nya tidak tertulis.
Saya takut dibohongi sama
penjualnya.

Untuk sementara, itu saja
pertanyaan dari saya. Sebelum
dan sesudahnya terima kasih.

Loveyoukoe

Jawab:
1. Seharusnya, kalau Anda

menggunakan Athlon XP
1800+, mestinya
kecepatannya terdeteksi pada

1533MHz. Cara untuk
menaikkannya berarti dengan
menaikkan FSB di
motherboard, entah lewat
BIOS ataupun jumper di
motherboard, coba Anda
ubah saja FSB-nya ke 133MHz.
Sebagai informasi, saya juga
punya pengalaman yang sama
tentang prosesor Athlon XP
punya saya yaitu Athlon XP
1600+. Kalau pada BIOS FSB-
nya dibuat ke 100MHz,
System Properties cuma
menunjukkan angka
1050MHz, dan kemudian di
Windows juga cuma tertulis
AMD Athlon saja. Tetapi kalau
FSB-nya saya ubah ke 133MHz,
System Properties akan
menunjukkan angka 1400MHz
dan di Windows tertulis AMD
Athlon XP 1600+.

2. Windows hanya menuliskan

informasi kecepatan prosesor
berdasarkan deteksi BIOS.
Salah satu solusi mengatasi
kesalahan pendeteksian
kecepatan prosesor adalah
dengan update BIOS. Coba
saja Anda download file BIOS
update di web site-nya MSI.

Kalau boleh menyarankan,
pada komputer Anda terjadi

bottleneck di VGA tuh. Prosesor
AMD Athlon XP 1800+ koq
cuma dipasangi dengan kartu
grafis GeForce-2 MX? Saya rasa
akan lebih optimal jika
menggunakan kartu grafis
GeForce-4 MX atau Radeon
9000 ke atas.

Adhitya F. Anggoro, Bobby C
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Menggambar
Dengan PHP
( Bagian 3 - habis )

Yahya Kurniawan
yahya@e-pcplus.com

Bagian ini merupakan
artikel terakhir dari

“kursus menggambar”
yang PCplus berikan.

Sebenarnya di luar
fungsi-fungsi yang

nanti akan diberikan
masih banyak lagi

fungsi-fungsi
menggambar dengan

PHP namun sepertinya
tidak mungkin jika

semuanya dimuat di
PCplus. Jika Anda

benar-benar berniat
mempelajarinya Anda

dapat merujuk
sendiri pada PHP

documentation yang
dapat Anda download

di www.php.net.

ah, minggu lalu Anda
telah belajar
menggambar beberapa
bentuk seperi elips,

garis, kotak, dan polygon dengan
fungsi ImageArc, ImageLine,
ImageRectangle, dan
ImagePolygon. Ada beberapa
fungsi yang penggunaannya
mirip dan menghasilkan bentuk
elips, kotak, serta polygon juga
namun  kali ini bentuk-bentuk
tersebut tidak “kosong”
melainkan disertai dengan “isi”
warna.  Fungsi-fungsi tersebut
adalah:

imagefilledarc()
imagefilledellipse()
imagefilledpolygon()
imagefilledrectangle()

Untuk fungsi
imagefilledarc() dan
imagefilledellipse() baru
dikenal pada PHP 4.0.6 dan
memerlukan library GD 2.0.1 atau

lebih. Pada prinsipnya
penggunaan fungsi-fungsi ini
sama dengan penggunaan
fungsi-fungsi yang diberikan
minggu lalu. Berikut adalah salah
satu contohnya:

<?

Header("Content-Type:image/
jpeg");
$img = ImageCreate(300,300);
$biru = ImageColorAllocate
($img,0,0,255);$merah =
ImageColorAllocate
($img,255,0,0);
$putih = ImageColorAllocate
($img,255,255,255);
ImageFill($img,0,0,$putih);
ImageFilledRectangle
($img,0,0,200,200,$biru);
ImageJPEG($img);
?>

Skrip ini menghasilkan
gambar kotak yang berwarna
biru, bukan hanya rusuknya yang
berwarna biru tetapi seluruhnya
berwarna biru. Bandingkan
dengan Gambar 1.

Fungsi Image String()
dan Image StringUp()

Kedua fungsi ini digunakan
untuk menggambar sebuah
string. Perbedaannya adalah
fungsi ImageString()
menggambar sebuah string
dengan posisi horizontal,
sedangkan fungsi
ImageStringUp() menggambar
sebuah string dengan posisi
vertikal. Sintaksnya adalah
sebagai berikut:

ImageString
($img,font,x,y, string,$warna)

ImageStringUp
($img,font,x,y,
string,$warna)

Parameter
font terdiri dari
integer dari 1
sampai dengan 5
untuk mengambil
built-in font
dengan nilai 1
merupakan font
berukuran
terkecil dan 5
terbesar,
sedangkan
parameter string
adalah string
yang akan
dimunculkan
sebagai gambar.

Berikut akan
diberikan contoh
menggambar
string.

<?
Header("Content-

Type:image/jpeg");
$img = ImageCreate (300,300);
$biru = ImageColorAllocate
($img,0,0,255);
$merah = ImageColorAllocate
($img,255,0,0);
$putih = ImageColorAllocate
($img,255,255,255);

ImageFill($img,0,0,$putih);
ImageString
($img,5,30,30,"Belajar
PHP",$biru);
ImageStringUp
($img,5,150,150,
"Mudah
lho",$merah);
ImageJPEG($img);
?>

Hasilnya dapat
Anda lihat pada
Gambar 2.

Fungsi
Image
FillToBorder()

Fungsi ini akan
memberi warna
pada suatu area
sampai batas
tertentu.
Sintaksnya adalah
sebagai berikut:

ImageFillToBorder
($img,x,y,batas,
$warna)

Fungsi ini
akan memberi warna sesuai
parameter $warna dari x,y
sampai dengan menemui batas
yang disebutkan pada param-
eter batas.

Parameter
batas sendiri
merupakan sebuah
warna.

Berikut akan
diberikan contoh
penggunaannya.

<?
Header
("Content-
Type:image/
jpeg");
$img =
ImageCreate
(300,300);
$hitam =
ImageColor
Allocate
($img,0,0,0);
$biru =
ImageColor
Allocate
($img,0,0,255);
$putih =
ImageColor
Allocate
($img,255,255,255);
ImageFill
($img,0,0,$biru);
ImageArc
($img,150,150,250,
175,0,360,$putih);
ImageFillToBorder
($img,150,150,
$putih,$hitam);
ImageJPEG($img);
?>

Pada contoh ini, kanvas akan
diberi warna biru, kemudian

digambar sebuah elips berwarna
putih. Lalu di dalamnya akan
diberi warna hitam sampai warna
hitam tersebut menemui

batasnya, yaitu warna putih. Jika
koordinat titik awal berada di
dalam elips, maka warna hitam
akan memenuhi elips, jika titik
awal berada di luar elips, maka
warna hitam akan memenuhi
kanvas yang di luar bidang elips.
Bandingkan hasilnya dengan
Gambar 3.

Fungsi ImageTypes()
Fungsi ini digunakan untuk

memeriksa tipe gambar apa
sajakah yang didukung oleh PHP
pada server yang bersangkutan.
Sintaksnya adalah sebagai berikut:

ImageTypes()
Fungsi ini akan

menghasilkan nilai bit yang
bersesuaian dengan format
gambar yang didukung, yaitu
IMG_GIF, IMG_JPG,  IMG_PNG,
dan IMG_WBMP. Jika ingin
diperiksa apakah PHP pada server
yang bersangkutan mendukung
format JPEG, maka dapat
digunakan cara sebagai berikut:

<?
if (ImageTypes()
& IMG_JPG)
{echo "PHP
mendukung
format JPEG";
}
?>

Fungsi
Image
SetPixel()

Fungsi ini
digunakan untuk
menggambar se-
buah titik (pixel).
Sintaksnya adalah
sebagai berikut:

ImageSetPixel
($img,x,y,$warna)

Parameter x,y
merupakan
koordinat dimana
titik tersebut akan
digambar.

OK, sekian dulu pembahasan
mengenai fungsi-fungsi meng-
gambar yang terdapat di PHP.
Berbekal penge-tahuan tersebut,

minggu depan
PCplus akan mem-
berikan tutorial
menggambar
sebuah pie chart
yang nantinya
akan diterapkan
pada aplikasi jajak
pendapat. Sebagai
penutup untuk
edisi nomor ini,
saya selaku penga-
suh rubrik pemro-
graman di PCplus
memohon maaf
apabila ada bebe-
rapa pertanyaan
yang masuk ke
e-mail saya di
yahya@e-
pcplus.com yang
tidak mampu saya
jawab.
Untuk itu saya
mengajak Anda
semua untuk ber-
gabung di milis
dm2p@yahoo
groups.com (serta
sekaligus

mengunjungi situs saya di
www.dm2p.com). Milis ini uta-
manya akan membahas masalah-
masalah pemrograman. Di milis
tersebut saya harapkan Anda bisa
saling membantu dan tidak harus
selalu tergantung pada saya se-
laku pengasuh rubrik pemrogra-
man di PCplus. Terima kasih.  PC+

Gambar 2

Gambar 1

Gambar 3
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Samsung ML-1710:

Printer Laser
Hemat Tempat

Samsung Electronics Indonesia
www.samsung.com
☎ (021) 5225522

230 dolar AS

GO-D1600A:

DVD-ROM 16 Speed
dari Gigabyte

Nusantara Eradata
www.gigabyte.com
☎ (021) 6018218

Posisi printer la-
ser kian hari kian menguat
dan diperkirakan akan
menggantikan peran printer
tinta, terutama di kalangan
pengguna kantoran. Hal yang
mempercepat pergeseran ke
arah tersebut adalah dengan
semakin banyaknya varian
produk printer laser dari
vendor-vendor printer di dunia
sehingga membuat harganya
pun makin murah.
Produsen yang turut ambil
bagian dalam memproduksi
alat cetak untuk komputer
seperti Samsung tentu saja
memperoleh peluang untuk
merebut kue pangsa pasar yang

lumayan. Fakta ini tentu tak bisa
dikesampingkan begitu saja.
Produsen asal Korea ini
memproduksi pula printer laser
untuk berbagai level pengguna.

Salah satu produk keluaran
Samsung yang ditujukan untuk
pengguna small ofice ataupun
home office adalah seri Samsung
ML-1710. Sebagai sebuah printer
laser, Samsung ML-1710 ini
merupakan printer yang mungil.
Saat ditempatkan di meja kerja,
produk ini hanya mengambil
bidang sebesar 35 x 37 cm,
sedangkan untuk tinggi,
ukurannya cuma 20 cm.

Saat bekerja, printer ini
dapat mencetak hingga ke-

cepatan 16
halaman per
menit. Kualitas hasil
cetak Samsung ML-1710
juga cukup baik karena dapat
mencetak hingga resolusi 600
dpi. Untuk menempatkan
kertasnya, Samsung
menggunakan cassette tray yang
ada di bagian bawah printer.

Cassette tray ini dapat
menampung

hingga
250
lem-
bar
kertas
baik
kertas
ber-

ukuran
Letter,

Legal, Folio,
Executive,

Monarch,
COM10, C5, DL,

A4, A5, B5, dan 3
x 5 inci. Selain itu,

penggunanya juga
dapat mencetak di

kertas transparansi, label,
kartu pos, dan amplop.

Sebagai “otak” untuk
melakukan pekerjaan, printer ini
dilengkapi prosesor Samsung
berkecepatan 66MHz. Printer ini
juga sudah dilengkapi dengan
internal memory sebesar 8MB.
Dalam penggunaan normal,
printer ini dapat menghasilkan 15

Sudah sajak
lama kita mengetahui bahwa
Gigabyte, salah satu vendor
papan atas asal Taiwan, merupa-
kan vendor yang memfokuskan
diri di bidang motherboard.
Namun, melihat tren pasar yang
cukup berpotensi, belum lama
ini Gigabyte kembali
memperluas jajaran produknya.
Kali ini range produk mereka
mulai merambah ke drive optik.

Salah satu produk di jajaran

media optik
Gigabyte
adalah GO-
D1600A.
Produk ini
merupakan
sebuah DVD-
ROM yang
memiliki
kecepatan baca
DVD maksimal
sebesar 16x
sedangkan untuk
membaca media
jenis CD, kecepatan
baca maksimalnya
adalah 48x.

Drive ini
memiliki fitur Smart Monitoring
dan Adjusting Technology.
Maksudnya, drive ini dapat
mendeteksi dan mengatur secara
otomatis format media yang
digunakan agar performanya
optimal. Selain itu, saat bekerja
pada kecepatan penuh, drive ini
mengeluarkan suara yang tidak
terlalu berisik.

Untuk menampung media
optik, drive ini menggunakan tray

load mechanism. Berhubung drive
ini adalah drive DVD-ROM internal
biasa, maka interface yang digu-
nakan untuk menghubungkan
drive ini ke sistem adalah interface
IDE. Ketika digunakan untuk
membaca media DVD, access time
yang dibutuhkan oleh Gigabyte
GO-D1600A ini adalah 105ms,
sedangkan setelah memasukkan
media CD ke dalam drive, DVD ini
membutuhkan waktu 95ms.

Untuk Mean Time Between
Failure-nya, vendor DVD-ROM
drive ini mengklaim bahwa
produk Gigabyte GO-D1600A ini
dapat bekerja dengan baik selama
70 ribu jam dalam kondisi normal.
Untuk medianya, drive ini mampu

membaca CD-R, CD-RW, DVD-
RAM, DVD-ROM, DVD-R, DVD-RW,
DVD+R, DVD+RW, Video CD, dan
CD Text.

DVD-ROM ini memiliki buffer
yang cukup besar yaitu sebanyak
512KB. Dua kali lebih banyak bila
dibandingkan dengan buffer yang
dimiliki oleh beberapa merek
DVD-ROM lain. Untuk dimensinya
sendiri, Gigabyte membuat drive
ini dengan Extra Low-Profile
Design. Maksudnya, drive ini me-
miliki ukuran yang lebih pendek
(sekitar 3 cm) bila dibandingkan
dengan beberapa merek lain yaitu
41,3 x 145,8 x 170. Berat produk
ini sendiri hanya sekitar 0,8 kg dan
dapat diposisikan secara vertikal

ribu lembar dokumen per
bulannya.

Untuk terhubung dengan
komputer, printer ini
menggunakan standar interface
USB yang sudah sangat umum
saat ini. Sistem operasi yang
dapat mengaktifkan kerja
printer yang memiliki bobot
hanya sekitar 7 kg ini adalah
Windows 98, ME, 2000, XP, Mac
OS 8.6 ke atas, dan beberapa
distro Linux.

Untuk semakin menekan
biaya operasional, pada printer
ini juga tersedia fitur Toner
Save. Jika fitur ini diaktifkan,
maka dapat menghemat peng-
gunaan toner hingga 40 persen.
Cara mengaktifkannyapun
sangat mudah. Penggunanya
tinggal menekan tombol Toner
Save yang tersedia pada bagian
atas printer, dan mode hemat
pun langsung aktif. (fmn)

ARE
/PC

plu
s

ataupun horizontal.
Kami menguji secara singkat

drive ini dengan software Nero
CD Speed 1.02. Untuk CD kami
menggunakan CD audio,
sedangkan untuk DVD kami
menggunakan DVD film. Untuk
membaca CD tersebut, DVD-
ROM ini kecepatan baca rata-
ratanya tercatat pada 30,27x,
sedangkan saat digunakan
untuk membaca DVD, kecepatan
baca rata-ratanya tercatat pada
5,71x. (fmn)
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PT Astrindo Senayasa
www.asus.com

☎ (021) 6121330
105 dolar AS

Asus TV FM Card:

TV Tuner dengan Fitur
Tambahan Video Security
Sebagai salah satu
produsen beken untuk urusan
komponen komputer, Asus
banyak mengeluarkan seri-seri
produk terbaru.  Ia pun mulai
melebarkan sayap bisnisnya
dengan mengeluarkan produk
terbaru berupa TV tuner. Dari
dua buah seri yang
dikeluarkannya, PCplus
memperoleh seri TV FM Card,
yang selain mampu menangkap
saluran TV juga mampu
menangkap saluran radio FM.

Produk bikinan Taiwan
yang mensyaratkan
penggunaan memori utama
minimal sebesar 64MB ini dari
spesifikasi teknisnya cukup
menjanjikan. Dengan
mengusung chip audio/video
decoder SAA713x  buatan
Philips, gambar yang dihasilkan
bisa dilihat dengan tajam.
Maklum, decoding video yang
sudah dihasilkan oleh chip-nya
sudah menggunakan teknologi
10 bit yang membuat gambar
terlihat tajam.

Kemampuan yang dimiliki
tuner internal berbasis interface
PCI ini memang cukup banyak.
Selain karena software
pendukungnya yang lengkap,
port yang ditanam oleh pabrik
pembuatnya memang cukup
lengkap sebagai sebuah tuner.
Port FM-in dan port TV-in
disertakan tuner ini untuk
penghubung ke antena penerima
sinyal. Sementara, untuk inter-
face dengan perangkat audio
video, disertakan sebuah port
video-in (S-VHS) dan sebuah port
video-in  yang dihubungkan
dengan kabel RCA. Untuk
Suaranya, disertakan dua port
audio-in sebagai interface-nya

Fitur menarik yang diusung
TV FM card yang berbeda dengan
yang lain adalah remote control
yang lain dari yang lain. Remote
control yang disandingkan
dengan receiver remote control
kit berbasis USB selain dapat
memudahkan pengguna
mengontrol saluran TV dari jauh
juga dapat berfungsi sebagai

mouse pengganti. Selain itu,
terdapat pula tombol-tombol
khusus yang disertakan untuk
kenyamanan semisal tombol
teletext, VCR menu, DVD sub-
titles, dan snapshot.

Fitur khusus lain yang
dimiliki tuner ini adalah Asus
Video Security. Fitur semacam ini
sebetulnya sudah lama diusung
oleh beberapa seri kartu grafis
Asus  terdahulu. Dengan bantuan
kamera dan software
pendukungnya, pengguna bisa
memantau satu area tertentu
dalam jangkauan kamera agar
tidak dimasuki orang yang tak
diinginkan. Uniknya, penentuan
area tersebut cukup dengan
mengklik mouse pada area yang
akan diamankan. Setelah itu,
sistem akan mendeteksi kapan
dan siapa saja yang memasuki
area tersebut yang terekam
secara detail, lengkap dengan
gambar, jam dan tanggalnya.
Asiknya, report dari fitur ini  bisa
dikirim via e-mail atau
handphone secara otomatis bila

software-nya diatur
terlebih dahulu.

Dengan
memanfaatkan software-nya,
pengguna juga dapat men-
capture siaran TV, video dengan
sangat mudah. Tersedia pula
fasilitas snapshot untuk
menangkap gambar. Sama
seperti produk sejenis, fasilitas
capture ini dapat diatur
pengguna untuk beberapa
parameter dengan
memanfaatkan software yang
disediakan. Sayangnya, tidak bisa
meng-capture satu saluran
sementara penggunanya
menikmati saluran lain. Ketika
diuji, PCplus mendapati
kemudahan dalam proses

instalasi, baik untuk menangkap
saluran TV maupun ketika
memanfaatkan fitur-fitur unik
yang disediakan.

Pada kemasan jualnya, Asus
menyertakan buku manual
lengkap, CD driver maupun
beberapa bundel software,
remote control dan receiver-
nya, antena radio, dan kabel-
kabel pendukung. Buat
pengguna TV tuner yang ingin
mendapatkan produk dengan
fitur lebih dari biasanya, produk
ini bisa jadi pilihan. (sil)

ARE/PCplus
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Digicolor FX5200:

DirectX 9 dengan
Memori 128MB

PT Jayacom Alpha Electronic
www.ennyah.com.tw

☎ (021) 6011925

HomeFree Home Networking:

Jaringan PC dengan
Kabel Telepon Rumah

PT Data Global Komukatama
www.dataglobal.co.id

☎ (021) 6125555
HomeFree Adapter PCI:

Rp.150.000,- sepasang
HomeFree Adapter USB:

Rp.150.000,- sepasang

Quake III Arena
1024 x 768  16bit :132,3
1024 x 768  32bit :97,8
1280 x 1024  16bit :82,7
1280 x 1024  32bit :58,8
1600 x 1200  16bit :56,8
1600 x 1200  32bit :38,4

3D Mark 2001
1024 x 768  16bit :4632
1024 x 768  32bit :4493
1280 x 1024  16bit :3093
1280 x 1024  32bit :2879
1600 x 1200  16bit :2235
1600 x 1200  32bit :1953

3D Mark 2003
1024 x 768  32bit :920
1280 x 1024  32bit :613
1600 x 1200  32bit :417

Kesulitan
membangun
jaringan di rumah bukan
serta-merta berarti kita tak tahu
cara membangunnya. Mungkin
juga karena kita males untuk
menambah keruwetan jaringan
kabel yang udah ada. Mungkin
juga karena sayang terhadap
dinding rumah yang sudah
manis dan rapi untuk sekadar
dibobok buat bikin jalur kabel
di dalamnya.

Padahal, mungkin
sebetulnya sudah ada sebuah
jaringan yang “nganggur” dan
dapat dimanfaatkan. Jaringan
apakah itu? Jaringan telepon di
rumah kita! Apalagi jika ada
beberapa terminal paralel di
beberapa ruang di rumah kita.
Antara titik satu dengan yang
lain sudah membentang
jaringan yang siap digunakan.

Mungkin Anda pernah
mendengar tentang jaringan
melalui kabel telepon rumahan
ini. Teknologi ini didasarkan
spesifikasi yang dikembangkan
oleh Home Phone Networking
Alliance (HPNA) dan karenanya

sering disebut dengan teknologi
HomePNA. HPNA merupakan
sebuah konsorsium dari
perusahaan-perusahaan top yang
bergerak dalam teknologi
jaringan yang menyusun standar
jalur telepon untuk industri
jaringan.

HomePNA ini menggunakan
metode yang disebut Frequency-
Division Multiplexing (FDM). FDM
menempatkan data komputer
pada frekuensi terpisah dari
sinyal suara yang dilewatkan oleh
saluran telepon. FDM
memisahkan ruang untuk sinyal
tambahan pada sebuah jalur
telepon menjadi kanal data yang
berbeda dengan cara
membaginya ke dalam potongan-
potongan bandwidth yang sama.
Ini persis dengan stasiun-stasiun
radio yang mengirim sinyal-
sinyalnya pada frekuensi yang
berbeda-beda dalam band yang
ada. Panjang kabel maksimal
yang bisa ditolerir adalah sekitar
500 kaki atau sekitar 167 meter.

Namun demikian, kita tidak
bisa begitu saja langsung
menggunakan jaringan kabel

tersebut
untuk meng-
hubungkan
komputer ke
dalam satu jaringan.
Kita butuh alat yang
mendukung
teknologi
HomePNA ini.
Sudah banyak
yang ada di
pasaran. Salah
satunya adalah HomeFree buatan
Diamond Multimedia Systems,
Inc. yang berbasis di Vancouver,
USA.

Ada dua jenis produk
HomeFree yang diterima redaksi
PCplus. Satu berupa kartu PCI dan
satunya lagi berupa kit USB
eksternal. Tentu saja untuk dapat
menggunakannya, Anda butuh

minimal dua produk dan
dipasang pada terminal yang
ingin dikoneksikan. Kartu PCI
atau kit USB tersebut
menghubungkan terminal atau
PC ke telephone wall jack alias

colokan
kabel telepon di tembok
dengan jenis RJ-11 standar.
Satu lagi colokan yang sama
untuk dihubungkan dengan
handset telepon agar tetap bisa
digunakan untuk menelepon.

HomeFree yang berbentuk
PCI Card yang redaksi terima
masih menggunakan standar
HPNA 1.0, jadi baru bisa
melewatkan data dengan
kecepatan maksimal 1Mbps.
Sedang kit USB-nya sudah
mendukung spesifikasi HPNA 2.0
dan mampu beroperasi pada
kecepatan 10Mbps.

Untuk setiap produk,
tersedia kelengkapan CD driver
dan dua buah kabel. CD berisi
driver dan software untuk
melakukan instalasi yang dapat
dilakukan dengan mudah
karena tinggal mengikuti
wizard yang disediakan.

Selain untuk sekadar
berbagi file atau bermain game
jaringan, HomeFree juga bisa

dimanfaatkan
untuk

sharing

akses
Inter-

net.
Pilih

komputer
dengan

koneksi
Internet paling
cepat sebagai
“server”
untuk

sharing.
Lakukan instalasi Internet
sharing dari CD driver
tersebut. (fbi)

ARE/PCplus

nVidia telah meng-
update jajaran kartu grafis
mereka ke kelas GeForce FX. Hal
ini mereka tempuh untuk
meningkatkan kinerja produk
yang telah “termakan” usia,
yaitu jajaran GeForce-4 dan
GeForce-4 MX. Seperti kita
ketahui bersama, di dunia kartu
grafis usia satu generasi chip
grafis tidaklah lama.

Salah satu vendor asal
Taiwan yang sudah cukup lama
ikut serta berpartisipasi
membuat produk kartu grafis
dengan chipset nVidia yaitu
Ennyah Technologies Corp. kini
sudah mendistribusikan jajaran
produk kartu grafis dengan chip
GeForce FX di Indonesia.
Tentunya masih dengan merek
dagang Digicolor. Untuk kali ini,
produk milik Ennyah yang akan
sedikit kita bahas adalah yang
menggunakan chip GeForce
FX5200.

Selain produk yang kita
bahas ini, Ennyah sendiri masih
memiliki satu jenis produk lagi
yang memanfaatkan chip
GeForce FX5200 yaitu yang
menggunakan tambahan embel-
embel Ultra. Perbedaannya tentu
terletak pada engine dan
memory clock yang lebih tinggi.

Produk FX5200 yang datang
ke lab kami adalah yang
menggunakan memori video
sebesar 128MB. Pada board kartu
grafis yang dipoles dengan warna
hitam ini, Ennyah memasangkan
sebanyak empat buah chip
memori yang berkapasitas 32MB.
Memori video ini jenisnya adalah
DDR 128-bit dengan chip buatan
Elixir.

Untuk memori video
tersebut, kami mendeteksi clock
default-nya pada 330,75MHz.
Ennyah tidak memberikan
fasilitas pendinginan memori
pada kartu grafis yang satu ini.

Namun demikian, tidak ada
masalah yang terjadi saat
pengujian. Demikian pula ketika
memory clock-nya kami naikkan.

Untuk graphic processing
unit-nya, clock yang terdeteksi
oleh software uji kami adalah
pada 249,75MHz. Pada GPU-ini,
fitur pendinginan sudah
disediakan yaitu berupa heat sink
dengan fan. Meskipun tampak
standar, heat sink fan yang
digunakan pada board kartu
grafis ini mampu mengatasi
masalah panas yang dikeluarkan
pada saat kartu grafis bekerja.
Bahkan ketika kami naikkan
engine clock-nya, heat sink fan
ini masih dapat menjalankan
fungsinya dengan baik.

Setelah menyelesaikan
pengujian standar, kami mencoba
menaikkan sedikit demi sedikit
core clock dan memory clock
kartu grafis ini. Hasilnya, kartu
grafis ini dapat bekerja dengan
stabil hingga pada clock 325/
400MHz. Meskipun masih bisa
dinaikkan, namun pada clock

yang lebih tinggi, pada layar
monitor mulai muncul artifak
yang menunjukkan bahwa clock
tersebut sudah terlalu tinggi.

Dengan clock tersebut, kartu
grafis ini dapat menyamai clock
beberapa kartu grafis chip
GeForce FX5600 dan Radeon
9600. Namun demikian, angka
pengujian FX5200 yang clock-nya
dibuat sama dengan FX5600 dan
Radeon 9600 ini tetap tidak
dapat menyamai kedua chip
grafis tersebut.

Kami menguji kartu grafis ini
dengan software uji
3DMark2001, 3DMark 2003, serta
Quake 3 Arena. Untuk sistemnya
kami menggunakan motherboard
Asus A7N8X, prosesor AMD
Athlon XP 2000+, dua keping
memori Corsair DDR400
berkapasitas 256MB, harddisk
Seagate Barracuda ATA IV
7200rpm kapasitas 40GB, dengan
sistem operasi Windows XP
Professional. Untuk driver-nya
kami menggunakan nVidia
Detonator XP versi 44.03,

sedangkan untuk mengetahui
core clock dan memory clock
sebenarnya kartu grafis ini
kami menggunakan
PowerStrip 3.40. (fmn)

ARE/PCplus
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Selamat Datang
Internet

Masa Depan

Budi Putra
budi@budiputra.com

S

Akses Internet
supercepat dan segala
keleluasaan  teknisnya

menjadi dambaan
para pengakses

jaringan pintar ini.
Segala upaya

didedikasikan para
pakar Internet untuk
memenuhi tuntutan
itu. Syukurlah, jalan

ke arah sana semakin
lempang dan

benderang. Bersiaplah
untuk menikmati

akses yang
diramalkan akan

secepat kedipan mata
itu.

etidaknya,
ada dua hal
besar yang sedang
dilakukan para pakar

di bidang Internet: Pertama,
membereskan sistem
pengalamatan Internet yang
nyaris buntu. Kedua, merancang
protokol transmisi yang lebih

cepat sehingga tak terlalu
mensyaratkan infrastruktur
telekomunikasi yang kompleks
dan mahal.

SISTEM ALAMAT IPV6
Mulai digunakannya sistem

alamat IPv6 (protokol Internet
versi 6) atau juga disebut Next
Generation Internet Protocol
(IPng) boleh jadi merupakan
upaya cukup serius
membereskan kebuntuan
pengalamatan di Internet.
Pengembangan sistem yang
didesain oleh IETF (Internet
Engineering Task Force) ini
didasari kecenderungan
penggunaan  Internet yang
makin meluas, di mana
aplikasinya bukan hanya
komputer saja, melainkan
hampir seluruh perangkat
elektronik dalam suatu jaringan
global. Pasalnya, teknologi
Internet yang secara de facto
menggunakan protokol berbasis
TCP/IP telah berkembang pesat.
Selama dua dekade lebih,  IPv4 -
-sistem pengalamatan yang
umumnya digunakan saat ini--
telah terbukti menyediakan

mekanisme komunikasi untuk
protocol TCP/IP yang andal.

Namun demikian, kesuksesan
teknologi IPv4 yang
menggunakan 32-bit untuk
pengalamatan telah membawa
bencana bagi dirinya sendiri.
Jumlah tersebut memang sangat
besar pada awalnya, namun
dengan melesatnya penggunaan
dewasa ini jumlah tersebut makin
menyusut dan tidak akan
mencukupi lagi pada masa
mendatang. Karenanya, sistem
baru IPv6 yang mulai digunakan
secara terbatas sejak tahun 1994
kini mulai diarahkan untuk
menggantikan kedudukan IPv4.
Pada  prinsipnya, protokol baru
ini tetap menyediakan
mekanisme komunikasi yang ada
pada protokol IPv4 tapi dengan
menambahkan berbagai feature
baru, antara lain menyediakan
ruang sebesar 128-bit untuk
pengalamatan host, kompatibel
dengan peranti keras lain selain
komputer, plus kemudahan
teknis lainnya.

IPv6 juga membuka
kemungkinan akan aplikasi masa
depan. Menurut seorang praktisi
Teknologi Informasi,  sistem ini
memungkinkan terobosan-
terobosan baru berbasis Internet,
misalnya kulkas atau pintu garasi
yang memiliki nomor IP sendiri.
Hebatnya, IPv6 tidak
mengharuskan semua
penyelenggara jasa Internet (ISP)
untuk berpindah dari IPv4 ke
IPv6, karena sudah disiapkan
mekanisme "smooth landing".
Pasalnya, memang tidak
gampang melakukan transisi dari
IPv4 ke protokol IPv6 secara
sekaligus. Karenanya, mekanisme
yang dikembangkan adalah
tunneling dan virtual ethernet.
Kedua mekanisme ini
memungkinkan transisi secara
bertahap, tanpa merusak
keberadaan infrastruktur berbasis
IPv4 yang ada.

Sejumlah lembaga di
Amerika Serikat dan Eropa sudah
mulai mengadopsi protokol baru
ini. Pentagon misalnya, sudah
mengumumkan akan memulai
transisi IPv6 guna mendekatkan
Departemen Pertahanan (DoD)
pada tujuan perang dan operasi
net-sentris. IPv4, telah digunakan
oleh DoD selama hampir 30
tahun. Namun, batasan-batasan
fundamentalnya, bersamaan
dengan meledaknya penggunaan
Internet di seluruh dunia, dirasa-
kan memperlambat peng-
operasian strategi net-sentris.

Di Indonesia, sejumlah
lembaga sudah mencoba
bereksperimen di sistem IPv6.
Asosiasi Penyelenggara Jasa
Internet Indonesia (APJII) sudah
mulai menggunakan metode ini
karena bagaimanapun IIX
(Indonesia Internet eXchange)
yang dikelola APJII harus bisa
mendukung IPv6 untuk
mengantisipasi perkembangan
teknologi.  Hal yang sama juga
sudah dilakukan secara internal
di Institut Teknologi Bandung
(ITB).

PROTOKOL FAST TCP
Upaya kedua, yakni

merancang protokol transmisi
yang lebih andal, juga sudah
melegakan hati. Kehebatan
koneksi Fast TCP, protokol
transmisi baru yang
dikembangkan sebuah tim dari

Institut Teknologi California
(Caltech), terletak pada
kemampuannya yang ramah dan
universal: bisa jalan pada
infrastruktur Internet yang ada
sekarang ini. Sementara itu, kita
tahu bahwa Internet yang ada
sekarang masih menggunakan
TCP/IP (Transmission Control
Protocol/Internet Protocol) yang
dibuat pada 1970 oleh Vinton
Cerf dari Universitas Stanford dan

Bob Kanh dari pusat riset
Pentagon.

Dalam proses transmisinya,
TCP/IP hanya mampu
memperkecil dokumen digital
berukuran besar menjadi paket
sekecil 1500 byte.  Masing-masing
paket membawa alamat pengirim
dan penerima. Sistem pengiriman
datanya antri. Komputer
pengirim mengirimkan paket itu,
kemudian selama beberapa saat
harus menunggu pengembalian
tanda terima apakah kiriman itu
sampai atau tidak, dan baru
mengirimkan paket berikutnya.
Jika tidak ada tanda terima,
komputer kembali mengirimkan
paket yang sama tapi dengan
kecepatan setengah dari
sebelumnya. Proses serupa
diulangi kembali, dengan
kecepatan yang juga menyusut
setengahnya lagi. Jika gagal,

diulangi lagi, begitu seterusnya,
hingga kiriman itu sampai
dengan selamat. Bayangkan,
betapa lama waktu yang
dibutuhkan.

Lain halnya dengan Fast TCP.
Dengan kecepatan relatif tinggi,
protokol baru ini akan
memberikan informasi lebih awal
soal status paket kiriman dan
segera memprediksi tingkat
koneksi yang harus dialokasikan

agar tidak sampai kehilangan
data.

Kehandalan Fast TCP sudah
diuji-coba pada akhir tahun
lalu. Tim Caltech Stanford
mencoba mengirimkan data
sejauh 10.000 kilometer dari
Sunnyvale, California, dengan
tingkat transmisi 925 megabit
per detik. Sementara itu,
dengan rute yang sama, TCP
konvensional hanya mampu
mengirimkan data 266 megabit
per detik. Dengan menjalankan
10 Fast TCP secara bersamaan,
tim itu berhasil membukukan
prestasi akses 8,6 gigabit per
detik: yang berarti 6000 kali
dari kapasitas rata-rata koneksi
yang ada sekarang.

Kerja keras dan kompetisi
di kalangan pakar Internet
dalam menghadirkan akses
internet yang cepat plus

keleluasaan teknis aplikasinya,
tentu akan semakin
memanjakan para pengguna
Internet di berbagai belahan
dunia.  Keberanian Indonesia
untuk mengadopsi kemajuan-
kemajuan semacam ini tentu
sangat menentukan bagi masa
depan pengguna Internet di
negara tercinta ini, agar
tidak sampai “ketinggalan
kereta”. PC+

Dengan teknologi-teknologi baru yang berkembang, ber-Internet bisa lebih asyik. Koneksi yang cepat serta
keamanan yang terjamin bisa memungkinkan kita melakukan banyak hal di Internet.
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Minggu Terakhir Pendaftaran
Mega Workshop

Inilah kesempatan terakhir
untuk mengikuti workshop
merakit PC serta workshop
instalasi software. Tempat
hampir penuh, waktu sudah
mepet. Jadi, ya buruan daftar!
“Kami menghimbau kepada
para calon peserta yang
berminat mengikuti “Workshop
Merakit PC” dan “Workshop
Instalasi Software” untuk segera
mendaftar, karena tempat yang
disediakan terbatas dan hampir
habis,” ungkap Irwan,
perwakilan PCplus Surabaya.

Menurut Irwan, peserta
workshop seperti biasanya tidak
hanya berasal dari Surabaya
saja, tapi dari seluruh penjuru
Jawa Timur seperti Gresik,
Pasuruan, Probolinggo, Jember,
dan bahkan juga dari Jogjakarta
dan Jakarta. “Kami berharap
masyarakat Surabaya untuk
segera mendaftar, karena fax
dari luar kota terus
berdatangan untuk mendaftar,”
imbuh Irwan.

Yang menarik, menurut

Tanggal 15 Agustus 2003
IMP, salah satu penyelenggara
pameran yang cukup ternama
di Surabaya kembali menggelar
pameran. Pameran yang
mengambil tempat di Conven-
tion Hall Tunjungan Plaza III
Surabaya kali ini bertajuk
MEGATEX Expo 2003. Pameran
ini direncanakan akan
berlangsung sampai dengan
tanggal 24 Agustus 2003.

Megatex Expo 2003
Dibuka

Irwan, adalah salah seorang
peserta dari Surabaya mengikuti
workshop merakit PC untuk yang
kedua kalinya. Ia mendaftar
workshop merakit PC dan
instalasi software sekaligus.
Karena ingin mematangkan
ilmunya dalam hal merakit PC,
maka ia mengikuti lagi workshop
merakit PC. “Yang pertama
memang tidak mengecewakan,
tapi saya betul-betul ingin
mendalami ilmu merakit PC.
Rasanya menarik dan bangga
kalau bisa merakit PC sendiri,”
ujarnya.

Lain lagi pengakuan seorang
peserta yang berasal dari SMU
Negeri V Surabaya. Ia dan
temannya ingin mendapatkan
tambahan bekal untuk
menghadapi dunia kerja. “Saya
memang berencana untuk kuliah
setelah lulus SMU, tapi tambahan
ilmu seperti ini jarang didapat
dan merupakan nilai tambah
bagi saya untuk mendapatkan
pekerjaan,” ujarnya.
Menurutnya, workshop seperti ini

jarang diadakan, dan saat ini
adalah saat yang tepat untuk
mendapatkannya. “Sekarang
memang ada, tapi nanti di
waktu-waktu mendatang apakah
akan ada lagi? Belum tentu
kan?” ujarnya.

“Kami memang akan terus
mengadakan workshop yang
dibutuhkan oleh masyarakat
Surabaya, tapi tentu tidak
terbatas workshop merakit PC
saja. Seperti yang kami adakan
kali ini adalah “Workshop
Instalasi Software dan Optimasi
BIOS”. Dalam workshop ini,
peserta akan diajari menyetel
kemampuan komputernya
hingga dapat berjalan secara
maksimal.

Setelah itu diajarkan pula
mengatur harddisk supaya data
dan program tidak tercampur.
Selain itu akan diajarkan pula
cara meng-install Windows yang
benar dan cara meng-install
ulang Windows yang rusak tanpa
harus kehilangan data,” ujar
Irwan panjang lebar.

Selain itu, masih menurut
Irwan, akan diadakan pula
workshop tentang Linux. “UU
HaKI memang memberi
pengaruh yang sangat besar
terhadap masyarakat.

Walau banyak yang masih
menggunakan bajakan, namun
banyak juga yang berencana
untuk mencari alternatif untuk
tidak menggunakan bajakan,”
ujar Irwan.

“Bagi yang mampu membeli
Windows original tentu tidak
masalah, tapi bagi yang tidak
mampu mereka pasti mencari
solusi, bukannya terus
menggunakan bajakan.
Alternatif yang terdekat saat ini
ya Linux,” ujar Irwan. “Kami
tidak bermaksud beramai-ramai
mengajak masyarakat untuk
pindah menggunakan Linux dan
tidak menggunakan Windows,
tapi kami ingin menawarkan
Linux sebagai pilihan. Seperti
prosesor, ada Intel, AMD, Cyrix,
dan lain-lain. Nah, kalau di
software sistem operasi, selain

Windows ada Linux,” terang
Irwan.

Saat ini memang banyak
mahasiswa yang sudah
menguasai Linux dengan baik,
bahkan banyak dari mereka
menganggap bahwa pengguna
Windows adalah pengguna
komputer amatiran. Seperti
Agus, mahasiswa asal Malang
yang membuat jaringan Linux di
tempat kosnya. “Saya dan
teman-temang memang
penggemar berat Linux dan
masing-masing dari kami
mempunyai komputer. Untuk
saling berkomunikasi dan
meningkatkan kemampuan
kami, maka kami membuat
jaringan komputer berbasis
Linux di tempat kami,” ujarnya.

Jika pengguna komputer
berbasis Linux makin tumbuh di
kalangan perusahaan, maka
bukan tidak mungkin orang-
orang kreatif seperti Agus akan
mendapatkan lapangan
pekerjaan dan membuat
mereka makin kreatif. (din)

Menurut Bayu, direktur IMP,
pameran ini adalah komitmen
besar yang dipersembahkan
kepada masyarakat sebagai
sarana informasi atas
perkembangan teknologi,
telekomunikasi, elektronik, dan
komputer yang saat ini makin
pesat dan makin terintegrasi.

“Harus diakui, bahwa makin
lama komputer makin dekat
dengan kehidupan kita sehari-

hari. Di rumah, komputer bisa
menjadi sarana hiburan, di
samping sebagai sarana mencari
nafkah,” ujar Bayu. “Selain itu,
perkembangan teknologi juga
makin terintegrasi. Contohnya
adalah kita bisa dengan mudah
mengatur handphone melalui
komputer, sesuatu yang tak
terbayang selama ini,” katanya.

Walau saat ini isu UU HaKI
masih membuat kita semua

bingung, tapi tampaknya minat
masyarakat untuk membeli
komputer tidak surut.
“Menurut peserta pameran,
transaksi yang terjadi cukup
menggembirakan,” ujar Bayu.
“Pengunjung pun tampaknya
juga banyak. Mungkin juga
karena tertarik untuk melihat
apakah peserta pameran
memberikan alternatif lain dari
Windows, walau sampai saat ini

masyarakat masih menyukai
dan familiar dengan Win-
dows,” ujar Bayu.

Selain komputer,
pengunjung bisa menyaksikan
dan menikmati perkembangan
terbaru dalam bidang
telekomunikasi dan elektronik.
Tampaknya panitia memang
bersungguh-sungguh untuk
menyajikan hal-hal yang paling
baru kepada masyarakat. (din)
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Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga Dalam Dolar AS

UGM - JOGJAKARTA

27 - 28 September 2003

Materi :

• Dasar-dasar Video Editing
• Capture video ke komputer
• Membuat VCD
• Tip & Trik video editing dengan
  Adobe Premiere 6.0

KIT workshop •
Modul materi workshop •

Coffee Break •
Sertifikat •

Fasilitas:

Pendaftaran:
- Sdr. Oesep Kurniadi - Tlp: (0274) 563172
- Sdr. Aris - Hp. 08179409911

Biaya: Rp. 200.000,- (umum)
           Rp. 150.000,- (mahasiswa)

Fakultas MIPA - Jurusan Fisika
(Prog.Studi Elektronika & Instrumentasi)

MOTHERBOARD

VIA P4PB-Ultra+RAID  P4X400, ATX,
FSB533, DDR333/400, RAID 103
VIA P4PB400-L  P4X400, ATX,
FSB533, DDR333/400 68
VIA P4PB266EN, P4X266, ATX,
FSB 533, 3 DDR 68
VIA P4MA-Pro, Via P4M266,
M-ATX, FSB 400, VGA, LAN 59

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 110
Asus P4PE/L 1394, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 137
Asus P4PE/L , i845PE, AGP4X, DDR,
6PCI, USB2.0, Hyper-threading 110
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 247
Asus P4P800 Deluxe, i865,
FSB 800, ATA100, 4DDR 184
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 84
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 164
Asus P4C800, i875, FSB800,
4DDR, RAID, Audio,
Gigabit LAN 221
Asus P4B533, i845E, FSB533,
ATA100, 3DDR, audio 90
Asus P4B533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 79
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio,
Serial ATA, 1394 138
Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR,
audio, Gigabit LAN 92
Asus P4S533-X, SiS645dx, FSB533,
2DDR, audio, VGA onboard 73
Asus A7V8X/L 1394, KT400,
ATA133, AGP8x, FSB266, 3DDR,
audio, LAN, 1394 126
Asus A7S533MX, Si651, 3 PCI,
4 USB 1.1 79
Asus A7N8X Deluxe/GD,
NForce2, ATA133, 5 PCI, 3DDR,
audio dolby, AGP8x 173
Asus A7N8X Deluxe, NForce2,
ATA133, 5 PCI, 3DDR,
audio dolby, AGP8x 168
Asus A7N8X/L, NForce2,
ATA133,
5PCI, 3DDR, Codec, LAN, 1394 119
Asus A7V266VM, VIA KT266A,
ATA100, 3PCI, 3DDR 70

APLUS AP973, i845G, FSB 533MHz,
2DDR, Intel Graphic, ATX, AC97 76
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 76
APLUS AP978 Ii845GL, ATX,
400FSB, SOUND AC97, 2 SDRAM 54
APLUS AP971A+ VIA P4M266, ATX,
400FSB, SOUND AC97, 2 SDRAM,
S3 Savage4 4XAGP 50
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 50
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A2 VIA P4M266A, ATX,
533FSB, SOUND AC97, 2DDR 52
APLUS AP971A VIA  P4M266A, M.ATX,
533FSB, SOUND AC97, 2SDRAM 50
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 645Combo, SiS 645, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 6PCI 66
MSI 645E MAX-U, SiS645DX, ATX,
FSB533, 3DIMM, ATA133, AGP4X, 6PCI 73
MSI 651M COMBO-L, SiS 651, m-ATX,
FSB533, 2DIMM, ATA133, AGP4X 76
MSI 648 MAX, SiS 648x, ATX, FSB533,
3DIMM, ATA133, AGP8X, 6PCI 88
MSI 655 MAX FISR, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 160
MSI 655 MAX LS, SiS655, ATX,
FSB533, 4DIMM, ATA133, SATA,
AGP8X 110
MSI 645GLM, I845gl, Matx, FSB400,
2DIMM, ATA100, AGP4X, 3PCI 73
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 96
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133,
AGP8X, 5PCI 130
MSI 845PE Max2-FISR, i845PE,ATX,
FSB533, 2GBDDR, ATA133, AGP4X 163
MSI K7N2-L, nForce2, ATX, FSB400,
3GB DDR, ATA133, AGP8X, 5PCI 115
K7N2G-L, nForce2, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 5 PCI 130
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X, 6PCI 85
KT4V Ultra FISR, Via KT400, ATX,
FSB333, 3GBDDRR, ATA133, SATA 158

Gigabyte GA-7VKMP-P,
VIA AKM266,
ATX, Soket A, ATA133, LAN 77
Gigabyte GA-7VA, VIA KT400,
ATX, Soket A, ATA133 89
Gigabyte GA-7N400-L1, nForce2 ultra,
ATX, Soket A, ATA133, Raid, Firewire 112
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-8SG800,  SiS 648,
ATX, FSB800, ATA133, AGP8X, 5PCI 82
Gigabyte GA-8ST800, SiS 645DX,
ATX, FSB800, ATA133 73
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 187
Gigabyte GA-8IE800, i845E,ATX,
FSB533, ATA100 87
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 132
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 107

Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 242

Jetway J-603TCF, VIA PLE33,
soket 370, M-ATX, FSB100, ATA100 52
Jetway J-P4XFBU, VIA P4X266E,
soket 478, ATX, FSB533, ATA133 62
Jetwat J-615TCS, i845E, soket 370,
M-ATX, FSB133, ATA133 56
Jetway J-615TCF, I845e, M-ATX,
soket 370, FSB133, ATA133 81
Jetway J-830CH, SiS730SE, ATX,
soket 462, FSB266, ATA100 63
Jetway J-P4MDPT, VIA P4M266A,
M-ATX, soket 478, FSB533, ATA133 64
Jetway J-S446, SiS645/961, ATX,
soket 478, FSB400, ATA100 66
Jetway J-845EPRO+ RAID, i845E,
ATX, soket 478, FSB400/533,
ATA133 90
Jetway J-845GLM, i845GL, M-ATX,
soket 478, FSB/400, ATA100 67

Fujitsu-Siemens D-1627A, i845PE,
ATX, FSB800, 4DDR, 5PCI,
ATA100, RAID 175
Fujitsu-Siemens D1561A, I865G,
M-ATX, FSB800, 4DDR, 3PCI,
ATA100, LAN 155
Fujitsu-Siemens D1562A, I865g,
M-ATX, FSB800, 4DDR, 3PCI,
ATA100, LAN 167
Fujitsu-Siemens D1520, I845GE,
M-ATX, FSB533, 2DDR, 3PCI,
ATA100, LAN 121
Fujitsu-Siemens D1522A, i845GE,
M-ATX, FSB533, 2DDR, 3PCI,
ATA100, LAN 145
Fujitsu-Siemens D1495-A,
SIS645DX, M-ATX, FSB533,
3DDR, 5PCI, ATA133, LAN 91
Fujitsu-Siemens D1555, SIS648,
ATX, FSB533, 3DDR, 5PCI,
ATA133. LAN 112

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 80
Iwill P4E, i845PE, soket 478,
FSB 400/533, DDR, Audio,
F1 series, ATA133 & 100 76
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soyo K7V Dragon Ultra. VIA KT333,
6ch audio, AGP Pro, LAN10/100 145
Soyo K7V Dragon Lite. VIA KT333,
6ch audio, AGP 4x 85
Soyo P4X400, VIA P4X400, RAID,
6ch audio, AGP PRO, 6 PCI 155
Soyo P4I Fire Dragon, i845D, DDR266,
RAID, 6ch audio, AGP PRO, 6 PCI 120
Soyo P4S Dragon Ultra, Sis645A2+
961, RAID, 6ch audio, AGP PRO, 6 PCI 140
Soyo P4IS2, i845, SDRAM, AC97,
6PCI, AGP4X 60

Abit IC7  i875P, FSB800MHz, 4 DDR,
AGP 8X, 5 PCI 145
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 103
Abit BE7-G, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 127

Visipro 256MB (8 IC) PC2700 53
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 99
Visipro 256MB PC3200 (8IC) 56
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (4IC) Call
Visipro 256MB PC800 (8IC) 105

Nexus SDRAM PC-133 64MB 15.5
Nexus SDRAM PC-133 128MB 20.5
Nexus SDRAM PC-133 256MB 37
Nexus DDR PC-2100 128MB 23
Nexus DDR PC-2100 256MB 42.5
Nexus DDR PC-2700 256MB 44.5
Nexus DDR PC-2700 512MB 90

V-Gen SDRAM PC-133 (8IC) 64MB 16
V-Gen SDRAM PC-133 (4IC) 128MB 22
V-Gen SDRAM PC-133 (8IC) 128MB 31
V-Gen SDRAM PC-133 (8IC) 256MB 41
V-Gen SDRAM PC-133 (16IC) 256MB 61
V-Gen SDRAM PC-133 (16IC) 512MB 80
V-Gen DDR PC-2100 (8IC) 128MB 25
V-Gen DDR PC-2100 (8IC) 256MB 46
V-Gen DDR PC-2700 (8IC) 256MB 49
V-Gen DDR PC-2100 (16IC) 512MB 92
V-Gen DDR PC-2700 (16IC) 512MB 96
V-Gen DDR PC-3200 (8IC)
256MB 52
V-Gen DDR PC-3200 (16IC)
512MB 99
V-Gen RDRAM PC-800 128MB 51
V-Gen RDRAM PC-800 256MB 97

NCPRO 256MB DDR PC-3200 47
NCPRO 256MB DDR PC-2700 44
NCPRO 512MB DDR PC-2700 89
NCPRO 128MB DDR PC-2100 18

Abit BE7-S, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 117
Abit BG7, i845G, FSB 533MHz,
3DDR, AGP 4X, 5 PCI 126
Abit BG7E, i845GE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 100
Abit TH7 II RAID, i850, FSB 400MHz,
4 RIMM, AGP 4X, 5 PCI 149
Abit SR7-8X, SiS 648, FSB 533MHz,
3 DDR, AGP 8X, 5 PCI 95
Abit SD7-533, SiS 645, FSB 400MHz,
3 DDR, AGP 4X, 5 PCI 95
Abit SA7, SiS 645DX, FSB 533MHz,
3 DDR, AGP 4X,  5 PCI 75
Abit AT7 Max, Via KT333,
FSB 266MHz, 2 DDR, AGP 4x, 3 PCI 150
Abit AT7 Max II, Via KT400,
FSB 266MHz, 2 DDR, AGP 8X,  5PCI 181
Abit KD7, Via KT400, FSB 333MHz,
4DDR, AGP 8X, 6 PCI 87
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 97
Abit NF7-M, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 123

MEMORI

Visipro 128MB (4 IC) PC 133 25
Visipro 128MB (8 IC) PC 133 33
Visipro 256MB (8 IC) PC-133 45
Visipro 256MB (16 IC) PC-133 67
Visipro 512MB PC-133 82
Visipro 128MB (8 IC) PC-2100 28
Visipro 256MB (8 IC) PC2100 50
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 94
Visipro 128MB (4 IC) PC-2700 Call
Visipro 128MB (8 IC) PC-2700 29
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KURSUS

DIKLAT KOMPUTER BERSERTIFIKAT  Rp.100.000,-
1.Teknik Komputer+MoBo+Hardisk+CopyBios
2.Network LAN+Admin+EDP+PC Kloning
3.Design Graf is 4.Teknis i  Monitor  + TV
Gratis : CD-Modul-Sertifikat-Drink-Konsultasi

DIKLAT JARINGAN PC KLONING TANPA HARDISK
Komp lama bisa secepat P.4 - RAM 8 jadi 64
Belajar Jarak Jauh Bisa -  Bergaransi
EXSYSCOM:021.78889003 - 0815.997.1234
Jl.Raya Depok-Depan UI-Blk Halte-Jakarta 12640

IZZAH COM Kursus ‘PAKET HEMAT’ Merakit PC
75rb LAN(W 2000 Server) 75rb  WebDesign 150rb
Photoshop 85rb     MS.Office 85rb Pwr.Point 75rb
Praktis,Cpt,certificate.Jl.Rawamangun Timur/78
Ph.47867273 http://izzahcomp.tripod.com

IT Asy-syifa Bljr 5 Hari
Teknisi 1. Komp+Mobo+Copy Bios 60Rb 2. Moni-
tor 60Rb Software 3. Visual Basic 60Rb 4.SPSS
V.11 95Rb 5.Linux 60Rb.Sabtu-Ahad Tek.LAN+PC
Cloning+Warnet Jl.Akses UI 59 10M dari Kamp.E
Gunadarma Kelapa Dua Depok 920-2459

LAIN-LAIN

LENGKAP & MEMUASKAN
- Bubuk TONER MURNI dari pabrik
- OPC drum, blades, mag roller, dll

- Larutan Kimia untuk rekondisi
- Tinta literan INKJET MURNI

- Refill tool, resetter, accessories, dll
TERSEDIA BAGI PEMULA :

Paket bisnis isi ulang & training
www.ecoprintlution.com
(031) 501 6088, 504 0150

*** INGIN PUNYA SITUS IKLAN BARIS !! ***
Siap buat spt iklanbaris.co.id dll Murah
tms com/net/org + hosting 1th, fasl lain

** INGIN JADI TRAINER SOFTWARE PAJAK **
Training for Trainer, Modul/CD, kuriklm

Sistem Fee/Putus Hub. Media Digitalindo
Hub Sutardi 021-87903687 HP 08129950652
email std@sukses.net site www.sukses.net

IKLAN BARIS

COMPACT FLASH

NCPRO Flash memory 32MB 16
NCPRO Flash memory 64MB 17.5
NCPRO Flash memory 128MB 29
NCPRO Flash memory 256MB 58.5

Visipro Flash Memory 64MB 24
Visipro Flash Memory 128MB 40
Visipro Flash Memory 256MB 68
Visipro Flash Memory 512MB 125

SMART MEDIA CARD

NCPRO Flash Memory 32MB 12
NCPRO Flash Memory 64MB 19.5
NCPRO Flash Memory 128MB 27.5

USB FLASH MEMORI/MP3/
PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 89
Prolink USB Pen Drive, MP3 128MB 120
Prolink USB Pen Drive, MP3 256MB 175

NCPRO pen drive 128MB 37
NCPRO pen drive 256MB 59.5
NCPRO pen drive 512MB 115
NCPRO pen drive 128MB USB2.0 44

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound, 128MB, multi MP3,
voice recording, display 115
MagicStar 128 Turbo, USB 2.0,
128MB 70

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm
ATA133, 2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 65
Maxtor 6Y060L 60GB 7200rpm
ATA133, 8MB Cache, dual processor 80
Maxtor 6Y080L 80GB 7200rpm
ATA133, 8mb cache, dual processor 88
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 118
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 185
Maxtor 6Y200PO, 200GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 275

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51
Seagate Ux/Cuda 5400.1 40GB
ATA 100 59
Seagate Barracuda ATA IV /V 80GB
7200RPM ATA100 80
Seagate Barracuda 7200.7 40GB
ATA100 62
Seagate Barracuda 7200.7 80GB
ATA100 80
Seagate Barracuda 7200.7 120GB
ATA V/100 108
Seagate Barracuda 7200.7 Plus
160GB ATA V/100
(8MB cache) 165
Seagate Barracuda SATA 80GB,
ATA100 125
Seagate Barracuda SATA 120GB,
ATA100 143

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 52
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 54

Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 60
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133, 2MB cache Call
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 83
Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 172
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 130
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 160
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 220
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 275

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160
Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB, USB 2.0,
8MB Cache, 7200rpm 325
Maxtor 5000DV 200GB USB 2.0,
8MB Cache, 7200rpm 430

SCSI HARD-DISK 7200RPM
& 10K RPM

Maxtor KU018L/J 18 GB ORCA,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 165
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 200
Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 460
IBM IC35LO36UWD,
36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J,
18GB, 68/80pin, 7200rpm,
SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin,
10Krpm, SCSI160,  8MB cache 115
IBM DPSS 9170W,
9,1GB, 68/80pin, 7200rpm,
SCSI160, 4MB cache 95

Seagate Medalist
Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah 10Krpm,
36,7GB U320, 36ES, 63,2ms, 4MB 190
Seagate Cheetah 10Krpm, 73GB,
U320, 36ES, 63,2ms, 4MB 530
Seagate Cheetah 15Krpm 18,4GB,
U160, x 3,9ms, 8MB cache 219
Seagate Cheetah 15Krpm 36,7GB,
U320, x 3,9ms, 8MB cache 397

GPU 250MHz, 64MB SDRAM,
TV out 45
PixelView FX5800, AGP8X, DDRII,
VIVO, DVI 490
pixelView FX5600H, AGP8X,
DDR 3,5ns, VIVO, DVI 205
PixelView FX5600, AGP8X,
128MB DDR, 3,6ns, DVI, VIVO 185
PixelView FX5200, AGP8X,
128MB DDR, TV OUT, DVI 98

MSI G4 MX440SES-T, AGP4X,
64MB SDR, TV OUT 58
MSI G4MX440 SET, AGP4X,
64MB SDR, TV OUT 64
MSI MX440-TD8X, AGP8X,
64MB DDR, DVI, TV OUT,
DUAL CRT 91
MSI MX440-VTD8X, AGP 8X,
64MB DDR, DVI, VIDEO IN,
TV OUT 110
MSI Ti4200-TD8X64, AGP8X,
64MB DDR, DVI 165
MSI TI4200-VTD8X, AGP8X,
128MB DDR, DVI, VIDEO IN,
TV OUT 185
MSI FX5200-TDR128, 128MB DDR,
DVI, VIDEO IN, TV OUT 135
MSI FX5600-VTDR, AGP8X,
128MB DDR, DVI, VIDEO IN,
TV OUT 215

Elsa Gloria4 980XGL nVidia Quadro4
900XGL, 128MB DDR,
650MHz DVI-I 802
Elsa Gloria4 750XGL nVidia Quadro4
750XGL, 128MB DDR,
650MHz DVI-I 475

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI, 640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Thoroughbred A) 46
Athlon XP 1900+ (Palomino) 52
Athlon Xp 2000+ (Thoroughbred A) 55
Athlon Xp 2100+ (Thoroughbred A) 58
Athlon XP 2200+ ((Thoroughbred A) 65
AthlonXP 2400+ fan (Thoroughbred A) 76
AthlonXP 2600+ (FSB333) + fan 106
AthlonXP 2800+ (Barton FSB333) 182
AthlonXP 3000+ (Barton FSB333) 266

Intel Pentium-4 1,6GHz
(non memory)-423 126
Intel Pentium-4 1,8GHz, box, 478 136
Intel Pentium-4 3,06GHz,
box (non memory), 478 Call
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 Call
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,53GHz,
512KB cache L2, FSB 533, 478 Call
Intel Pentium-4 2,66GHz
(non memory, 512) FSB 533 211
Intel Pentium-4 2,8GHz
(non memory, 512) FSB 533 280
Intel Pentium-4 2,4GHz, 512KB,
FSB800, 478 Call
Intel Pentium-4 3.0GHz, 512KB,
FSB800, 478 Call
Intel Celeron 1,7GHz, c/128 64
Intel Celeron 1,8GHz, c/128 73
Intel Xeon Pentium-4 1,8GHz
512KB cache L2, MPGA 194
Intel Xeon Pentium-4 2,0AGHz,
512KB cache L2, MPGA 239
Intel Xeon Pentium-4 2,4AGHz,
512KB cache L2,FSB 533, MPGA 250
Intel Xeon 1000, 256KB cache L2,
133MHz 467

HEATSINK FAN

Coolermaster HAC-V81 (X-Dream) 21
Coolermaster HSC-V83 30
Coolermaster HHC-001 28
Coolermaster IHC-L71 32

Zalman CNPS-2005 15
Zalman CNPS-3000 18
Zalman CNPS3100 24
Zalman CNPS3100 G 35
Zalman CNPS5001 AL 19
Zalman CNPS 5001CU 26
Zalman CNPS-5700D-CU 32
Zalman CNPS 7000 CU 42
Zalman CNPS 7000 ALCU 35

VGA CARD

Asus V9280 SuperFast 128MB 247
Asus V9180 Magic/T 64MB
MX440-8X 84
Asus V9900, GeForceFX 5800,
AGP 8x, 128MB DDR 378
Asus V9520 Magic/T
GeForceFX 5200,
128MB, AGP8X 95
Asus V8170DDR/T,
GeForce 4 MX 440SE,
64MB DDR 68
Asus V8170 Magic/T,
GeForce 4 MX 420, 64MB DDR 63
Asus V9950 Ultra/TD,
GeForce FX5900, 256MB 588
Asus V7100 Combo,
GeForce 2 MX 400, 32MB 147
Asus V9280 SuperFast,
GEForce4,
AGP 8X 128MB 247
Asus V9180 Magic/T,
GeForce4 MX440-8X, 64MB 84

Abit GF3 Ti 200, 64MB DDR 120
Abit GF2 T400, AGP 4X,
64MB SDRAM, TV-out, 64
Abit GF2 MX400, AGP 4X,
64MB SDRAM 59
Abit GF2 T200, AGP4X,
32MB SDRAM, TV-out 56
Abit GF2 MX200, AGP 4X,
32MB SDRAM 49

PixelView GF4 Ti4200-8x,
GPU 250MHz, RAM Clock 500MHz,
128MB DDR,TV-out & Video In,
DVI Port 160
PixelView GF4 Ti4200-8x/64,
AGP 8x, GPU 250MHz,
RAM Clock 500MHz 64MB DDR,
TV-out 130
PixelView GF4 MX440-8x,
GPU 250MHz, 128MB DDR 5ns,
RAM Clock 400MHz, TV out,
video in, DVI 85
PixelView GF4 MX440-8x/64,
GPU 250, 64MB DDR 5ns,
RAM clock 400MHz TV-out,in, DVI 55
PixelView GF4 MX440SE/DDR, GPU
250MHz, 64MB DDR 4ns, TV out 48
PixelView GF4 MX440SE/sd,
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Pemenang Kuis Edisi 136/III/2002:
HADIAH SOUVENIR PCplus

1. Yohanes Hendrarso
Jl. Letjen S. Parman 8
Jogjakarta 55262

2. Saladin Zafrullah
Komp. Eramas 2000 Blok B11 No.27
Pulo Gebang - Jakarta 13950

3. M. Bachri
PH. Husin 2 Wana Bakti 3 No.29
Pontianak 78124

4. Franky Chandra
Jl. Kepiting Raya No.1 Rawamangun
Jakarta 13220

5. Muslim Ismail Moris
Komp. Pola Kemala No.78C
Kec. Baituss Alam - Aceh Besar 23373

KUIS Ook, adik si Ciplus mengadu ke Ciplus. "Bang, motherboard dan
VGA komputerku rusak nih, padahal aku sedang mengerjakan makalah
penting", katanya. "Kalau ke Mangga Dua, aku titip motherboard yang

menggunakan VGA onboardnya ya, biar hemat. Chipsetnya terserah, yang penting untuk prosesor
Pentium-4", tambahnya. Tolong dong si Ciplus, sebutkan tiga saja chipset untuk prosesor
Pentium-4 yang ada onboard grafisnya! Tuliskan jawaban tersebut di sehelai kartu pos dengan
mencantumkan alamat yang jelas dan sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan
menunda-nunda, karena jawaban sudah harus masuk ke meja Redaksi PCplus paling lambat tanggal
15 September 2003. PCplus akan memberikan 5 buah kaos PCplus untuk 5 orang pemenang
yang menjawab dengan benar dan beruntung! Buruan!!!

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
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Jawaban Kuis No. 136/III/2002: Performance Acceleration Technology

Elsa Synergy4, nVidia
Quadro4 550XGL, 128MB DDR,
500MHz, DVI-I 301
Elsa Gladiac 518, nVidia
GF4 MX440, 64MB DDRTV 83
Elsa Gladiac 517SEP nVidia
GF4 MX440, 64MB DDR,
video out, DVD 59
Elsa Gladiac 511, nVidia GF2 mx00,
64MB DDRAM, 47

Sapphire Radeon 9700 Atlantis,
128MB DDR, DVI VO 276
Sapphire Radeon 9500 Atlantis,
128MB DDR,DVI TVO 170
Sapphire Radeon 9000 Pro,
128MB DDR, VIVO (PAL) 106
Sapphire Radeon 7000,SDR,
TV-OUT(PAL),128MB 276
Sapphire Radeon 9800Pro
128MB DDR, DVI, AGP8X 470

DigiColor TNT2/M64 nVIDIA,
32 MB SDR, CRT 24
DigiColor GF2 MX400 nVidia,
64 MB SDR, CRT 34
DigiColor GF4 MX440se
nVidia LMA II, 64 MB 128-bit
DDR 350 Mhz, CRT+TV out 70
DigiColor GeForce FX5200,
nVidia LMA II, 64 MB 128-bit,
CRT, TV out 80
DigiColor GeForce FX5600
nVidia LMA II, 128 MB 128-bit DDR,
Tv- out 170
DigiColor GF4 MX 440 AGP 8X
nVidia  64MB 128-bit DDR,
CRT, + TV out 50

Impact mx440 64mb,
AGP 4X DDR, tv out 48
Impact mx440 64mb DDR,
AGP8X tv out 58
Impact Ti4200 64mb, tv out,dvi 130
Impact Ti4200 128mb, AGP 8X,
128ddr tv out,dvi,vivo 159
Impact GeForceFX5200 128MB DDR,
tv out,dvi,vivo, AGP8X 97

Gigabyte R9700 Pro,
radeon 9700pro, TV-out S/RCA,
DVI port DVI-I 342
Gigabyte R9500 , radeon 9500,
TV-out S/RCA, DVI port DVI-I 167
Gigabyte R9000 Pro,
ATI Radeon 9000Pro, 64MB DDR,
TV-out, S-Video, Twin View, DVI Port 97
Gigabyte R9000, ATI Radeon 9000,
64MB,  DDR, TV-out 73
Gigabyte R9600 Pro,
ATI Radeon 9600 Pro, 128MB DDR 212
Gigabyte R-9800 Pro,
Radeon 9800Pro, 380MHz/ 680MHz,
256MB 547
Gigabyte R-9200 (VIVO),
Radeon 9200, 250MHz/ 400MHz,
128MB 117

Gigacube Radeon 9800 Pro 256MB 550
Gigacube Radeon 9800 Pro 128MB 440
Gigacube Radeon 9700 Pro 128MB 340
Gigacube Radeon 9600 Pro 128MB 185
Gigacube Radeon 9600  128MB 160
Gigacube Radeon 9200  128MB 98
Gigacube Radeon 9100  128MB 85

VIDEO EDITING CARD

Matrox RTX.10 550
Matrox RTX.100 965

Pinnacle Studio PCTV PCI 62
Pinnacle Studio DC10 plus ver 8.0 165
Pinnacle Studio Deluxe ver 8.0 285
Pinnacle MP20 VCD/SVCD/DVD 195
Pinnacle DV500DVD 470
Pinnacle Pro one V2 775
Pinnacle Pro one RTDV 985

Optibase Movie maker 100s 1260

tekram Digital Video Firewire 28

CD-RW DRIVE

Samsung CD ROM 52X 18

Aopen CD-ROM 56X OEM 23
Aopen CD-RW3248 32x12x48 50
Aopen CD-RW4850 48x12x50x 80
Aopen CD_RW 40x12x48 box 60
Aopen external CD-RW
40x12x48 box 135
Aopen DVD +
CD RW combo ultra slim, box 290

ION CD ROM 52X 19

Mitsumi CD-ROM 54x 22
Mitsumi CD-RW 48x24x48 48

Asus CD-RW external
5224 A-U (USB) 52x24x48 137
Asus external slim
combo SCB 1608D 205
Asus DVD-R/RW 2x1x6x 341
Asus CRW 5224A, 52x24x48 60
Asus CRW 4824A, 48x24x52 55
Asus DVD 16x 48

TDK CDRW 48x24x48 IDE
( White Panel ) 49
TDK CDRW 48x24x48 IDE
( Black Panel ) 51
TDK CDRW 48x16x48 USB
External 2.0 125
TDK CDRW 24x10x24
Slim USB 2.0 180
TDK DVD R/RW Dual
Format 290

RICOH CD RW 32x10x40 90

Plextor CD RW 48x24x48 Internal IDE 130
Plextor CD RW 8x8x24
external USB slim 150
Plextor CD RW 24x10x40
external USB 190
Plextor CD RW 24x10x40
external USB slim 215
Plextor CD RW 12x10x32
SCSI external 285
Plextor CD RW Combo DVD+ CD RW 325

Pioneer DVD ROM  106SZ 55
Pioneer DVD-RW  A05 (2X8) 240

Whale CD ROM 56x 20
Whale CD-RW 52x24x52 47

TV TUNER

Jetway  878, TV tuner, radio,
remote (int) 47
Jetway USB, TV tuner, radio,
remote USB 67

PixelView Play TV USB,
ext USB TV tuner + FM radio, remote 65
PixelView Play TV Pro,
TV tuner card + FM radio, remote 41
PixelView Play TV HDl,
TV tuner card + FM radio 55

MONITOR

Chameleon 150A, 15" TFT LCD,
grade A panel, contrast ratio 400:1 295

Saturn 150, LCD PC/TV 15"build in
TV tuner input: VGA & DVI port,
video in, out, mic 460
Venus 070, TFT active LCD TV 7",
build in antenna, video-audio in,
out, remote call

LCD Monitor Colortac LM 15Xn 298
LCD Monitor Colortac LM 17Xn 495

AOC 5En, 15" 86
AOC 7VLR, 17", OSD, LR 125
AOC 7F, 17", FLAT 160
AOC 9KLR, 19" OSD, LR, FLAT 250
AOC LM520, LCD 15", TFT, OSD 320
AOC LM520, LCD 17", TFT, OSD 475
AOC LM520, LCD 17", speaker,
TFT, OSD 505
AOC LM520, LCD 18", TFT, OSD 600
AOC LM520. LCD 19", TFT, OSD 675

SAMSUNG 15" DIGITAL 551V 88
SAMSUNG 17" DIGITAL 753S 130
SAMSUNG 17"
DIGITAL 753DFX/FLAT 155
SAMSUNG 17" 765MB DIGITAL 180
SAMSUNG 21" 1100P+ 600
SAMSUNG 15" LCD 151s 340
SAMSUNG 15" LCD 151N 355
SAMSUNG 15" LCD 151MP 700
SAMSUNG 19" LCD 191N 930
SAMSUNG 21" LCD 211MP 2800

Acer AC501, CRT 15" 90
Acer AC711, CRT 17" 136
Acer AF705, CRT 17" real flat 166
Acer AC901, CRT 19" 225

Acer AJ15FP, LCD 15" +
free speaker & subwoofer 435
Acer AL532, LCD 15" 525
Acer AL702, LCD 17" 690
Acer AL722, LCD 17" 710
Acer AL922, LCD 19" 1025

UPS

Prolink 2060D, 600VA, AVR 160-270V, 54
Prolink 2060S, 600VA,
AVR 160-270V, software monitor 59
Prolink 2100, 1000VA,
AVR 160-270V, software monitor 99

Nexus N-600B, 600VA with AVR 46
Nexus N-600S, 600VA with AVR +
software 51
Nexus N-1200B, 1200VA with AVR 82
Nexus N-1200S, 1200VA with AVR +
software 87
Nexus B-12V7AH,
Battery UPS 12V 7AH 12

MOUSE

Samsung Smart Bettle PS2 12
Samsung Smart Bettle USB 12
Samsung Cyber Bettle USB 13

Comfort MUS 4D 4

Aopen keyboard KB-858P 107 key 10

SM 100 optic Mini PS2 13
SOM 3100 Optic Wheel LED PS2 13
SOM 3200 Optic Wheel PS2 12.5
SCM 5100 Cordless Optic Combo 26
SOM 3500 Optical Neon Mouse 14
SW 1000 Wheel PS2, lose pack 5.5
SW 1000 Wheel w/ LED PS2 6.5

Nexus 8D5-P, 8D scroll ball PS/2 7
Nexus 8D5-U, 8D scroll ball USB 7,5
Nexus 8D6-P, 8D Scroll ball PS/2 11,5
Nexus 8D6-C, 8D scroll ball,
optical mouse combo 12,5
Nexus RF2-P, RF scroll,
ball mouse PS/2 10,5
Nexus RFI-P, RF scroll,
optical mouse PS/2 22

Nexus RF2U+KB1, RF scroll,
ball mouse, + RF keyboard 31
Nexus 3DN-U, mouse blue scroll,
optical USB 9

Whale Optical Mouse PS/2 11
Whale Optical Mouse USB 12

PRINTER

CANON PRINTER BJC-55 270
CANON PRINTER BJC-2100SP 62
CANON PRINTER i70 270
CANON PRINTER S600 195
CANON PRINTER S6300 310
CANON PRINTER  S200SPx 58
CANON PRINTER  S820 218
CANON PRINTER  S830D 415
CANON PRINTER  i550 180
CANON PRINTER  i850 250
CANON PRINTER  S530D 220
CANON PRINTER  i320 84

Samsung laser printer ML1210 210
Samsung laser printer ML1450 300

Lexmark Z-605 4800x1200,
USB, 14ppm 59
Lexmark Z-55 3600x1200,
USB, paralel, 17ppm 170
Lexmark Z-65 4800x1200,
USB, 21ppm 235
Lexmark Z-65n 4800x1200,
21ppm, SUB & ethernet 299
Lexmark Z-42 2400x1200,
USB, paralel, 10ppm 125
Lexmark X-5150 All in One
4800x1200, USB, 19ppm, A4 280
Lexmark X-1150 All in One
4800x1200, USB, 19ppm, A4 138

SCANNER

CANON CANOSCAN D-646UEX 58
CANON CANOSCAN FS-4000US 715
CANON CANOSCAN 5000F 210
CANON CANOSCAN N640Pex 55
CANON CANOSCAN D-1250U2 105
CANON CANOSCAN D-1250U2F 145
CANON CANOSCAN Lide-20 68
CANON CANOSCAN Lide-30 95

Prolink Winscan Pro 2448U,
1200x2400 opt res, ccd,
48 bit color, USB 85

PowerLook 1000 (scan area legal) 515
UTA-1000 (Transparency Unit for
PowerLook-1000) 735
PowerLook 1120 (scan area A4) 1,390
PowerLook 2100XL Built-in
UTA-2100XL (scan area A3) 1,925
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